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Warranty
The material contained in this document is 
provided "as is," and is subject to being 
changed, without notice, in future editions. 
Further, to the maximum extent permitted 
by applicable law, Keysight disclaims all 
warranties, either express or implied, with 
regard to this manual and any information 
contained herein, including but not limited 
to the implied warranties of merchantability 
and fitness for a particular purpose. 
Keysight shall not be liable for errors or for 
incidental or consequential damages in 
connection with the furnishing, use, or 
performance of this document or of any 
information contained herein. Should 

Keysight and the user have a separate 
written agreement with warranty terms 
covering the material in this document that 
conflict with these terms, the warranty 
terms in the separate agreement shall 
control.

Technology License
The hardware and/or software described in 
this document are furnished under a license 
and may be used or copied only in 
accordance with the terms of such license.

U.S. Government Rights
The Software is "commercial computer 
software," as defined by Federal Acquisition 
Regulation ("FAR") 2.101. Pursuant to FAR 
12.212 and 27.405-3 and Department of 
Defense FAR Supplement ("DFARS") 
227.7202, the U.S. government acquires 
commercial computer software under the 
same terms by which the software is 
customarily provided to the public. 
Accordingly, Keysight provides the Software 
to U.S. government customers under its 
standard commercial license, which is 
embodied in its End User License Agreement 
(EULA), a copy of which can be found at 
www.keysight.com/find/sweula. The 
license set forth in the EULA represents the 
exclusive authority by which the U.S. 
government may use, modify, distribute, or 
disclose the Software. The EULA and the 
license set forth therein, does not require or 
permit, among other things, that Keysight: (1) 
Furnish technical information related to 
commercial computer software or 
commercial computer software 
documentation that is not customarily 
provided to the public; or (2) Relinquish to, or 
otherwise provide, the government rights in 
excess of these rights customarily provided 
to the public to use, modify, reproduce, 
release, perform, display, or disclose 
commercial computer software or 
commercial computer software 
documentation. No additional government 
requirements beyond those set forth in the 

EULA shall apply, except to the extent that 
those terms, rights, or licenses are explicitly 
required from all providers of commercial 
computer software pursuant to the FAR and 
the DFARS and are set forth specifically in 
writing elsewhere in the EULA. Keysight shall 
be under no obligation to update, revise or 
otherwise modify the Software. With respect 
to any technical data as defined by FAR 
2.101, pursuant to FAR 12.211 and 27.404.2 
and DFARS 227.7102, the U.S. government 
acquires no greater than Limited Rights as 
defined in FAR 27.401 or DFAR 227.7103-5 
(c), as applicable in any technical data.

Safety Notices

CAUTION

A CAUTION notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or 
adhered to, could result in damage 
to the product or loss of important 
data. Do not proceed beyond a 
CAUTION notice until the indicated 
conditions are fully understood and 
met.

http://www.keysight.com/find/sweula
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WARNING

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the like that, if not correctly 
performed or adhered to, could 
result in personal injury or death. 
Do not proceed beyond a WARNING 
notice until the indicated 
conditions are fully understood and 
met.
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InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes—
At a Glance

Figure 1 InfiniiVision 1200 X-Series 4-Channel Oscilloscope
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 Figure 2 InfiniiVision 1200 X-Series 2-Channel Oscilloscope
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Table 1 InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes Model Numbers, Bandwidths 

Model: EDUX1052A EDUX1052G DSOX1202A DSOX1202G DSOX1204A DSOX1204G

Channels: 2 4

Bandwidth: 50 MHz 70 MHz

Bandwidth upgrades:  70 MHz to 100 MHz with 
D1202BW1A upgrade

70 MHz to 100 MHz with 
D1200BW1A upgrade

70 MHz to 200 MHz with 
D1202BW2A upgrade

70 MHz to 200 MHz with 
D1200BW2A upgrade

100 MHz to 200 MHz with 
D1202BW3A upgrade

100 MHz to 200 MHz with 
D1200BW3A upgrade

Sampling rate: 1 GSa/s 2 GSa/s (interleaved), 1 GSa/s (non-interleaved)

Memory: 200 kpts 2 Mpts (1 Mpts when the 
External Trig channel is on)

2 Mpts (interleaved), 1 Mpts 
(non-interleaved)

Segmented memory: No Yes
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The Keysight InfiniiVision 1200 X-Series and EDUX1052A/G oscilloscopes deliver 
these features:

• 7 inch WVGA display.

• 200,000 waveforms/second update rate.

• All knobs are pushable for making quick selections.

• Trigger types: edge, pulse width, and video on EDUX1000-Series models. 
DSOX1200-Series models add: pattern, rise/fall time, and setup and hold.

• Serial decode/trigger options for: I2C and UART/RS232 on EDUX1000-Series 
models. DSOX1200-Series models add: CAN, LIN, and SPI.

• Math waveforms: add, subtract, multiply, divide, FFT (magnitude and phase), 
and low-pass filter.

• Reference waveforms (2) for comparing with other channel or math waveforms.

• Many built-in measurements.

• G-suffix models have built-in waveform generator with: sine, square, ramp, 
pulse, DC, noise.

• USB/LAN ports makes printing, saving, and sharing data easy.

• A Quick Help system is built into the oscilloscope. Press and hold any key to 
display Quick Help.

For more information about InfiniiVision oscilloscopes, see: 
www.keysight.com/find/scope

Waveform generator: No Yes (20 MHz) No Yes (20 MHz) No Yes (20 MHz)

Mask/limit test: No Yes

Table 1 InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes Model Numbers, Bandwidths (continued)

Model: EDUX1052A EDUX1052G DSOX1202A DSOX1202G DSOX1204A DSOX1204G

http://www.keysight.com/find/scope
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In This Guide
This guide shows how to use the InfiniiVision 1200 X-Series and EDUX1052A/G 
oscilloscopes.

When unpacking and using the 
oscilloscope for the first time, see:

• Chapter 1, “Getting Started,” starting on page 21

When displaying waveforms and 
acquired data, see:

• Chapter 2, “Horizontal Controls,” starting on page 37

• Chapter 3, “Vertical Controls,” starting on page 47

• Chapter 4, “Analog Bus Display,” starting on page 55

• Chapter 5, “FFT Spectral Analysis,” starting on page 57

• Chapter 6, “Math Waveforms,” starting on page 65

• Chapter 7, “Reference Waveforms,” starting on page 
77

• Chapter 8, “Serial Bus Decode/Trigger,” starting on 
page 81

• Chapter 9, “Display Settings,” starting on page 83

• Chapter 10, “Labels,” starting on page 91

When setting up triggers or changing 
how data is acquired, see:

• Chapter 11, “Triggers,” starting on page 97

• Chapter 12, “Trigger Mode/Coupling,” starting on 
page 121

• Chapter 13, “Acquisition Control,” starting on page 
129

Making measurements and analyzing 
data:

• Chapter 14, “Cursors,” starting on page 145

• Chapter 15, “Measurements,” starting on page 155

• Chapter 16, “Mask Testing,” starting on page 181

• Chapter 17, “Digital Voltmeter,” starting on page 195

• Chapter 18, “Frequency Response Analysis,” starting 
on page 199

When using the built-in waveform 
generator, see:

• Chapter 19, “Waveform Generator,” starting on page 
205

When saving, recalling, or printing, 
see:

• Chapter 20, “Save/Recall (Setups, Screens, Data),” 
starting on page 217

• Chapter 21, “Print (Screens),” starting on page 229
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When using the oscilloscope's utility 
functions, see:

• Chapter 22, “Utility Settings,” starting on page 233

• Chapter 23, “Web Interface,” starting on page 251

For reference information, see: • Chapter 24, “Reference,” starting on page 263

When using serial bus triggering and 
decode features, see:

• Chapter 25, “CAN Triggering and Serial Decode,” 
starting on page 277

• Chapter 26, “I2C Triggering and Serial Decode,” 
starting on page 287

• Chapter 27, “LIN Triggering and Serial Decode,” 
starting on page 295

• Chapter 28, “SPI Triggering and Serial Decode,” 
starting on page 303

• Chapter 29, “UART/RS232 Triggering and Serial 
Decode,” starting on page 315

NOTE Abbreviated instructions for pressing a series of keys and softkeys

Instructions for pressing a series of keys are written in an abbreviated manner. Instructions for 
pressing [Key1], then pressing Softkey2, then pressing Softkey3 are abbreviated as follows:

Press [Key1]> Softkey2 > Softkey3.

The keys may be a front panel [Key] or a Softkey. Softkeys are the six keys located directly 
below the oscilloscope display.
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This chapter describes the steps you take when using the oscilloscope for the first 
time.

Inspect the Package Contents

• Inspect the shipping container for damage.

If your shipping container appears to be damaged, keep the shipping container 
or cushioning material until you have inspected the contents of the shipment 
for completeness and have checked the oscilloscope mechanically and 
electrically.

• Verify that you received the following items and any optional accessories you 
may have ordered:
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• InfiniiVision 1200 X-Series or EDUX1052A/G oscilloscope.

• Power cord (country of origin determines specific type).

• Oscilloscope probes (one for each analog input channel).

Power-On the Oscilloscope

Power
Requirements

Line voltage, frequency, and power:

• ~Line 100-120 Vac, 50/60/400 Hz

• 100-240 Vac, 50/60 Hz

• 50 W max

The oscilloscope tolerates mains supply voltage fluctuations up to ±10% of the 
nominal voltage.

Ventilation
Requirements

The air intake and exhaust areas must be free from obstructions. Unrestricted air 
flow is required for proper cooling. Always ensure that the air intake and exhaust 
areas are free from obstructions.

The fan draws air in from the left side and bottom of the oscilloscope and pushes it 
out behind the oscilloscope.

When using the oscilloscope in a bench-top setting, provide at least 2" clearance 
at the sides and 4" (100 mm) clearance above and behind the oscilloscope for 
proper cooling.

To power-on the
oscilloscope

1 Connect the power cord to the rear of the oscilloscope, then to a suitable AC 
voltage source. Route the power cord so the oscilloscope's feet and legs do not 
pinch the cord.

2 The oscilloscope automatically adjusts for input line voltages in the range 100 
to 240 VAC. The provided line cord is matched to the country of origin.

3 Press the power switch.

The power switch is located on the lower left corner of the front panel. The 
oscilloscope will perform a self-test and will be operational in a few seconds.

WARNING Always use a grounded power cord. Do not defeat the power cord ground.
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Connect Probes to the Oscilloscope

1 Connect the oscilloscope probe to an oscilloscope input channel BNC 
connector.

2 Connect the probe's retractable hook tip to the point of interest on the circuit or 
device under test. Be sure to connect the probe ground lead to a ground point 
on the circuit.

Input a Waveform

The Probe Comp signal is used for compensating probes.

1 Connect an oscilloscope probe from channel 1 to the Demo, Probe Comp terminal 
on the front panel.

2 Connect the probe's ground lead to the ground terminal (next to the Demo 
terminal).

CAUTION  Maximum input voltage at analog inputs

150 Vrms, 200 Vpk

CAUTION  Do not float the oscilloscope chassis

Defeating the ground connection and "floating" the oscilloscope chassis will probably 
result in inaccurate measurements and may also cause equipment damage. The probe 
ground lead is connected to the oscilloscope chassis and the ground wire in the power 
cord. If you need to measure between two live points, use a differential probe with 
sufficient dynamic range.

WARNING Do not negate the protective action of the ground connection to the oscilloscope. The 
oscilloscope must remain grounded through its power cord. Defeating the ground 
creates an electric shock hazard.
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Recall the Default Oscilloscope Setup

To recall the default oscilloscope setup:

1 Press [Default Setup].

The default setup restores the oscilloscope's default settings. This places the 
oscilloscope in a known operating condition.

In the Save/Recall menu, there are also options for restoring the complete factory 
settings or performing a secure erase (see Chapter 20, “Save/Recall (Setups, 
Screens, Data),” starting on page 217).

Use Autoscale

Use [Auto Scale] to automatically configure the oscilloscope to best display the 
input signals.

1 Press [Auto Scale].

You should see a waveform on the oscilloscope's display similar to this:

WARNING A voltage source should never be connected to the ground terminal of this instrument. 
If, for any reason, the Protective Conductor Terminal is disconnected or not functioning 
properly and a voltage source is connected to the equipment's ground terminals, the 
entire chassis will be at the voltage potential of the voltage source, and the operator or 
bystanders could receive an electric shock.
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2 If you want to return to the oscilloscope settings that existed before, press Undo 
Autoscale.

3 If you want to enable "fast debug" autoscaling, change the channels 
autoscaled, or preserve the acquisition mode during autoscale, press Fast 
Debug, Channels, or Acq Mode.

These are the same softkeys that appear in the Autoscale Preferences menu. 
See Chapter 22, “Utility Settings,” starting on page 233.

If you see the waveform, but the square wave is not shaped correctly as shown 
above, perform the procedure "Compensate Passive Probes" on page 25.

If you do not see the waveform, make sure the probe is connected securely to the 
front panel channel input BNC and to the Demo/Probe Comp terminal.

Compensate Passive Probes

Each oscilloscope passive probe must be compensated to match the input 
characteristics of the oscilloscope channel to which it is connected. A poorly 
compensated probe can introduce significant measurement errors.
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1 Input the Probe Comp signal (see "Input a Waveform" on page 23).

2 Press [Default Setup] to recall the default oscilloscope setup (see "Recall the 
Default Oscilloscope Setup" on page 24).

3 Press [Auto Scale] to automatically configure the oscilloscope for the Probe 
Comp signal (see "Use Autoscale" on page 24).

4 Press the channel key to which the probe is connected ([1], [2], etc.).

5 In the Channel menu, press Probe.

6 In the Channel Probe menu, press Probe Check; then, follow the instructions 
on-screen.

If necessary, use a nonmetallic tool (supplied with the probe) to adjust the 
trimmer capacitor on the probe for the flattest pulse possible.

On some probes (like the N2140/42A probes), the trimmer capacitor is located 
on the probe BNC connector. On other probes (like the N2862/63/90 probes), 
the trimmer capacitor is a yellow adjustment on the probe tip.

7 Connect probes to all other oscilloscope channels.

8 Repeat the procedure for each channel.

Learn the Front Panel Controls and Connectors

On the front panel, key refers to any key (button) you can press.

NOTE If your probe has a configurable attenuation setting (like the N2140/42A probes do), the 10:1 
setting must be used for probe compensation.

Perfectly compensated 

Over compensated 

Under compensated
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Softkey specifically refers to the six keys next to the display. Menus and softkey 
labels appear on the display when other front panel keys are pressed. Softkey 
functions change as you navigate through the oscilloscope's menus.

For the following figures, refer to the numbered descriptions in the table that 
follows.

Figure 3 InfiniiVision 1200 X-Series 4-Channel Oscilloscopes
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9. Measure controls

7. Horizontal and Acquisition controls

16. Math
function
controls

18. Waveform
generator

output

17. Analog
channel
inputs

14. [FFT] key



28 Keysight InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes User's Guide

1 Getting Started
 

Figure 4 InfiniiVision 1200 X-Series 2-Channel Oscilloscopes

Mixed Signal OscilloscopeMSOX1204G Digital Storage OscilloscopeDSOX1202G 200 MHz 2 GSa/s70 MHz 2 GSa/s InfiniiVision
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22. Ext Trig
external trigger

input

21. [External] key

1. Power switch Press once to switch power on; press again to switch power off. See "Power-On the 
Oscilloscope" on page 22.

2. Softkeys The functions of these keys change based upon the menus shown on the display next to the keys.

The Back key moves back in the softkey menu hierarchy. At the top of the hierarchy, the 

Back key turns the menus off, and oscilloscope information is shown instead.

3. [Intensity] key Press the key to illuminate it. When illuminated, turn the Entry knob to adjust waveform intensity.

You can vary the intensity control to bring out signal detail, much like an analog oscilloscope.

4. Entry knob The Entry knob is used to select items from menus and to change values. The function of the Entry 
knob changes based upon the current menu and softkey selections.

Note that when the Entry knob symbol appears on a softkey, you can use the Entry knob, to 
select values.

Often, rotating the Entry knob is enough to make a selection. Sometimes, you can push the Entry 
knob to enable or disable a selection. Also, pushing the Entry knob can also make popup menus 
disappear.

Back

Back
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5. [Default Setup] 
key

Press this key to restore the oscilloscope's default settings (details on "Recall the Default 
Oscilloscope Setup" on page 24).

6. [Auto Scale] 
key

When you press the [Auto Scale] key, the oscilloscope will quickly determine which channels have 
activity, and it will turn these channels on and scale them to display the input signals. See "Use 
Autoscale" on page 24.

7. Horizontal and 
Acquisition 
controls

The Horizontal and Acquisition controls consist of:

• Horizontal scale knob — Turn the knob in the Horizontal section that is marked  to 
adjust the time/div setting. The symbols under the knob indicate that this control has the effect 
of spreading out or zooming in on the waveform using the horizontal scale.

Push the horizontal scale knob to toggle between fine and coarse adjustment.

• Horizontal position knob — Turn the knob marked  to pan through the waveform data 
horizontally. You can see the captured waveform before the trigger (turn the knob clockwise) or 
after the trigger (turn the knob counterclockwise). If you pan through the waveform when the 
oscilloscope is stopped (not in Run mode) then you are looking at the waveform data from the last 
acquisition taken.

• [Acquire] key — Press this key to open the Acquire menu where you can select the Normal, XY, and 
Roll time modes, enable or disable Zoom, and select the trigger time reference point.

Also you can select the Normal, Peak Detect, Averaging, or High Resolution acquisition modes 
and, on DSOX1200-Series models, use segmented memory (see "Selecting the Acquisition 
Mode" on page 135).

• Zoom  key — Press the  zoom key to split the oscilloscope display into Normal and Zoom 
sections without opening the Acquire menu.

For more information see Chapter 2, “Horizontal Controls,” starting on page 37.

8. Run Control 
keys

When the [Run/Stop] key is green, the oscilloscope is running, that is, acquiring data when trigger 
conditions are met. To stop acquiring data, press [Run/Stop].

When the [Run/Stop] key is red, data acquisition is stopped. To start acquiring data, press 
[Run/Stop].

To capture and display a single acquisition (whether the oscilloscope is running or stopped), press 
[Single]. The [Single] key is yellow until the oscilloscope triggers.

For more information, see "Running, Stopping, and Making Single Acquisitions (Run 
Control)" on page 129.



30 Keysight InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes User's Guide

1 Getting Started
 

9. Measure 
controls

The measure controls consist of:

• [Analyze] key — Press this key to access analysis features like:

• Trigger level setting.

• Measurement threshold setting.

• Video trigger automatic set up and display.

• Display a bus made up of the analog channel inputs where channel 1 is the least significant bit 
and channel 4 is the most significant bit. See also Chapter 4, “Analog Bus Display,” starting 
on page 55.

• Enable serial bus decodes. See also Chapter 8, “Serial Bus Decode/Trigger,” starting on page 
81.

• Reference waveforms (see Chapter 7, “Reference Waveforms,” starting on page 77).

• Mask testing (see Chapter 16, “Mask Testing,” starting on page 181).

• Digital voltmeter (see Chapter 17, “Digital Voltmeter,” starting on page 195).

• Frequency response analysis on models with a built-in waveform generator (see Chapter 18, 
“Frequency Response Analysis,” starting on page 199).

• [Meas] key — Press this key to access a set of predefined measurements. See Chapter 15, 
“Measurements,” starting on page 155.

• [Cursors] key — Press this key to open a menu that lets you select the cursors mode and source.

• Cursors knob — Push this knob select cursors from a popup menu. Then, after the popup menu 
closes (either by timeout or by pushing the knob again), rotate the knob to adjust the selected 
cursor position.

10. Tools keys The Tools keys consist of:

• [Save/Recall] key — Press this key to save oscilloscope setups, screen images, waveform data, or 
mask files or to recall setups, mask files or reference waveforms. See Chapter 20, “Save/Recall 
(Setups, Screens, Data),” starting on page 217.

• [Utility] key — Press this key to access the Utility menu, which lets you configure the 
oscilloscope's I/O settings, use the file explorer, set preferences, access the service menu, and 
choose other options. See Chapter 22, “Utility Settings,” starting on page 233.

• [Display] key — Press this key to access the menu where you can enable persistence, adjust the 
display grid (graticule) intensity, label waveforms, add an annotation, and clear the display (see 
Chapter 9, “Display Settings,” starting on page 83).

• [Quick Action] key — Press this key to perform the selected quick action: measure all snapshot, 
print, save, recall, freeze display. and more. See "Configuring the [Quick Action] Key" on 
page 248.

• [Save to USB] key — Press this key to perform a quick save to a USB storage device.
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11. Trigger controls The Trigger controls determine how the oscilloscope triggers to capture data. These controls consist 
of:

• Level knob — Turn the Level knob to adjust the trigger level for a selected analog channel.

Push the knob to set the level to the waveform's 50% value. If AC coupling is used, pushing the 
Level knob sets the trigger level to about 0 V.

The position of the trigger level for the analog channel is indicated by the trigger level icon  (if 
the analog channel is on) at the far left side of the display. The value of the analog channel trigger 
level is displayed in the upper-right corner of the display.

• [Trigger] key — Press this key to select the trigger type (edge, pulse width, video, etc.). See 
Chapter 11, “Triggers,” starting on page 97. You can also set options that affect all trigger types. 
See Chapter 12, “Trigger Mode/Coupling,” starting on page 121.

• [Force] key — Causes a trigger (on anything) and displays the acquisition.

This key is useful in the Normal trigger mode where acquisitions are made only when the trigger 
condition is met. In this mode, if no triggers are occurring (that is, the "Trig'd?" indicator is 
displayed), you can press [Force] to force a trigger and see what the input signals look like.

12. Vertical 
controls

The Vertical controls consist of:

• Analog channel on/off keys — Use these keys to switch a channel on or off, or to access a 
channel's menu in the softkeys. There is one channel on/off key for each analog channel.

• Vertical scale knob — Use the knob marked  to change the vertical sensitivity (gain) for 
the selected analog input channel.

Push the vertical scale knob to toggle between fine and coarse adjustment.

The default mode for expanding the signal is about the ground level of the channel; however, you 
can change this to expand about the center of the display.

• Vertical position knob — Use this knob to change the selected analog input channel waveform 
vertical position on the display.

The voltage value momentarily displayed in the upper right portion of the display represents the 

voltage difference between the vertical center of the display and the ground level ( ) icon. It 
also represents the voltage at the vertical center of the display if vertical expansion is set to 
expand about ground.

For more information, see Chapter 3, “Vertical Controls,” starting on page 47.

13. [Wave Gen] key On G-suffix models that have a built-in waveform generator, press this key to access waveform 
generator functions. See Chapter 19, “Waveform Generator,” starting on page 205.

14. [FFT] key Provides access to FFT spectrum analysis function. See Chapter 5, “FFT Spectral Analysis,” starting 
on page 57.

T
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15. [Help] key Opens the Help menu where you can display overview help topics, select the Language (see also 
"Access the Built-In Quick Help" on page 36), and select training signals that can be output on 
the Demo terminal.

16. Math function 
controls

The Math function controls consist of:

• [Math] key — provides access to math (add, subtract, etc.) waveform functions. See Chapter 6, 
“Math Waveforms,” starting on page 65.

• Vertical scale knob — Use the knob marked  to change the vertical sensitivity (as with 
the analog channel vertical controls).

• Vertical position knob — Use the knob to change a math function waveform's vertical position on 
the display (as with the analog channel vertical controls).

17. Analog channel 
inputs

Attach oscilloscope probes or BNC cables to these BNC connectors.

In the InfiniiVision 1200 X-Series oscilloscopes, the analog channel inputs have 1 MΩ impedance.

Also, there is no automatic probe detection, so you must properly set the probe attenuation for 
accurate measurement results. See "Setting Analog Channel Probe Options" on page 51.

18. Waveform 
generator 
output

On G-suffix models, the built-in waveform generator can output sine, square, ramp, pulse, DC, or 
noise on the Gen Out BNC. Press the [Wave Gen] key to set up the waveform generator. See 
Chapter 19, “Waveform Generator,” starting on page 205.

You can also send the trigger output signal or the mask test failure signal to the Gen Out BNC 
connector. See "Setting the Gen Out Source" on page 242.

19. Demo/Probe 
Comp, Ground 
terminals

• Demo terminal — This terminal outputs the Probe Comp signal which helps you match a probe's 
input capacitance to the oscilloscope channel to which it is connected. See "Compensate 
Passive Probes" on page 25. The oscilloscope can also output demo or training signals on this 
terminal.

• Ground terminal — Use the ground terminal for oscilloscope probes connected to the Demo/Probe 
Comp terminal. See the warning in "Input a Waveform" on page 23.
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 Front Panel Overlays for Different Languages

Front panel overlays, which have translations for the English front panel keys and 
label text, are available in many languages. The appropriate overlay is included 
when the localization option is chosen at time of purchase.

To install a front panel overlay:

1 Gently pull on the front panel knobs to remove them.

2 Insert the overlay's side tabs into the slots on the front panel.

3 Reinstall the front panel knobs.

Learn the Rear Panel Connectors

For the following figure, refer to the numbered descriptions in the table that 
follows.

20. USB Host port This port is for connecting USB mass storage devices or printers to the oscilloscope.

Connect a USB compliant mass storage device (flash drive, disk drive, etc.) to save or recall 
oscilloscope setup files and reference waveforms or to save data and screen images. See 
Chapter 20, “Save/Recall (Setups, Screens, Data),” starting on page 217.

To print, connect a USB compliant printer. For more information about printing see Chapter 21, 
“Print (Screens),” starting on page 229.

You can also use the USB port to update the oscilloscope's system software when updates are 
available.

NOTE: You must Eject a USB mass storage device before unplugging it; otherwise, the device will be 
marked as needing repair when connecting to a computer with the Windows operating system (even 
though there are no harmful effects to the device).

CAUTION:Do not connect a host computer to the oscilloscope's USB host port. A host computer 
sees the oscilloscope as a device, so connect the host computer to the oscilloscope's device port (on 
the rear panel). See "Learn the Rear Panel Connectors" on page 33.

21. [External] key Press this key to set external trigger input options. See "External Trigger Input" on page 127.

22. Ext Trig input External trigger input BNC connector. See "External Trigger Input" on page 127 for an 
explanation of this feature.
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Learn the Oscilloscope Display

The oscilloscope display contains acquired waveforms, setup information, 
measurement results, and the softkey definitions.

5. EXT TRIG input (on
    4-channel oscilloscopes) 

3. USB Device port

1. Power cord connector

2. Kensington lock hole

4. LAN port

1. Power cord 
connector

Attach the power cord here.

2. Kensington lock 
hole

This is where you can attach a Kensington lock for securing the instrument.

3. USB Device 
port

This port is for connecting the oscilloscope to a host PC. You can issue remote commands from a 
host PC to the oscilloscope via the USB device port (see the Programmer's Guide).

4. LAN port When the oscilloscope is connected to a network (see "Setting up the Oscilloscope's LAN 
Connection" on page 234), the LAN port lets you print to network printers (see Chapter 21, “Print 
(Screens),” starting on page 229), access the oscilloscope's built-in web server (see Chapter 23, 
“Web Interface,” starting on page 251), and issue remote commands (see the Programmer's Guide).

15. EXT TRIG input On 4-channel models, the external trigger input BNC connector is on the rear panel.

On 2-channel models, the external trigger input BNC connector is on the front panel.

See "External Trigger Input" on page 127 for an explanation of this feature.
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 Figure 5 Interpreting the oscilloscope display
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Status line The top line of the display contains vertical, horizontal, and trigger setup information.

Display area The display area contains the waveform acquisitions, channel identifiers, and analog trigger, and 
ground level indicators. Each analog channel's information appears in a different color.

Signal detail is displayed using 256 levels of intensity.

For more information about display modes see Chapter 9, “Display Settings,” starting on page 83.
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Access the Built-In Quick Help

To view Quick Help:

1 Press and hold the key, softkey, or knob for which you would like to view help.

Quick Help remains on the screen until another key is pressed or a knob is turned.

Select the User Interface Language

To select the user interface and Quick Help language:

1 Press [Help], then press the Language softkey.

2 Turn the Entry knob until the desired language is selected.

Softkey labels and 
information area

When most front panel keys are pressed, short menu names and softkey labels appear in this area. 
The labels describe the softkey functions. Typically, softkeys let you set up additional parameters for 
the selected mode or menu.

Pressing the Back key returns through the menu hierarchy until softkey labels are off and the 
information area is displayed. The information area contains acquisition, analog channel, math 
function, and reference waveform information.

You can also specify that softkey menus turn off automatically after a specified timeout period 
([Utility] > Options > Menu Timeout). 

Pressing the Back key when the information area is displayed returns to the most recent menu 
displayed.

Measurements area When measurements or cursors are turned on, this area contains automatic measurement and cursor 
results.

When measurements are turned off, this area displays additional status information describing 
channel offset and other configuration parameters.

Back

Back
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2 Horizontal Controls
To adjust the horizontal (time/div) scale / 38
To adjust the horizontal delay (position) / 39
Panning and Zooming Single or Stopped Acquisitions / 40
To change the horizontal time mode (Normal, XY, or Roll) / 40
To display the zoomed time base / 44
To change the horizontal scale knob's coarse/fine adjustment setting / 45
To position the time reference (left, center, right) / 46

The horizontal controls include:

• The horizontal scale and position knobs.

• The [Acquire] key for accessing the Acquire menu.

• The  zoom key for quickly enabling/disabling the split-screen zoom display.

The following figure shows the Acquire menu which appears after pressing the 
[Acquire] key.
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The Acquire menu lets you select the time mode (Normal, XY, or Roll), enable 
Zoom, and specify the time reference.

The current sample rate is displayed in the right side information area when 
softkey menu labels are off.

To adjust the horizontal (time/div) scale

1 Turn the large horizontal scale (sweep speed) knob marked  to 
change the horizontal time/div setting.

Notice how the time/div information in the status line changes.

The ∇ symbol at the top of the display indicates the time reference point.

Figure 6 Acquire Menu
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The horizontal scale knob works (in the Normal time mode) while acquisitions are 
running or when they are stopped. When running, adjusting the horizontal scale 
knob changes the sample rate. When stopped, adjusting the horizontal scale knob 
lets you zoom into acquired data. See "Panning and Zooming Single or Stopped 
Acquisitions" on page 40.

Note that the horizontal scale knob has a different purpose in the Zoom display. 
See "To display the zoomed time base" on page 44.

To adjust the horizontal delay (position)

1 Turn the horizontal delay (position) knob ( ).

The trigger point moves horizontally, pausing at 0.00 s (mimicking a 
mechanical detent), and the delay value is displayed in the status line.

Changing the delay time moves the trigger point (solid inverted triangle) 
horizontally and indicates how far it is from the time reference point (hollow 
inverted triangle ∇). These reference points are indicated along the top of the 
display grid.

Figure 6 shows the trigger point with the delay time set to 200 µs. The delay time 
number tells you how far the time reference point is located from the trigger point. 
When delay time is set to zero, the delay time indicator overlays the time reference 
indicator.

All events displayed left of the trigger point happened before the trigger occurred. 
These events are called pre-trigger information, and they show events that led up 
to the trigger point.

Everything to the right of the trigger point is called post-trigger information. The 
amount of delay range (pre-trigger and post-trigger information) available 
depends on the time/div selected and memory depth.

The horizontal position knob works (in the Normal time mode) while acquisitions 
are running or when they are stopped. When running, adjusting the horizontal 
scale knob changes the sample rate. When stopped, adjusting the horizontal scale 
knob lets you zoom into acquired data. See "Panning and Zooming Single or 
Stopped Acquisitions" on page 40.

Note that the horizontal position knob has a different purpose in the Zoom display. 
See "To display the zoomed time base" on page 44.
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Panning and Zooming Single or Stopped Acquisitions

When the oscilloscope is stopped, use the horizontal scale and position knobs to 
pan and zoom your waveform. The stopped display may contain several 
acquisitions worth of information, but only the last acquisition is available for pan 
and zoom.

The ability to pan (move horizontally) and scale (expand or compress horizontally) 
an acquired waveform is important because of the additional insight it can reveal 
about the captured waveform. This additional insight is often gained from seeing 
the waveform at different levels of abstraction. You may want to view both the big 
picture and the specific little picture details.

The ability to examine waveform detail after the waveform has been acquired is a 
benefit generally associated with digital oscilloscopes. Often this is simply the 
ability to freeze the display for the purpose of measuring with cursors or printing 
the screen. Some digital oscilloscopes go one step further by including the ability 
to further examine the signal details after acquiring them by panning through the 
waveform and changing the horizontal scale.

There is no limit imposed on the scaling ratio between the time/div used to 
acquire the data and the time/div used to view the data. There is, however, a 
useful limit. This useful limit is somewhat a function of the signal you are 
analyzing.

To change the horizontal time mode (Normal, XY, or Roll)

1 Press [Acquire].

2 In the Acquire menu, press Time Mode; then, select:

• Normal — the normal viewing mode for the oscilloscope.

NOTE Zooming into stopped acquisitions

The screen will still contain a relatively good display if you zoom-in horizontally by a factor of 
1000 and zoom-in vertically by a factor of 10 to display the information from where it was 
acquired. Remember that you can make automatic measurements on displayed data only.
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In the Normal time mode, signal events occurring before the trigger are 
plotted to the left of the trigger point (▼) and signal events after the trigger 
plotted to the right of the trigger point.

• XY — XY mode changes the display from a volts-versus-time display to a 
volts-versus-volts display. The time base is turned off. Channel 1 amplitude 
is plotted on the X-axis and Channel 2 amplitude is plotted on the Y-axis.

You can use XY mode to compare frequency and phase relationships 
between two signals. XY mode can also be used with transducers to display 
strain versus displacement, flow versus pressure, volts versus current, or 
voltage versus frequency.

Use the cursors to make measurements on XY mode waveforms.

For more information about using XY mode for measurements, refer to "XY 
Time Mode" on page 41.

• Roll — causes the waveform to move slowly across the screen from right to 
left. It only operates on time base settings of 50 ms/div and slower. If the 
current time base setting is faster than the 50 ms/div limit, it will be set to 
50 ms/div when Roll mode is entered.

In Roll mode there is no trigger. The fixed reference point on the screen is the 
right edge of the screen and refers to the current moment in time. Events 
that have occurred are scrolled to the left of the reference point. Since there 
is no trigger, no pre-trigger information is available.

If you would like to pause the display in Roll mode press the [Single] key. To 
clear the display and restart an acquisition in Roll mode, press the [Single] 
key again.

Use Roll mode on low-frequency waveforms to yield a display much like a 
strip chart recorder. It allows the waveform to roll across the display.

XY Time Mode

The XY time mode converts the oscilloscope from a volts-versus-time display to a 
volts-versus-volts display using two input channels. Channel 1 is the X-axis input, 
channel 2 is the Y-axis input. You can use various transducers so the display could 
show strain versus displacement, flow versus pressure, volts versus current, or 
voltage versus frequency.
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Example This exercise shows a common use of the XY display mode by measuring the 
phase difference between two signals of the same frequency with the Lissajous 
method.

1 Connect a sine wave signal to channel 1, and a sine wave signal of the same 
frequency but out of phase to channel 2.

2 Press the [Auto Scale] key, press the [Acquire] key; then, press Time Mode and 
select "XY".

3 Center the signal on the display with the channel 1 and 2 position ( ) knobs. 
Use the channel 1 and 2 volts/div knobs and the channel 1 and 2 Fine softkeys 
to expand the signal for convenient viewing.

The phase difference angle (θ) can be calculated using the following formula 
(assuming the amplitude is the same on both channels):

4 Press the [Cursors] key.

5 Set the Y2 cursor to the top of the signal, and set Y1 to the bottom of the 
signal.

Note the ΔY value at the bottom of the display. In this example, we are using 
the Y cursors, but you could have used the X cursors instead.

Figure 7 XY time mode signals, centered on display
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6 Move the Y1 and Y2 cursors to the intersection of the signal and the Y axis. 
Again, note the ΔY value.

7 Calculate the phase difference using the formula below.

For example, if the first ΔY value is 1.688 and the second ΔY value is 1.031:

Figure 8 Phase difference measurements, automatic and using cursors

sinθ = second ΔY
first ΔY

= 1.031
1.688; θ = 37.65 degrees of phase shift

NOTE Z-Axis Input in XY Display Mode (Blanking)

When you select the XY display mode, the time base is turned off. Channel 1 is the X-axis 
input, channel 2 is the Y-axis input, and the EXT TRIG input is the Z-axis input. If you only want 
to see portions of the Y versus X display, use the Z-axis input. Z-axis turns the trace on and off 
(analog oscilloscopes called this Z-axis blanking because it turned the beam on and off). 
When Z is low (<1.4 V), Y versus X is displayed; when Z is high (>1.4 V), the trace is turned off.
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To display the zoomed time base

Zoom, formerly called Delayed sweep mode, is a horizontally expanded version of 
the normal display. When Zoom is selected, the display divides in half. The top 
half of the display shows the normal time/div window and the bottom half 
displays a faster Zoom time/div window.

The Zoom window is a magnified portion of the normal time/div window. You can 
use Zoom to locate and horizontally expand part of the normal window for a more 
detailed (higher-resolution) analysis of signals.

To turn on (or off) Zoom:

1 Press the  zoom key (or press the [Acquire] key and then the Zoom softkey).

These markers show the
beginning and end of the
Zoom window

Normal
window

Time/div
for zoomed
window

Time/div
for normal
window

Delay time 
momentarily displays
when the Horizontal
position knob is turned 

Zoom
window

Signal
anomaly
expanded
in zoom
window

Select
Zoom



Horizontal Controls 2

Keysight InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes User's Guide 45

 

The area of the normal display that is expanded is outlined with a box and the rest 
of the normal display is ghosted. The box shows the portion of the normal sweep 
that is expanded in the lower half.

To change the time/div for the Zoom window, turn the horizontal scale (sweep 
speed) knob. As you turn the knob, the zoomed window time/div is highlighted in 
the status line above the waveform display area. The Horizontal scale (sweep 
speed) knob controls the size of the box.

The Horizontal position (delay time) knob sets the left-to-right position of the 
zoom window. The delay value, which is the time displayed relative to the trigger 
point) is momentarily displayed in the upper-right portion of the display when the 
delay time ( ) knob is turned.

Negative delay values indicate you're looking at a portion of the waveform before 
the trigger event, and positive values indicate you're looking at the waveform after 
the trigger event.

To change the time/div of the normal window, turn off Zoom; then, turn the 
horizontal scale (sweep speed) knob.

For information about using zoom mode for measurements, refer to "To isolate a 
pulse for Top measurement" on page 161 and "To isolate an event for frequency 
measurement" on page 168.

To change the horizontal scale knob's coarse/fine adjustment 
setting

1 Push the horizontal scale knob to toggle between fine and coarse adjustment 
of the horizontal scale.

When Fine is enabled, turning the horizontal scale knob changes the time/div 
(displayed in the status line at the top of the display) in smaller increments. The 
time/div remains fully calibrated when Fine is on.

When Fine is turned off, the Horizontal scale knob changes the time/div setting in 
a 1-2-5 step sequence.
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To position the time reference (left, center, right)

Time reference is the reference point on the display for delay time (horizontal 
position).

1 Press [Acquire].

2 In the Acquire menu, press Time Ref; then, select:

• Left — the time reference is set to one major division from the left edge of the 
display.

• Center — the time reference is set to the center of the display.

• Right — the time reference is set to one major division from the right edge of 
the display.

A small hollow triangle (∇) at the top of the display grid marks the position of the 
time reference. When delay time is set to zero, the trigger point indicator (▼) 
overlays the time reference indicator.

The time reference position sets the initial position of the trigger event within 
acquisition memory and on the display, with delay set to 0.

Turning the Horizontal scale (sweep speed) knob expands or contracts the 
waveform about the time reference point (∇). See "To adjust the horizontal 
(time/div) scale" on page 38.

Turning the Horizontal position ( ) knob in Normal mode (not Zoom) moves the 
trigger point indicator (▼) to the left or right of the time reference point (∇). See 
"To adjust the horizontal delay (position)" on page 39.
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3 Vertical Controls
To turn waveforms on or off (channel or math) / 49
To adjust the vertical scale / 49
To adjust the vertical position / 49
To specify channel coupling / 50
To specify bandwidth limiting / 50
To change the vertical scale knob's coarse/fine adjustment setting / 51
To invert a waveform / 51
Setting Analog Channel Probe Options / 51

The vertical controls include:

• Multiplexed vertical scale and position knobs for the selected analog channel.

• The channel keys for turning a channel on or off and accessing the channel's 
softkey menu.
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The following figure shows the Channel 1 menu that appears after pressing the [1] 
channel key.

The ground level of the signal for each displayed analog channel is identified by 

the position of the  icon at the far-left side of the display.

NOTE Keysight recommends always scaling the signal so that the entire waveform is contained 
between the top and bottom of the display.

For proper operation of the 1200 X-Series oscilloscope, the channel inputs must not be 
overdriven more than ±8 divisions. Exceeding this limit may result in signals that appear 
incorrect and may increase crosstalk between the input channels.

NOTE To minimize crosstalk between input channels, make sure the channel is not overdriven. Also, 
connecting a probe or cable to a channel will reduce crosstalk.

Channel,
Volts/div

Channel 1
ground
level

Trigger
source

Trigger level
or threshold 

Channel 2
ground
level
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To turn waveforms on or off (channel or math)

1 Press an analog channel key turn the channel on or off (and to display the 
channel's menu).

When a channel is on, its key is illuminated.

To adjust the vertical scale

1 Turn the large knob above the channel key marked  to set the vertical 
scale (volts/division) for the channel.

The vertical scale knob changes the analog channel scale in a 1-2-5 step 
sequence (with a 1:1 probe attached) unless fine adjustment is enabled (see "To 
change the vertical scale knob's coarse/fine adjustment setting" on page 51).

The analog channel Volts/Div value is displayed in the status line.

The default mode for expanding the signal when you turn the volts/division knob 
is vertical expansion about the ground level of the channel; however, you can 
change this to expand about the center of the display. See "To choose "expand 
about" center or ground" on page 239.

To adjust the vertical position

1 Turn the small vertical position knob ( ) to move the channel's waveform up or 
down on the display.

NOTE Turning channels off

You must be viewing the menu for a channel before you can turn it off. For example, if channel 
1 and channel 2 are turned on and the menu for channel 2 is being displayed, to turn channel 
1 off, press [1] to display the channel 1 menu; then, press [1] again to turn channel 1 off.
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The voltage value momentarily displayed in the upper right portion of the display 
represents the voltage difference between the vertical center of the display and 

the ground level ( ) icon. It also represents the voltage at the vertical center of 
the display if vertical expansion is set to expand about ground (see "To choose 
"expand about" center or ground" on page 239).

To specify channel coupling

Coupling changes the channel's input coupling to either AC (alternating current) 
or DC (direct current).

1 Press the desired channel key.

2 In the Channel menu, press the Coupling softkey to select the input channel 
coupling:

• DC — DC coupling is useful for viewing waveforms as low as 0 Hz that do not 
have large DC offsets.

• AC — AC coupling is useful for viewing waveforms with large DC offsets.

AC coupling places a 10 Hz high-pass filter in series with the input waveform 
that removes any DC offset voltage from the waveform.

Note that Channel Coupling is independent of Trigger Coupling. To change trigger 
coupling see "To select the trigger coupling" on page 124.

To specify bandwidth limiting

1 Press the desired channel key.

2 In the Channel menu, press the BW Limit softkey to enable or disable bandwidth 
limiting.

TIP If the channel is DC coupled, you can quickly measure the DC component of the signal by 
simply noting its distance from the ground symbol.

If the channel is AC coupled, the DC component of the signal is removed, allowing you to use 
greater sensitivity to display the AC component of the signal.
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When bandwidth limit is on, the maximum bandwidth for the channel is 
approximately 20 MHz. For waveforms with frequencies below this, turning 
bandwidth limit on removes unwanted high frequency noise from the waveform. 
The bandwidth limit also limits the trigger signal path of any channel that has 
BW Limit turned on.

To change the vertical scale knob's coarse/fine adjustment setting

1 Push the channel's vertical scale knob (or press the channel key and then the 
Fine softkey in the Channel menu) to toggle between fine and coarse 
adjustment of the vertical scale.

When Fine adjustment is selected, you can change the channel's vertical 
sensitivity in smaller increments. The channel sensitivity remains fully calibrated 
when Fine is on.

The vertical scale value is displayed in the status line at the top of the display.

When Fine is turned off, turning the volts/division knob changes the channel 
sensitivity in a 1-2-5 step sequence.

To invert a waveform

1 Press the desired channel key.

2 In the Channel menu, press the Invert softkey to invert the selected channel.

When Invert is selected, the voltage values of the displayed waveform are inverted.

Invert affects how a channel is displayed. However, when using basic triggers, the 
oscilloscope attempts to maintain the same trigger point by changing trigger 
settings.

Inverting a channel also changes the result of any math function selected in the 
waveform Math menu or any measurement.

Setting Analog Channel Probe Options

1 Press the probe's associated channel key.
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2 In the Channel menu, press the Probe softkey to display the Channel Probe 
menu.

The Channel Probe menu lets you select additional probe 
parameters such as attenuation factor and units of 
measurement for the connected probe.

The Probe Check softkey guides you through the process of 
compensating passive probes (such as the N2140A, N2142A, 
N2862A/B, N2863A/B, N2889A, N2890A, 10073C, 10074C, 
or 1165A probes).

See Also • "To specify the channel units" on page 52

• "To specify the probe attenuation" on page 52

• "To specify the probe skew" on page 53

To specify the channel units

1 Press the probe's associated channel key.

2 In the Channel menu, press Probe.

3 In the Channel Probe menu, press Units; then, select:

• Volts — for a voltage probe.

• Amps — for a current probe.

Channel sensitivity, trigger level, measurement results, and math functions will 
reflect the measurement units you have selected.

To specify the probe attenuation

The probe attenuation factor must be set properly for accurate measurement 
results.
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To set the probe attenuation factor:

1 Press the channel key.

2 Press the Probe softkey until you have selected how you want to specify the 
attenuation factor, choosing either Ratio or Decibels.

3 Turn the Entry knob  to set the attenuation factor for the connected probe.

When measuring voltage values, the attenuation factor can be set from 0.100:1 to 
10000:1 in a 1-2-5 sequence.

When measuring current values with a current probe, the attenuation factor can 
be set from 10.0 V/A to 0.0001 V/A.

When specifying the attenuation factor in decibels, you can select values from 
-20 dB to 80 dB.

If Amps is chosen as the units and a manual attenuation factor is chosen, then the 
units as well as the attenuation factor are displayed.

To specify the probe skew

When measuring time intervals in the nanoseconds (ns) range, small differences in 
cable length can affect the measurement. Use Skew to remove cable-delay errors 
between any two channels.

1 Probe the same point with both probes.

2 Press one of the probes associated channel key.

3 In the Channel menu, press Probe.

4 In the Channel Probe menu, press Skew; then, select the desired skew value.

Each analog channel can be adjusted ±100 ns for a total of 200 ns difference.

The skew setting is not affected by pressing [Default Setup] or [Auto Scale].
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4 Analog Bus Display

You can display a bus made up of the analog channel inputs and, on 2-channel 
oscilloscope models, the external trigger input. Any of the input channels can be 
assigned to the bus.

To display an analog bus:

1 Press the [Analyze] key.

2 Press Features; then, select Analog Bus.

3 Press Features again (or push the Entry knob) to enable the analog bus display.

4 To assign channels to the bus, press the Channel softkey, turn the Entry knob to 
select the channel, and then press Channel again to include or exclude the 
channel in the bus.

5 To specify the analog bus value number base, press Base and turn the Entry 
knob to select Hex or Binary.

6 To specify the channel threshold voltage levels, which determines 0 and 1 bit 
levels in the bus value, use the Source softkey and the Entry knob to select a 
channel, then use the Threshold softkey and Entry knob to specify its threshold 
voltage.

You can push the Entry knob to toggle between Source and Threshold softkey 
selection.
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The bus values display appears at the bottom of the graticule, above any serial 
bus waveforms (if present). Channel 1 is the least significant bit and channel 4 is 
the most significant bit.
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5 FFT Spectral Analysis

FFT is used to compute the fast Fourier transform of analog input signals. FFT 
takes the digitized time record of the specified source and transforms it to the 
frequency domain. When the FFT function is selected, the FFT spectrum is plotted 
on the oscilloscope display as magnitude in dBV versus frequency. The readout for 
the horizontal axis changes from time to frequency (Hertz) and the vertical readout 
changes from volts to dB.

Use the FFT function to find crosstalk problems, to find distortion problems in 
analog waveforms caused by amplifier non-linearity, or for adjusting analog filters.

To display a FFT waveform:

1 Press the [FFT] key.

• Source 1 — selects the source for the FFT.

• Settings — displays the FFT Settings menu.

• Span — specifies the frequency range represented by the 
width of the display. Divide span by 10 to calculate the 
frequency scale per division.

• Center — specifies the frequency at the center vertical grid 
line of the display.
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2 Press the Settings softkey to display additional FFT settings.

• Source 1 — selects the source for the FFT.

• Window— selects a window to apply to your FFT input 
signal:

• Hanning — window for making accurate frequency 
measurements or for resolving two frequencies that are 
close together.

• Flat Top — window for making accurate amplitude 
measurements of frequency peaks.

• Rectangular — good frequency resolution and amplitude 
accuracy, but use only where there will be no leakage 
effects. Use on self-windowing waveforms such as 
pseudo-random noise, impulses, sine bursts, and 
decaying sinusoids.

• Blackman Harris — window reduces time resolution 
compared to a rectangular window, but improves the 
capacity to detect smaller impulses due to lower 
secondary lobes.

• Vertical Units — lets you select Decibels or V RMS as the units for the FFT 
vertical scale.

• Auto Setup — sets the frequency Span and Center to values that will cause 
the entire available spectrum to be displayed. The maximum available 
frequency is half the FFT sample rate, which is a function of the time per 
division setting. The FFT resolution is the quotient of the sampling rate and 
the number of FFT points (fS/N). The current FFT Resolution is displayed.

NOTE Scale and offset considerations

If you do not manually change the FFT scale or offset settings, when you turn the horizontal 
scale knob, the span and center frequency settings will automatically change to allow 
optimum viewing of the full spectrum.

If you do manually set scale or offset, turning the horizontal scale knob will not change the 
span or center frequency settings, allowing you see better detail around a specific frequency.

Pressing the FFT Auto Setup softkey will automatically rescale the waveform and span and 
center will again automatically track the horizontal scale setting.
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3 To make cursor measurements, press the [Cursors] key and set the Source 
softkey to Math N.

Use the X1 and X2 cursors to measure frequency values and difference between 
two frequency values (ΔX). Use the Y1 and Y2 cursors to measure amplitude in 
dB and difference in amplitude (ΔY).

4 To make other measurements, press the [Meas] key and set the Source softkey to 
Math N.

You can make peak-to-peak, maximum, minimum, and average dB 
measurements on the FFT waveform. You can also find the frequency value at 
the first occurrence of the waveform maximum by using the X at Max Y 
measurement.

To adjust the FFT waveform scale and offset, use the multiplexed scale and 
position knobs next to the [Math] key to re-size and re-position the math 
waveform.

The following FFT spectrum was obtained by connecting a 2.5 V, 100 kHz square 
wave to channel 2. Set the horizontal scale to 50 µs/div, vertical sensitivity to 
1 V/div, Units/div to 20 dBV, Offset to -40.0 dBV, Center frequency to 500 kHz, 
frequency Span to 1 MHz, and window to Hanning.

See Also • "FFT Measurement Hints" on page 60
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• "FFT Units" on page 61

• "FFT DC Value" on page 61

• "FFT Aliasing" on page 62

• "FFT Spectral Leakage" on page 63

• "Units for Math Waveforms" on page 67

FFT Measurement Hints

The number of points acquired for the FFT record can be up to 65,536, and when 
frequency span is at maximum, all points are displayed. Once the FFT spectrum is 
displayed, the frequency span and center frequency controls are used much like 
the controls of a spectrum analyzer to examine the frequency of interest in greater 
detail. Place the desired part of the waveform at the center of the screen and 
decrease frequency span to increase the display resolution. As frequency span is 
decreased, the number of points shown is reduced, and the display is magnified.

While the FFT spectrum is displayed, use the [Math] and [Cursors] keys to switch 
between measurement functions and frequency domain controls in FFT menu.

Decreasing the effective sampling rate by selecting a greater time/div setting will 
increase the low frequency resolution of the FFT display and also increase the 
chance that an alias will be displayed. The resolution of the FFT is the effective 
sample rate divided by the number of points in the FFT. The actual resolution of 
the display will not be this fine as the shape of the window will be the actual 
limiting factor in the FFTs ability to resolve two closely space frequencies. A good 
way to test the ability of the FFT to resolve two closely spaced frequencies is to 
examine the sidebands of an amplitude modulated sine wave.

For the best vertical accuracy on peak measurements:

• Make sure the probe attenuation is set correctly. The probe attenuation is set 
from the Channel menu if the operand is a channel.

NOTE FFT Resolution

The FFT resolution is the quotient of the sampling rate and the number of FFT points (fS/N). 
With a fixed number of FFT points (up to 65,536), the lower the sampling rate, the better the 
resolution.
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• Set the source sensitivity so that the input signal is near full screen, but not 
clipped.

• Use the Flat Top window.

• Set the FFT sensitivity to a sensitive range, such as 2 dB/division.

For best frequency accuracy on peaks:

• Use the Hanning window.

• Use Cursors to place an X cursor on the frequency of interest.

• Adjust frequency span for better cursor placement.

• Return to the Cursors menu to fine tune the X cursor.

For more information on the use of FFTs, please refer to Keysight Application Note 
243, The Fundamentals of Signal Analysis at 
http://literature.cdn.keysight.com/litweb/pdf/5952-8898E.pdf. Additional 
information can be obtained from Chapter 4 of the book Spectrum and Network 
Measurements by Robert A. Witte.

FFT Units

0 dBV is the amplitude of a 1 Vrms sinusoid. When the FFT source is channel 1 or 
channel 2 (or channel 3 or 4 on 4-channel models), FFT units will be displayed in 
dBV when channel units is set to Volts and channel impedance is set to 1 MΩ.

FFT units will be displayed in dBm when channel units is set to Volts and channel 
impedance is set to 50Ω.

FFT units will be displayed as dB for all other FFT sources or when a source 
channel's units has been set to Amps.

FFT DC Value

The FFT computation produces a DC value that is incorrect. It does not take the 
offset at center screen into account. The DC value is not corrected in order to 
accurately represent frequency components near DC.

http://literature.cdn.keysight.com/litweb/pdf/5952-8898E.pdf
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FFT Aliasing

When using FFTs, it is important to be aware of frequency aliasing. This requires 
that the operator have some knowledge as to what the frequency domain should 
contain, and also consider the sampling rate, frequency span, and oscilloscope 
vertical bandwidth when making FFT measurements. The FFT resolution (the 
quotient of the sampling rate and the number of FFT points) is displayed 
on-screen when the FFT menu is open.

Aliasing happens when there are frequency components in the signal higher than 
half the sample rate. Because the FFT spectrum is limited by this frequency, any 
higher components are displayed at a lower (aliased) frequency.

The following figure illustrates aliasing. This is the spectrum of a 990 Hz square 
wave, which has many harmonics. The horizontal time/div setting for the square 
wave sets the sample rate and results in a FFT resolution of 1.91 Hz. The displayed 
FFT spectrum waveform shows the components of the input signal above the 
Nyquist frequency to be mirrored (aliased) on the display and reflected off the right 
edge.

NOTE Nyquist Frequency and Aliasing in the Frequency Domain

The Nyquist frequency is the highest frequency that any real-time digitizing oscilloscope can 
acquire without aliasing. This frequency is half of the sample rate. Frequencies above the 
Nyquist frequency will be under sampled, which causes aliasing. The Nyquist frequency is also 
called the folding frequency because aliased frequency components fold back from that 
frequency when viewing the frequency domain.
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Because the frequency span goes from ≈ 0 to the Nyquist frequency, the best way 
to prevent aliasing is to make sure that the frequency span is greater than the 
frequencies of significant energy present in the input signal.

FFT Spectral Leakage

The FFT operation assumes that the time record repeats. Unless there is an 
integral number of cycles of the sampled waveform in the record, a discontinuity is 
created at the end of the record. This is referred to as leakage. In order to minimize 
spectral leakage, windows that approach zero smoothly at the beginning and end 
of the signal are employed as filters to the FFT. The FFT menu provides four 
windows: Hanning, Flat Top, Rectangular, and Blackman-Harris. For more 
information on leakage, see Keysight Application Note 243, The Fundamentals of 
Signal Analysis at 
http://literature.cdn.keysight.com/litweb/pdf/5952-8898E.pdf.

Figure 9 Aliasing

http://literature.cdn.keysight.com/litweb/pdf/5952-8898E.pdf
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6 Math Waveforms
To display math waveforms / 66
To perform a math function on an arithmetic operation / 67
To adjust the math waveform scale and offset / 67
Units for Math Waveforms / 67
Math Operators / 68
Math Transforms / 70
Math Filters / 74

Math functions can be performed on analog channels. The resulting math 
waveform is displayed in light purple.

You can use a math function on a channel even if you choose not to display the 
channel on-screen.

You can:

• Perform an arithmetic operation (like add, subtract, or multiply) on analog input 
channels.

• Perform a transform function (like FFT) on an analog input channel.

• Perform a transform function on the result of an arithmetic operation.
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To display math waveforms

1 Press the [Math] key on the front panel to display the waveform Math menu.

2 If f(t) is not already shown on the Function softkey, press the 
Function sofkey and select f(t): Displayed.

3 Use the Operator softkey to select an operator or transform.

For more information on the operators, transforms, or filters, 
see:

• "Math Operators" on page 68

• "Math Transforms" on page 70

• "Math Filters" on page 74

4 Use the Source 1 softkey to select the analog channel on 
which to perform math. You can rotate the Entry knob or 
repetitively press the Source 1 softkey to make your selection. 
If you choose a transform function (FFT) the result is 
displayed.

5 If you select an arithmetic operator, use the Source 2 softkey 
to select the second source for the arithmetic operation. The 
result is displayed.

6 To re-size and re-position the math waveform, see "To adjust the math 
waveform scale and offset" on page 67.

TIP Math Operating Hints

If the analog channel or math function is clipped (not fully displayed on screen) the resulting 
displayed math function will also be clipped.

Once the function is displayed, the analog channel(s) may be turned off for better viewing of 
the math waveform.

The vertical scaling and offset of each math function can be adjusted for ease of viewing and 
measurement considerations.

The math function waveform can be measured using [Cursors] and/or [Meas].
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To perform a math function on an arithmetic operation

To perform an FFT or low-pass filter math function on an arithmetic operation 
(add, subtract, or multiply):

1 Press the Function softkey and select g(t): Internal.

2 Use the Operator, Source 1, and Source 2 softkeys to set up an arithmetic 
operation.

3 Press the Function softkey and select f(t): Displayed.

4 Use the Operator softkey to select an FFT or low-pass filter math function.

5 Press the Source 1 softkey and select g(t) as the source. Note that g(t) is only 
available when you select an FFT or low-pass filter math function in the 
previous step.

To adjust the math waveform scale and offset

Use the multiplexed scale and position knobs next to the [Math] key to re-size and 
re-position the math waveform.

See Also • "Units for Math Waveforms" on page 67

Units for Math Waveforms

Units for each input channel can be set to Volts or Amps using the Units softkey in 
the Channel Probe menu. Units for math function waveforms are:

NOTE Math Scale and Offset are Set Automatically

Any time the currently displayed math function definition is changed, the function is 
automatically scaled for optimum vertical scale and offset. If you manually set scale and offset 
for a function, select a new function, then select the original function, the original function will 
be automatically rescaled.
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A scale unit of U (undefined) will be displayed for math functions when two source 
channels are used and they are set to dissimilar units and the combination of units 
cannot be resolved.

Math Operators

Math operators perform arithmetic operations (add, subtract, or multiply) on 
analog input channels.

• "Add or Subtract" on page 68

• "Multiply or Divide" on page 69

Add or Subtract

When you select add or subtract, the Source 1 and Source 2 values are added or 
subtracted point by point, and the result is displayed.

You can use subtract to make a differential measurement or to compare two 
waveforms.

If your waveforms' DC offsets are larger than the dynamic range of the 
oscilloscope's input channels you will need to use a differential probe instead.

Math function Units

add or subtract V or A

multiply V2, A2, or W (Volt-Amp)

FFT Magnitude dB (decibels) or V RMS.

FFT Phase degrees or radians



Math Waveforms 6

Keysight InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes User's Guide 69

 See Also • "Units for Math Waveforms" on page 67

Multiply or Divide

When you select the multiply or divide math function, the Source 1 and Source 2 
values are multiplied or divided point by point, and the result is displayed.

The divide by zero case places holes (that is, zero values) in the output waveform.

Multiply is useful for seeing power relationships when one of the channels is 
proportional to the current.

Figure 10 Example of Subtract Channel 2 from Channel 1
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Math Transforms

Math transforms perform a transform function (FFT) on an analog input channel or 
on the result of an arithmetic operation.

• "FFT Magnitude, FFT Phase" on page 70

FFT Magnitude, FFT Phase

Using the Fast Fourier Transform (FFT), the FFT (Magnitude) math function 
displays the magnitudes of the frequency content that makes up the source 
waveform, and the FFT (Phase) math function shows the phase relationships of the 
frequency content. The FFT takes the digitized time record of the specified source 
and transforms it to the frequency domain.

The source of the FFT math functions can be analog input channels or an 
arithmetic operation g(t).

Figure 11 Example of Multiply Channel 1 by Channel 2
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The horizontal axis of FFT math functions is frequency (Hertz). For the FFT 
(Magnitude) math function, the vertical axis is in decibels or V RMS. For the FFT 
(Phase) math function, the vertical axis is in degrees or radians.

Use the FFT (Magnitude) function to find crosstalk problems, to find distortion 
problems in analog waveforms caused by amplifier non-linearity, or for adjusting 
analog filters.

To display a FFT waveform:

1 Press the [Math] key, press the Function softkey and select f(t), press the Operator 
softkey and select FFT (Magnitude) or FFT (Phase).

• More — displays the FFT settings menu.

• Auto Setup — sets the frequency Span and Center to values 
that will cause the entire available spectrum to be 
displayed. The maximum available frequency is half the 
FFT sample rate, which is a function of the time per 
division setting. The FFT resolution is the quotient of the 
sampling rate and the number of FFT points (fS/N). The 
current FFT Resolution is displayed.
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2 Press the More softkey to display the FFT settings.

• Source 1 — selects the source for the FFT. (See "To perform 
a math function on an arithmetic operation" on 
page 67 for information about using g(t) as the source.)

• Span — sets the overall width of the FFT spectrum that you 
see on the display (left to right). Divide span by 10 to 
calculate the number of Hertz per division. It is possible to 
set Span above the maximum available frequency, in 
which case the displayed spectrum will not take up the 
whole screen. Press the Span softkey, then turn the Entry 
knob to set the desired frequency span of the display.

• Center — sets the FFT spectrum frequency represented at 
the center vertical grid line of the display. It is possible to 
set the Center to values below half the span or above the 
maximum available frequency, in which case the displayed 
spectrum will not take up the whole screen. Press the 
Center softkey, then turn the Entry knob to set the desired 
center frequency of the display.

• Window— selects a window to apply to your FFT input signal:

• Hanning — window for making accurate frequency measurements or for 
resolving two frequencies that are close together.

• Flat Top — window for making accurate amplitude measurements of 
frequency peaks.

• Rectangular — good frequency resolution and amplitude accuracy, but use 
only where there will be no leakage effects. Use on self-windowing 
waveforms such as pseudo-random noise, impulses, sine bursts, and 
decaying sinusoids.

• Blackman Harris — window reduces time resolution compared to a 
rectangular window, but improves the capacity to detect smaller impulses 
due to lower secondary lobes.

• Vertical Units — For FFT (Magnitude), you can select Decibels or V RMS. For 
FFT (Phase), you can select Degrees or Radians.

Use the knobs for the [Math] key to adjust the FFT waveform vertical scale 
and offset.
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3 To make cursor measurements, press the [Cursors] key and set the Source 
softkey to Math: f(t).

Use the X1 and X2 cursors to measure frequency values and difference between 
two frequency values (ΔX). Use the Y1 and Y2 cursors to measure amplitude in 
dB and difference in amplitude (ΔY).

4 To make other measurements, press the [Meas] key and set the Source softkey to 
Math: f(t).

You can make peak-to-peak, maximum, minimum, and average dB 
measurements on the FFT waveform. You can also find the frequency value at 
the first occurrence of the waveform maximum by using the X at Max Y 
measurement.

The following FFT spectrum was obtained by connecting a 4 V, 75 kHz square 
wave to channel 1. Set the horizontal scale to 50 µs/div, vertical sensitivity to 
1 V/div, Units/div to 20 dBV, Offset to -60.0 dBV, Center frequency to 250 kHz, 
frequency Span to 500 kHz, and window to Hanning.

NOTE Scale and offset considerations

If you do not manually change the FFT scale or offset settings, when you turn the horizontal 
scale knob, the span and center frequency settings will automatically change to allow 
optimum viewing of the full spectrum.

If you do manually set scale or offset, turning the horizontal scale knob will not change the 
span or center frequency settings, allowing you see better detail around a specific frequency.

Pressing the FFT Auto Setup softkey will automatically rescale the waveform and span and 
center will again automatically track the horizontal scale setting.
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See Also • "To perform a math function on an arithmetic operation" on page 67

• "FFT Measurement Hints" on page 60

• "FFT Units" on page 61

• "FFT DC Value" on page 61

• "FFT Aliasing" on page 62

• "FFT Spectral Leakage" on page 63

• "Units for Math Waveforms" on page 67

Math Filters

You can use math filters to create a waveform that is the result of a low-pass filter 
on an analog input channel or on the result of an arithmetic operation.

• "Low Pass Filter" on page 74

Low Pass Filter

The low-pass filter function applies the filter to the selected source waveform and 
display the resut in the math waveform.
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The low-pass filter is a 4th order Bessel-Thompson filter.

Use the Bandwidth softkey to select the filter's -3 dB cutoff frequency.

NOTE The ratio of the input signal's Nyquist frequency and the selected -3 dB cutoff frequency 
affects how many points are available in the output, and under some circumstances, there are 
no points in the output waveform.

Figure 12 Example of Low Pass Filter
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7 Reference Waveforms
To save a waveform to a reference waveform location / 77
To display a reference waveform / 78
To scale and position reference waveforms / 79
To adjust reference waveform skew / 79
To display reference waveform information / 80
To save/recall reference waveform files to/from a USB storage device / 80

Analog channel or math waveforms can be saved to one of two reference 
waveform locations in the oscilloscope. Then, a reference waveform can be 
displayed and compared against other waveforms. One reference waveform can 
be displayed at a time.

You can adjust the vertical scale and offset of reference waveforms. There is also a 
skew adjustment for reference waveforms. Reference waveform scale, offset, and 
skew information can optionally be included on the oscilloscope display.

Analog channel, math, or reference waveforms can be saved to a reference 
waveform file on a USB storage device. You can recall a reference waveform file 
from a USB storage device into one of the reference waveform locations.

To save a waveform to a reference waveform location

1 Press the [Analyze] key.

2 Press Features; then, select R1 or R2.

3 Press Features again (or push the Entry knob) to turn on the reference waveform.

4 Press Save/Clear.
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5 In the Save/Clear menu, press the Source softkey and turn the Entry knob to 
select the source waveform.

6 Press the Save to R1/R2 softkey to save the waveform to the reference waveform 
location.

To clear a
reference

waveform location

1 Press the [Analyze] key.

2 Press Features; then, select R1 or R2.

3 Press Features again (or push the Entry knob) to turn on the reference waveform.

4 Press Save/Clear.

5 In the Save/Clear menu, press the Clear R1/R2 softkey to clear the reference 
waveform location.

Reference waveforms are also cleared by a Factory Default or Secure Erase (see 
Chapter 20, “Save/Recall (Setups, Screens, Data),” starting on page 217).

To display a reference waveform

1 Press the [Analyze] key.

2 Press Features; then, select R1 or R2.

3 Press Features again (or push the Entry knob) to turn on the reference waveform.

NOTE Reference waveforms are non-volatile — they remain after power cycling or performing a 
default setup.
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One reference waveform can be displayed at a time.

See Also • "To display reference waveform information" on page 80

To scale and position reference waveforms

1 Display the desired reference waveform (see "To display a reference 
waveform" on page 78).

2 Press the Scale softkey and turn the Entry knob to adjust the reference 
waveform vertical scale.

3 Press the Offset softkey and turn the Entry knob to adjust the reference 
waveform vertical offset.

To adjust reference waveform skew

Once reference waveforms are displayed, you can adjust their skew.

1 Display the desired reference waveform (see "To display a reference 
waveform" on page 78).
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2 Press the Skew softkey and turn the Entry knob to adjust the reference 
waveform skew.

To display reference waveform information

1 Press the [Analyze] key.

2 Press Features; then, select R1 or R2.

3 Press Save/Clear.

4 In the Save/Clear menu, press the Display Info softkey to enable or disable 
reference waveform information on the oscilloscope display.

5 Press the Transparent softkey to enable or disable transparent information 
backgrounds.

This setting is also used for other oscilloscope information on the display, like 
mask test statistics, etc.

To save/recall reference waveform files to/from a USB storage 
device

Analog channel, math, or reference waveforms can be saved to a reference 
waveform file on a USB storage device. See "To save reference waveform files to a 
USB storage device" on page 222.

You can recall a reference waveform file from a USB storage device into one of the 
reference waveform locations. See "To recall reference waveform files from a USB 
storage device" on page 226.
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8 Serial Bus Decode/Trigger

Depending on the oscilloscope model, the following hardware-accelerated serial 
decode and trigger features are available:

Triggering on
Serial Data

In some cases, such as when triggering on a slow serial signal (for example, I2C, 
SPI, CAN, LIN, etc.), to stabilize the waveform display, it may be necessary to 
switch from the Auto trigger mode to the Normal trigger mode to prevent the 
oscilloscope from auto-triggering. You can select the trigger mode by pressing the 
[Trigger] key, then the Mode softkey.

Also, the threshold voltage level must be set appropriately for each source 
channel. The threshold level for each serial signal can be set in the Signals menu 
(press [Analyze] > Features, select Serial Bus, then press the Signals softkey).

See Also • Chapter 25, “CAN Triggering and Serial Decode,” starting on page 277

• Chapter 26, “I2C Triggering and Serial Decode,” starting on page 287

• Chapter 27, “LIN Triggering and Serial Decode,” starting on page 295

Serial decode and trigger type: Available on:

CAN (Controller Area Network) DSOX1200-Series models

I2C (Inter-IC) DSOX1200-Series and EDUX1052A/G 
models

LIN (Local Interconnect Network) DSOX1200-Series models

SPI (Serial Peripheral Interface) DSOX1200-Series models

UART (Universal Asynchronous Receiver/Transmitter) 
protocols including RS232 (Recommended Standard 232)

DSOX1200-Series and EDUX1052A/G 
models
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• Chapter 28, “SPI Triggering and Serial Decode,” starting on page 303

• Chapter 29, “UART/RS232 Triggering and Serial Decode,” starting on page 315
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9 Display Settings
To adjust waveform intensity / 83
To set or clear persistence / 85
To clear the display / 86
To select the grid type / 86
To adjust the grid intensity / 87
To add an annotation / 87
To freeze the display / 89

To adjust waveform intensity

You can adjust the intensity of displayed waveforms to account for various signal 
characteristics, such as fast time/div settings and low trigger rates.

Increasing the intensity lets you see the maximum amount of noise and 
infrequently occurring events.

Reducing the intensity can expose more detail in complex signals as shown in the 
following figures.

1 Press the [Intensity] key to illuminate it.

This key is located just below the Entry knob.

2 Turn the Entry knob to adjust the waveform instensity.

Waveform intensity adjustment affects analog channel waveforms only (not math 
waveforms, reference waveforms, etc.).
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Figure 13 Amplitude Modulation Shown at 100% Intensity

Figure 14 Amplitude Modulation Shown at 40% Intensity
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To set or clear persistence

With persistence, the oscilloscope updates the display with new acquisitions, but 
does not immediately erase the results of previous acquisitions. All previous 
acquisitions are displayed with reduced intensity. New acquisitions are shown in 
their normal color with normal intensity.

Waveform persistence is kept only for the current display area; you cannot pan 
and zoom the persistence display.

To use persistence:

1 Press the [Display] key.

2 In the Display menu, press Persistence.

3 In the Persistence menu, press Persistence; then, turn the Entry knob to select 
between:

• Off — turns off persistence.

When persistence is off, you can press the Capture Waveforms softkey to 
perform a single-shot infinite persistence. A single acquisition's data is 
displayed with reduced intensity, and it remains on the display until you 
clear persistence or clear the display.

• ∞ Persistence — (infinite presistence) Results of previous acquisitions are 
never erased.

Use infinite persistence to measure noise and jitter, to see the worst-case 
extremes of varying waveforms, to look for timing violations, or to capture 
events that occur infrequently.

• Variable Persistence — Results of previous acquisitions are erased after a 
certain amount of time.

Variable persistence gives you a view of acquired data that is similar to 
analog oscilloscopes.

When variable persistence is selected, press the Time softkey and use the 
Entry knob to specify the amount of time that previous acquisitions are to be 
displayed.

The display will begin accumulating multiple acquisitions.

4 To erase the results of previous acquisitions from the display, press the Clear 
Persistence softkey.
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The oscilloscope will start to accumulate acquisitions again.

5 To return the oscilloscope to the normal display mode, turn off persistence; 
then, press the Clear Persistence softkey.

Turning off persistence does not clear the display. The display is cleared if you 
press the Clear Display softkey or if you press the [Auto Scale] key (which also 
turns off persistence).

For another method of seeing worst-case extremes of varying waveforms, see 
"Glitch or Narrow Pulse Capture" on page 136.

To clear the display

1 Press [Display] > Clear Display.

You can also configure the [Quick Action] key to clear the display. See "Configuring 
the [Quick Action] Key" on page 248.

To select the grid type

When the Video trigger type is selected (see "Video Trigger" on page 108), and the 
vertical scaling of at least one displayed channel is 140 mV/div, the Grid softkey 
lets you select from these grid types:

• Full — the normal oscilloscope grid.

• mV — shows vertical grids, labeled on the left, from -0.3 V to 0.8 V.

• IRE — (Institute of Radio Engineers) shows vertical grids in IRE units, labeled on 
the left, from -40 to 100 IRE. The 0.35 V and 0.7 V levels from the mV grid are 
also shown and labeled at the right. When the IRE grid is selected, cursor values 
are also shown in IRE units. (Cursor values via the remote interface are not in 
IRE units.)

The mV and IRE grid values are accurate (and match Y cursor values) when the 
vertical scaling is 140 mV/division and the vertical offset is 245 mV.

To select the grid type:

1 Press [Display].

2 In the Display menu, press Grid.
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3 In the Grid menu, press the Grid softkey; then, turn the Entry knob  to select 
the grid type.

To adjust the grid intensity

To adjust the display grid (graticule) intensity:

1 Press [Display].

2 In the Display menu, press Grid.

3 In the Grid menu, press the Intensity softkey; then, turn the Entry knob  to 
change the intensity of the displayed grid.

The intensity level is shown in the Intensity softkey and is adjustable from 0 to 
100%.

Each major vertical division in the grid corresponds to the vertical sensitivity 
shown in the status line at the top of the display.

Each major horizontal division in the grid corresponds to the time/div shown in the 
status line at the top of the display.

To add an annotation

You can add an annotation to the upper left corner of the oscilloscope's display. 
The annotation is useful for documentation purposes, to add notes before 
capturing screens.

To add an annotation:

1 On the oscilloscope's front panel, press [Display].

2 In the Display menu, press Annotation.

3 In the Annotation menu, press Annotation to enable the annotation.

4 Press Edit.

5 In the Edit Annotation menu:
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• Use the Spell, , , and Delete Character softkeys to enter the annotation 
text:

• Spell — press this softkey and turn the Entry knob to select the character 
at the current position.

•  — press this softkey to enter characters and move the cursor to the 
next character position.

•  — press this softkey to enter characters and move the cursor to the 
previous character position.

• Delete Character — press the  or  softkeys until the desired character 
is highlighted; then, press this softkey to delete the character.

• Use the Clear softkey to delete all annotation characters.

• Press OK to save the annotation edits.

NOTE You can use a connected USB keyboard instead of using the Spell (and other) character 
editing softkeys.
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6 Press the Back key to return the the Annotation menu.

7 Press the Text Color softkey and turn the Entry knob to select the annotation 
color.

You can choose white, red, or colors that match analog channels, digital 
channels, math waveforms, reference waveforms, or markers.

8 Press the Background softkey and turn the Entry knob to select the annotation 
background:

• Opaque — the annotation has a solid background.

• Inverted — the annotation's foreground and background colors are switched.

• Transparent — the annotation has a transparent background.

See Also • "To save BMP or PNG image files" on page 219

• "To print the oscilloscope's display" on page 229

To freeze the display

To freeze the display without stopping running acquisitions, you must configure 
the [Quick Action] key. See "Configuring the [Quick Action] Key" on page 248.

Back
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1 Once the [Quick Action] key has been configured, press it to freeze the display.

2 To un-freeze the display, press [Quick Action] again.

Manual cursors can be used on the frozen display.

Many activities, such as adjusting the trigger level, adjusting vertical or horizontal 
settings, or saving data will un-freeze the display.
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10 Labels
To turn the label display on or off / 91
To assign a predefined label to a channel / 92
To define a new label / 93
To load a list of labels from a text file you create / 94
To reset the label library to the factory default / 95

You can define labels and assign them to each analog input channel, or you can 
turn labels off to increase the waveform display area.

To turn the label display on or off

1 Press [Display] > Labels > Display.

This turns on labels for the displayed analog channels. Labels are displayed at 
the left edge of the displayed traces.

The figure below shows an example of displayed labels.
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2 To turn the labels off, press the Display softkey again.

To assign a predefined label to a channel

1 Press [Display] > Labels > Edit.

2 Press the Channel softkey, then turn the Entry knob or successively press the 
Channel softkey to select a channel for label assignment.
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The figure above shows the list of channels and their default labels. The 
channel does not have to be turned on to have a label assigned to it.

3 Press the Library softkey, then turn the Entry knob or successively press the 
Library softkey to select a predefined label from the library.

4 Press the Apply New Label softkey to assign the label to your selected channel.

5 Repeat the above procedure for each predefined label you want to assign to a 
channel.

To define a new label

1 Press [Display] > Labels > Edit.

2 Press the Channel softkey; then, turn the Entry knob or successively press the 
softkey to select a channel for label assignment.

The channel does not have to be turned on to have a label assigned to it. If the 
channel is turned on, its current label will be highlighted.

3 Press the Spell softkey; then, turn the Entry knob to select the first character in 
the new label.
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Turning the Entry knob selects a character to enter into the highlighted position 
shown in the "New label =" line and in the Spell softkey. Labels can be up to ten 
characters in length.

4 Press the Enter softkey to enter the selected character and to go to the next 
character position.

5 You may position the highlight on any character in the label name by 
successively pressing the Enter softkey.

6 To delete a character from the label, press the Enter softkey until the letter you 
want to delete is highlighted, then press the Delete Character softkey.

7 When you are done entering characters for the label, press the Apply New Label 
softkey to assign the label to the selected channel.

When you define a new label, it is added to the nonvolatile label list.

Label Assignment
Auto-Increment

When you assign a label ending in a digit, such as ADDR0 or DATA0, the 
oscilloscope automatically increments the digit and displays the modified label in 
the "New label" field after you press the Apply New Label softkey. Therefore, you 
only need to select a new channel and press the Apply New Label softkey again to 
assign the label to the channel. Only the original label is saved in the label list. This 
feature makes it easier to assign successive labels to numbered control lines and 
data bus lines.

To load a list of labels from a text file you create

It may be convenient to create a list of labels using a text editor, then load the 
label list into the oscilloscope. This lets you type on a keyboard rather than edit 
the label list using the oscilloscope's controls.

You can create a list of up to 75 labels and load it into the oscilloscope. Labels are 
added to the beginning of the list. If more than 75 labels are loaded, only the first 
75 are stored.

To load labels from a text file into the oscilloscope:

NOTE You can use a connected USB keyboard instead of using the Spell (and other) character 
editing softkeys.
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1 Use a text editor to create each label. Each label can be up to ten characters in 
length. Separate each label with a line feed.

2 Name the file labellist.txt and save it on a USB mass storage device such as a 
thumb drive.

3 Load the list into the oscilloscope using the File Explorer (press [Utility] > File 
Explorer).

To reset the label library to the factory default

1 Press [Utility] > Options > Preferences.

2 Press the Default Library softkey.

This will delete all user-defined labels from the library and set the labels in the 
library back to the factory default. However, this does not default the labels 
currently assigned to the channels (those labels that appear in the waveform 
area).

NOTE Label List Management

When you press the Library softkey, you will see a list of the last 75 labels used. The list does 
not save duplicate labels. Labels can end in any number of trailing digits. As long as the base 
string is the same as an existing label in the library, the new label will not be put in the library. 
For example, if label A0 is in the library and you make a new label called A12345, the new 
label is not added to the library.

When you save a new user-defined label, the new label will replace the oldest label in the list. 
Oldest is defined as the longest time since the label was last assigned to a channel. Any time 
you assign any label to a channel, that label will move to the newest in the list. Thus, after you 
use the label list for a while, your labels will predominate, making it easier to customize the 
instrument display for your needs.

When you reset the label library list (see next topic), all of your custom labels will be deleted, 
and the label list will be returned to its factory configuration.

NOTE Pressing the Default Library softkey will remove all user-defined labels from the library and 
set the labels back to the factory default. Once deleted, these user-defined labels cannot be 
recovered.
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NOTE Defaulting labels without erasing the default library

Pressing [Default Setup] sets all channel labels back to the default labels but does not erase 
the list of user-defined labels in the library.
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11 Triggers
Adjusting the Trigger Level / 99
Forcing a Trigger / 99
Edge Trigger / 99
Pulse Width Trigger / 102
Pattern Trigger / 104
Rise/Fall Time Trigger / 106
Setup and Hold Trigger / 107
Video Trigger / 108
Serial Trigger / 118

A trigger setup tells the oscilloscope when to acquire and display data. For 
example, you can set up to trigger on the rising edge of the analog channel 1 input 
signal.

You can adjust the vertical level used for analog channel edge detection by 
turning the Trigger Level knob.

In addition to the edge trigger type, you can also set up triggers on pulse widths 
or video signals. On DSOX1200-Series models, you can additionally set up 
triggers on patterns, rise/fall times, or setup and hold violations.
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You can use any input channel or the EXT TRIG input BNC (see "External Trigger 
Input" on page 127) as the source for most trigger types.

Changes to the trigger setup are applied immediately. If the oscilloscope is 
stopped when you change a trigger setup, the oscilloscope uses the new 
specification when you press [Run/Stop] or [Single]. If the oscilloscope is running 
when you change a trigger setup, it uses the new trigger definition when it starts 
the next acquisition.

You can use the [Force] key to acquire and display data when triggers are not 
occurring.

You can use the [Trigger] key to set options that affect all trigger types (see 
Chapter 12, “Trigger Mode/Coupling,” starting on page 121).

You can save trigger setups along with the oscilloscope setup (see Chapter 20, 
“Save/Recall (Setups, Screens, Data),” starting on page 217).

Triggers - General
Information

A triggered waveform is one in which the oscilloscope begins tracing (displaying) 
the waveform, from the left side of the display to the right, each time a particular 
trigger condition is met. This provides stable display of periodic signals such as 
sine waves and square waves, as well as nonperiodic signals such as serial data 
streams.

The figure below shows the conceptual representation of acquisition memory. You 
can think of the trigger event as dividing acquisition memory into a pre-trigger 
and post-trigger buffer. The position of the trigger event in acquisition memory is 
defined by the time reference point and the delay (horizontal position) setting (see 
"To adjust the horizontal delay (position)" on page 39).

Pre-Trigger Buffer Post-Trigger Buffer

Acquisition Memory

Trigger Event
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Adjusting the Trigger Level

You can adjust the trigger level for a selected analog channel by turning the 
Trigger Level knob.

You can push the Trigger Level knob to set the level to the waveform's 50% value. 
If AC coupling is used, pushing the Trigger Level knob sets the trigger level to 
about 0 V.

The position of the trigger level for the analog channel is indicated by the trigger 
level icon  (if the analog channel is on) at the far left side of the display. The 
value of the analog channel trigger level is displayed in the upper-right corner of 
the display.

The line trigger level is not adjustable. This trigger is synchronized with the power 
line supplied to the oscilloscope.

Forcing a Trigger

The [Force] key causes a trigger (on anything) and displays the acquisition.

This key is useful in the Normal trigger mode where acquisitions are made only 
when the trigger condition is met. In this mode, if no triggers are occurring (that is, 
the "Trig'd?" indicator is displayed), you can press [Force] to force a trigger and see 
what the input signals look like.

In the Auto trigger mode, when the trigger condition is not met, triggers are forced 
and the "Auto?" indicator is displayed.

Edge Trigger

The Edge trigger type identifies a trigger by looking for a specified edge (slope) 
and voltage level on a waveform. You can define the trigger source and slope in 
this menu. The trigger type, source, and level (if applicable) are displayed in the 
upper-right corner of the display.

T

NOTE You can also change the trigger level of all channels by pressing [Analyze] > Features and 
then selecting Trigger Levels.
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1 On the front panel, in the Trigger section, press the [Trigger] key.

2 In the Trigger menu, press the Trigger Type softkey.

3 Press the Trigger Type softkey; then, turn the Entry knob to select Edge.

4 Select the trigger source:

• Analog channel, 1 to the number of channels

• External — triggers on the rear panel EXT TRIG input signal.

• Line — triggers at the 50% level of the rising or falling edge of the AC power 
source signal.

• WaveGen — triggers at the 50% level of the rising edge of the waveform 
generator output signal. (Not available when the DC or Noise waveforms are 
selected.)

• WaveGen Mod (FSK/FM) — when waveform generator FSK or FM modulation is 
used, triggers at the 50% level of the rising edge of the modulating signal.

You can choose a channel that is turned off (not displayed) as the source for the 
edge trigger.

The selected trigger source is indicated in the upper-right corner of the display 
next to the slope symbol:

• 1 through 4 = analog channels.

• E = External trigger input.

• L = Line trigger.

• W = Waveform generator.

5 Press the Slope softkey and select rising edge, falling edge, alternating edges, 
or either edge (depending on the selected source). The selected slope is 
displayed in the upper-right corner of the display.
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Using Autoscale to
Set Up Edge

Triggers

The easiest way to set up an Edge trigger on a waveform is to use Autoscale. 
Simply press the [Auto Scale] key and the oscilloscope will attempt to trigger on 
the waveform using a simple Edge trigger type. See "Use Autoscale" on page 24.

NOTE Alternating edge mode is useful when you want to trigger on both edges of a clock (for 
example, DDR signals).

Either edge mode is useful when you want to trigger on any activity of a selected source.

All modes operate up to the bandwidth of the oscilloscope except Either edge mode, which 
has a limitation. Either edge mode will trigger on Constant Wave signals up to 100 MHz, but 
can trigger on isolated pulses down to 1/(2*oscilloscope's bandwidth).

NOTE MegaZoom Technology Simplifies Triggering

With the built-in MegaZoom technology, you can simply Autoscale the waveforms, then stop 
the oscilloscope to capture a waveform. You can then pan and zoom through the data using 
the Horizontal and Vertical knobs to find a stable trigger point. Autoscale often produces a 
triggered display.
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Pulse Width Trigger

Pulse Width (glitch) triggering sets the oscilloscope to trigger on a positive or 
negative pulse of a specified width. If you want to trigger on a specific timeout 
value, use Pattern trigger in the Trigger menu (see "Pattern Trigger" on page 104).

1 Press the [Trigger] key.

2 In the Trigger menu, press the Trigger Type softkey.

3 Press the Trigger Type softkey; then, turn the Entry knob to select Pulse Width.

4 Press the Source softkey; then, rotate the Entry knob to select a channel source 
for the trigger.

The channel you select is shown in the upper-right corner of the display next to 
the polarity symbol.

The source can be any analog channel available on your oscilloscope.

5 Adjust the trigger level by turning the Trigger Level knob.

The value of the trigger level is displayed in the upper-right corner of the 
display.
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6 Press the pulse polarity softkey to select positive ( ) or negative ( ) polarity 
for the pulse width you want to capture.

The selected pulse polarity is displayed in the upper-right corner of the display. 
A positive pulse is higher than the current trigger level or threshold and a 
negative pulse is lower than the current trigger level or threshold.

When triggering on a positive pulse, the trigger will occur on the high to low 
transition of the pulse if the qualifying condition is true. When triggering on a 
negative pulse, the trigger will occur on the low to high transition of the pulse if 
the qualifying condition is true.

7 Press the qualifier softkey (< > ><) to select the time qualifier.

The Qualifier softkey can set the oscilloscope to trigger on a pulse width that is:

• Less than a time value (<).

For example, for a positive pulse, if you set t<20 ns:

• Greater than a time value (>).

For example, for a positive pulse, if you set t>20 ns:

• Within a range of time values (><).

For example, for a positive pulse, if you set t>20 ns and t<30 ns:

8 Select the qualifier time set softkey (< or >), then rotate the Entry knob to set 
the pulse width qualifier time.

The qualifiers can be set as follows:

• 17 ns to 10 s for > or < qualifier.

20 ns 20 ns Trigger

20 ns 20 ns Trigger

20 ns 30 ns Trigger25 ns
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• 20 ns to 10 s for >< qualifier, with minimum difference of 5 ns between upper 
and lower settings.

Pulse width
trigger < qualifier

time set softkey

• When the less than (<) qualifier is selected, the Entry knob sets the oscilloscope 
to trigger on a pulse width less than the time value displayed on the softkey.

• When the time range (><) qualifier is selected, the Entry knob sets the upper 
time range value.

Pulse width
trigger > qualifier

time set softkey

• When the greater than (>) qualifier is selected, the Entry knob sets the 
oscilloscope to trigger on a pulse width greater than the time value displayed 
on the softkey.

• When the time range (><) qualifier is selected, the Entry knob sets the lower 
time range value.

Pattern Trigger

On DSOX1200-Series oscilloscopes, the Pattern trigger identifies a trigger 
condition by looking for a specified pattern. This pattern is a logical AND 
combination of the channels. Each channel can have a value of 0 (low), 1 (high), or 
don't care (X). A rising or falling edge can be specified for one channel included in 
the pattern.

1 Press the [Trigger] key.

2 In the Trigger menu, press the Trigger Type softkey.

3 Press the Trigger Type softkey; then, turn the Entry knob to select Pattern.

4 For each analog channel you want to include in the desired pattern, press the 
Channel softkey to select the channel.

This is the channel source for the 0, 1, X, or edge condition. As you press the 
Channel softkey (or rotate the Entry knob), the channel you select is highlighted 
in the "Pattern =" line and in the upper-right corner of the display next to "Pat".

Adjust the trigger level for the selected analog channel by turning the Trigger 
Level knob. The value of the trigger level is displayed in the upper-right corner 
of the display.

5 For each channel you select, press the Pattern softkey; then, turn the Entry knob 
to set the condition for that channel in the pattern.
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• 0 sets the pattern to zero (low) on the selected channel. A low is a voltage 
level that is less than the channel's trigger level or threshold level.

• 1 sets the pattern to 1 (high) on the selected channel. A high is a voltage 
level that is greater than the channel's trigger level or threshold level.

• X sets the pattern to don't care on the selected channel. Any channel set to 
don't care is ignored and is not used as part of the pattern. However, if all 
channels in the pattern are set to don't care, the oscilloscope will not trigger.

• The rising edge ( ) or falling edge ( ) softkey sets the pattern to an edge 
on the selected channel. Only one rising or falling edge can be specified in 
the pattern. When an edge is specified, the oscilloscope will trigger at the 
edge specified if the pattern set for the other channels is true.

If no edge is specified, the oscilloscope will trigger on the last edge that 
makes the pattern true.

NOTE Specifying an Edge in a Pattern

You are allowed to specify only one rising or falling edge term in the pattern. If you define an 
edge term, then select a different channel in the pattern and define another edge term, the 
previous edge definition is changed to a don't care.
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Rise/Fall Time Trigger

On DSOX1200-Series oscilloscopes, the Rise/Fall Time trigger looks for a rising or 
falling transition from one level to another level in greater than or less than a 
certain amount of time.

1 Press the [Trigger] key.

2 In the Trigger menu, press the Trigger Type softkey.

3 Press the Trigger Type softkey; then, turn the Entry knob to select Rise/Fall Time.

4 Press the Source softkey, and turn the Entry knob to select the input channel 
source.

High level

Low level

Rising edge time Falling edge time
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5 Press the Rising Edge or Falling Edge softkey to toggle between edge types.

6 Press the Level Select softkey to select High; then, turn the Trigger Level knob to 
adjust the high level.

7 Press the Level Select softkey to select Low; then, turn the Trigger Level knob to 
adjust the low level.

You can also push the Trigger Level knob to toggle between High and Low 
selection.

8 Press the Qualifier softkey to toggle between "greater than" or "less than".

9 Press the Time softkey, and turn the Entry knob to select the time.

Setup and Hold Trigger

On DSOX1200-Series oscilloscopes, the Setup and Hold trigger looks for setup 
and hold violations.

One oscilloscope channel probes the clock signal and another channel probes the 
data signal.

To trigger on setup & hold violations:

1 Press the [Trigger] key.

2 In the Trigger menu, press the Trigger Type softkey.

3 Press the Trigger Type softkey; then, turn the Entry knob to select Setup and Hold.

4 Press the Clock softkey; then, turn the Entry knob to select the input channel 
with the clock signal.

5 Set the appropriate trigger tevel for the clock signal using the Trigger Level 
knob.

Data

Clock
(rising
edge)

Setup time Hold time
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6 Press the Rising Edge or Falling Edge softkey to specify the clock edge being used.

7 Press the Data softkey; then, turn the Entry knob to select the input channel 
with the data signal.

8 Set the appropriate trigger tevel for the data signal using the Trigger Level 
knob.

9 Press the < Setup softkey, and turn the Entry knob to select the setup time.

10 Press the < Hold softkey, and turn the Entry knob to select the hold time.

Video Trigger

Video triggering can be used to capture the complicated waveforms of most 
standard analog video signals. The trigger circuitry detects the vertical and 
horizontal interval of the waveform and produces triggers based on the video 
trigger settings you have selected.

The oscilloscope's MegaZoom IV technology gives you bright, easily viewed 
displays of any part of the video waveform. Analysis of video waveforms is 
simplified by the oscilloscope's ability to trigger on any selected line of the video 
signal.
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1 Press the [Trigger] key.

2 In the Trigger menu, press the Trigger Type softkey.

3 Press the Trigger Type softkey; then, turn the Entry knob to select Video.

4 Press the Source softkey and select any analog channel as the video trigger 
source.

The selected trigger source is displayed in the upper-right corner of the display. 
Turning the Trigger Level knob does not change the trigger level because the 
trigger level is automatically set to the sync pulse. Trigger coupling is 
automatically set to TV in the Trigger menu.

NOTE Video triggering is not available when serial decode is on.

NOTE It is important, when using a 10:1 passive probe, that the probe is correctly compensated. The 
oscilloscope is sensitive to this and will not trigger if the probe is not properly compensated, 
especially for progressive formats.



110 Keysight InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes User's Guide

11 Triggers
 

5 Press the sync polarity softkey to set the Video trigger to either positive ( ) or 

negative ( ) sync polarity.

6 Press the Settings softkey.

7 In the Video Trigger menu, press the Standard softkey to set the video standard.

The oscilloscope supports triggering on the following television (TV) and video 
standards.

NOTE Provide Correct Matching

Many video signals are produced from 75 Ω sources. To provide correct matching to these 
sources, a 75 Ω terminator (such as a Keysight 11094B) should be connected to the 
oscilloscope input.
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8 Press the Auto Setup softkey to automatically set up the oscilloscope for the 
selected Source and Standard:

• Source channel vertical scaling is set to 140 mV/div.

• Source channel offset is set to 245 mV.

• Source channel is turned on.

• Trigger type is set to Video.

• Video trigger mode is set to All Lines.

• Display Grid type is set to IRE (when Standard is NTSC) or mV (see "To select 
the grid type" on page 86).

• Horizontal time/division is set to 10 µs/div for NTSC/PAL/SECAM standards.

• Horizontal delay is set so that trigger is at first horizontal division from the 
left.

You can also press [Analyze]> Features and then select Video to quickly access the 
video triggering automatic set up and display options.

9 Press the Mode softkey to select the portion of the video signal that you would 
like to trigger on.

The Video trigger modes available are:

• Field1 and Field2 — Trigger on the rising edge of the first serration pulse of 
field 1 or field 2 (interlaced standards only).

• All Fields — Trigger on the rising edge of the first pulse in the vertical sync 
interval.

• All Lines — Trigger on all horizontal sync pulses.

• Line: Field1 and Line:Field2 — Trigger on the selected line # in field 1 or field 2 
(interlaced standards only).

• Line: Alternate — Alternately trigger on the selected line # in field 1 and field 2 
(NTSC, PAL, PAL-M, and SECAM only).

Standard Type Sync Pulse

NTSC Interlaced Bi-level

PAL Interlaced Bi-level

PAL-M Interlaced Bi-level

SECAM Interlaced Bi-level
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10 If you select a line # mode, press the Line # softkey, then rotate the Entry knob 
to select the line number on which you want to trigger.

The following table lists the line (or count) numbers per field for each video 
standard.

Video Triggering
Examples

The following are exercises to familiarize you with video triggering. These exercises 
use the NTSC video standard.

• "To trigger on a specific line of video" on page 112

• "To trigger on all sync pulses" on page 113

• "To trigger on a specific field of the video signal" on page 114

• "To trigger on all fields of the video signal" on page 115

• "To trigger on odd or even fields" on page 116

To trigger on a specific line of video

Video triggering requires greater than 1/2 division of sync amplitude with any 
analog channel as the trigger source. Turning the trigger Level knob in Video 
trigger does not change the trigger level because the trigger level is automatically 
set to the sync pulse tips.

One example of triggering on a specific line of video is looking at the vertical 
interval test signals (VITS), which are typically in line 18. Another example is 
closed captioning, which is typically in line 21.

1 Press the [Trigger] key.

2 In the Trigger menu, press the Trigger Type softkey.

3 Press the Trigger Type softkey; then, turn the Entry knob to select Video.

4 Press the Settings softkey, then press the Standard softkey to select the 
appropriate TV standard (NTSC).

Video standard Field 1 Field 2 Alt Field

NTSC 1 to 263 1 to 262 1 to 262

PAL 1 to 313 314 to 625 1 to 312

PAL-M 1 to 263 264 to 525 1 to 262

SECAM 1 to 313 314 to 625 1 to 312
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5 Press the Mode softkey and select the TV field of the line you want to trigger on. 
You can choose Line:Field1, Line:Field2, or Line:Alternate.

6 Press the Line # softkey and select the number of the line you want to examine.

To trigger on all sync pulses

To quickly find maximum video levels, you could trigger on all sync pulses. When 
All Lines is selected as the Video trigger mode, the oscilloscope will trigger on all 
horizontal sync pulses.

1 Press the [Trigger] key.

2 In the Trigger menu, press the Trigger Type softkey.

3 Press the Trigger Type softkey; then, turn the Entry knob to select Video.

NOTE Alternate Triggering

If Line:Alternate is selected, the oscilloscope will alternately trigger on the selected line 
number in Field 1 and Field 2. This is a quick way to compare the Field 1 VITS and Field 2 VITS 
or to check for the correct insertion of the half line at the end of Field 1.

Figure 15 Example: Triggering on Line 136
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4 Press the Settings softkey, then press the Standard softkey to select the 
appropriate TV standard.

5 Press the Mode softkey and select All Lines.

To trigger on a specific field of the video signal

To examine the components of a video signal, trigger on either Field 1 or Field 2 
(available for interleaved standards). When a specific field is selected, the 
oscilloscope triggers on the rising edge of the first serration pulse in the vertical 
sync interval in the specified field (1 or 2).

1 Press the [Trigger] key.

2 In the Trigger menu, press the Trigger Type softkey.

3 Press the Trigger Type softkey; then, turn the Entry knob to select Video.

4 Press the Settings softkey, then press the Standard softkey to select the 
appropriate TV standard.

5 Press the Mode softkey and select Field1 or Field2.

Figure 16 Triggering on All Lines
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 To trigger on all fields of the video signal

To quickly and easily view transitions between fields, or to find the amplitude 
differences between the fields, use the All Fields trigger mode.

1 Press the [Trigger] key.

2 In the Trigger menu, press the Trigger Type softkey.

3 Press the Trigger Type softkey; then, turn the Entry knob to select Video.

4 Press the Settings softkey, then press the Standard softkey to select the 
appropriate TV standard.

5 Press the Mode softkey and select All Fields.

Figure 17 Triggering on Field 1
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To check the envelope of your video signals, or to measure worst case distortion, 
trigger on the odd or even fields. When Field 1 is selected, the oscilloscope 
triggers on color fields 1 or 3. When Field 2 is selected, the oscilloscope triggers 
on color fields 2 or 4.

1 Press the [Trigger] key.

2 In the Trigger menu, press the Trigger Type softkey.

3 Press the Trigger Type softkey; then, turn the Entry knob to select Video.

4 Press the Settings softkey, then press the Standard softkey to select the 
appropriate TV standard.

5 Press the Mode softkey and select Field1 or Field2.

The trigger circuits look for the position of the start of Vertical Sync to determine 
the field. But this definition of field does not take into consideration the phase of 
the reference subcarrier. When Field 1 is selected, the trigger system will find any 
field where the vertical sync starts on Line 4. In the case of NTSC video, the 

Figure 18 Triggering on All Fields
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oscilloscope will trigger on color field 1 alternating with color field 3 (see the 
following figure). This setup can be used to measure the envelope of the reference 
burst.

If a more detailed analysis is required, then only one color field should be selected 
to be the trigger. You can do this by using the Field Holdoff softkey in the Video 
Trigger menu. Press the Field Holdoff softkey and use the Entry knob to adjust the 
holdoff in half-field increments until the oscilloscope triggers on only one phase of 
the color burst.

A quick way to synchronize to the other phase is to briefly disconnect the signal 
and then reconnect it. Repeat until the correct phase is displayed.

When holdoff is adjusted using the Field Holdoff softkey and the Entry knob, the 
corresponding holdoff time will be displayed in the Trigger menu.

Figure 19 Triggering on Color Field 1 Alternating with Color Field 3
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Serial Trigger

With serial decode features (see Chapter 8, “Serial Bus Decode/Trigger,” starting 
on page 81), you can enable serial trigger types. To set up these triggers, see:

• "CAN Triggering" on page 279

• "I2C Triggering" on page 288

• "LIN Triggering" on page 297

Table 2 Half-field holdoff time

Standard Time

NTSC 8.35 ms

PAL 10 ms

PAL-M 10 ms

SECAM 10 ms

Figure 20 Using Field Holdoff to Synchronize to Color Field 1 or 3 (Field 1 mode)
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• "SPI Triggering" on page 309

• "UART/RS232 Triggering" on page 317
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12 Trigger Mode/Coupling
To select the Auto or Normal trigger mode / 122
To select the trigger coupling / 124
To enable or disable trigger noise rejection / 125
To enable or disable trigger HF Reject / 125
To set the trigger holdoff / 126
External Trigger Input / 127

To access the trigger mode and coupling options:

• In the Trigger section of the front panel, press the [Trigger] key.
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Noisy Signals If the signal you are probing is noisy, you can set up the oscilloscope to reduce the 
noise in the trigger path and on the displayed waveform. First, stabilize the 
displayed waveform by removing the noise from the trigger path. Second, reduce 
the noise on the displayed waveform.

1 Connect a signal to the oscilloscope and obtain a stable display.

2 Remove the noise from the trigger path by turning on high-frequency rejection 
("To enable or disable trigger HF Reject" on page 125), low-frequency 
rejection ("To select the trigger coupling" on page 124), or "To enable or 
disable trigger noise rejection" on page 125.

3 Use "Averaging Acquisition Mode" on page 138 to reduce noise on the 
displayed waveform.

To select the Auto or Normal trigger mode

When the oscilloscope is running, the trigger mode tells the oscilloscope what to 
do when triggers are not occurring.

In the Auto trigger mode (the default setting), if the specified trigger conditions are 
not found, triggers are forced and acquisitions are made so that signal activity is 
displayed on the oscilloscope.

In the Normal trigger mode, triggers and acquisitions occur only when the 
specified trigger conditions are found.

To select the trigger mode:

1 Press the [Trigger] key.

2 In the Trigger menu, press the Mode softkey; then select either Auto or Normal.

See the following "When to Use Auto Trigger Mode" on page 123 and "When 
to Use Normal Trigger Mode" on page 123 descriptions.

You can also configure the [Quick Action] key to toggle between the Auto and 
Normal trigger modes. See "Configuring the [Quick Action] Key" on page 248.

Triggering and the
Pre- and

Post-Trigger
Buffers

After the oscilloscope starts running (after pressing [Run] or [Single] or changing 
the trigger condition), the oscilloscope first fills the pre-trigger buffer. Then, after 
the pre-trigger buffer is filled, the oscilloscope starts searching for a trigger, and 
sampled data continues to flow data through the pre-trigger buffer in a first-in 
first-out (FIFO) manner.
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When a trigger is found, the pre-trigger buffer contains the events that occurred 
just before the trigger. Then, the oscilloscope fills the post-trigger buffer and 
displays the acquisition memory. If the acquisition was initiated by [Run/Stop], the 
process repeats. If the acquisition was initiated by pressing [Single], the acquisition 
stops (and you can Pan and Zoom the waveform).

In either Auto or Normal trigger mode, a trigger may be missed if the event occurs 
while the pre-trigger buffer is being filled. This may be more likely, for example, 
when the horizontal scale knob is set to a slow time/div setting, such as 
500 ms/div.

Trigger Indicator The trigger indicator at the top right of the display shows whether triggers are 
occurring.

In the Auto trigger mode, the trigger indicator can show:

• Auto? (flashing) — the trigger condition is not found (after the pre-trigger buffer 
has filled), and forced triggers and acquisitions are occurring.

• Auto (not flashing) — the trigger condition is found (or the pre-trigger buffer is 
being filled).

In the Normal trigger mode, the trigger indicator can show:

• Trig'd? (flashing) — the trigger condition is not found (after the pre-trigger buffer 
has filled), and no acquisitions are occurring.

• Trig'd (not flashing) — trigger condition is found (or pre-trigger buffer is being 
filled).

When the oscilloscope is not running, the trigger indicator area shows Stop.

When to Use Auto
Trigger Mode

The Auto trigger mode is appropriate when:

• Checking DC signals or signals with unknown levels or activity.

• When trigger conditions occur often enough that forced triggers are 
unnecessary.

When to Use
Normal Trigger

Mode

The Normal trigger mode is appropriate when:

• You want to acquire only specific events specified by the trigger settings.

• Triggering on an infrequent signal from a serial bus (for example, I2C, SPI, CAN, 
LIN, etc.) or another signal that arrives in bursts. The Normal trigger mode lets 
you stabilize the display by preventing the oscilloscope from auto-triggering.

• Making single-shot acquisitions with the [Single] key.
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Often with single-shot acquisitions, you must initiate some action in the device 
under test, and you don't want the oscilloscope to auto-trigger before that 
happens. Before initiating the action in the circuit, wait for the trigger condition 
indicator Trig'd? to flash (this tells you the pre-trigger buffer is filled).

See Also • "Forcing a Trigger" on page 99

• "To set the trigger holdoff" on page 126

• "To position the time reference (left, center, right)" on page 46

To select the trigger coupling

1 Press the [Trigger] key.

2 In the Trigger menu, press the Coupling softkey; then, turn the Entry knob to 
select:

• DC coupling — allows DC and AC signals into the trigger path.

• AC coupling — places a 10 Hz high-pass filter in the trigger path removing 
any DC offset voltage from the trigger waveform.

The high-pass filter in the External Trigger input path is 50 Hz for all models.

Use AC coupling to get a stable edge trigger when your waveform has a 
large DC offset.

• LF (low frequency) Reject coupling — adds a high-pass filter with the 3-dB 
point at 50 kHz in series with the trigger waveform.

Pass
Band

50 kHz

0 dB

3 dB down point

DC
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Low frequency reject removes any unwanted low frequency components 
from a trigger waveform, such as power line frequencies, etc., that can 
interfere with proper triggering.

Use LF Reject coupling to get a stable edge trigger when your waveform has 
low frequency noise.

• TV coupling — is normally grayed-out, but is automatically selected when 
Video trigger is enabled in the Trigger menu.

Note that Trigger Coupling is independent of Channel Coupling (see "To specify 
channel coupling" on page 50).

To enable or disable trigger noise rejection

Noise Rej adds additional hysteresis to the trigger circuitry. By increasing the 
trigger hysteresis band, you reduce the possibility of triggering on noise. However, 
this also decreases the trigger sensitivity so that a slightly larger signal is required 
to trigger the oscilloscope.

1 Press the [Trigger] key.

2 In the Trigger menu, press Reject; then, select Noise Reject.

3 Press Reject again (or push the Entry knob) to enable or disable.

To enable or disable trigger HF Reject

HF Reject adds a 50 kHz low-pass filter in the trigger path to remove high 
frequency components from the trigger waveform.
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You can use HF Reject to remove high-frequency noise, such as AM or FM 
broadcast stations or noise from fast system clocks, from the trigger path.

1 Press the [Trigger] key.

2 In the Trigger menu, press Reject; then, select HF Reject.

3 Press Reject again (or push the Entry knob) to enable or disable.

To set the trigger holdoff

Trigger holdoff sets the amount of time the oscilloscope waits after a trigger 
before re-arming the trigger circuitry.

Use the holdoff to trigger on repetitive waveforms that have multiple edges (or 
other events) between waveform repetitions. You can also use holdoff to trigger on 
the first edge of a burst when you know the minimum time between bursts.

For example, to get a stable trigger on the repetitive pulse burst shown below, set 
the holdoff time to be >200 ns but <600 ns.

To set the trigger holdoff:

1 Press the [Trigger] key.

Pass
Band

50 kHzDC

0 dB

-3 dB

200 ns

Oscilloscope triggers hereHoldoff

600 ns
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2 In the Trigger menu, press the Holdoff softkey; then, turn the Entry knob to 
increase or decrease the trigger holdoff time.

Trigger Holdoff
Operating Hints

The correct holdoff setting is typically slightly less than one repetition of the 
waveform. Set the holdoff to this time to generate a unique trigger point for a 
repetitive waveform.

Changing the time base settings does not affect the trigger holdoff time.

With Keysight's MegaZoom technology, you can press [Stop], then pan and zoom 
through the data to find where the waveform repeats. Measure this time using 
cursors; then, set the holdoff.

External Trigger Input

The external trigger input can be used as a source in several of the trigger types.

On 4-channel oscilloscopes, the external trigger BNC input is on the rear panel 
and is labeled EXT TRIG.

On 2-channel oscilloscopes, the external trigger BNC input is on the front panel 
and is labeled Ext Trig.

The external trigger input impedance is 1M Ohm. This lets you use passive probes 
for general-purpose measurements. The higher impedance minimizes the loading 
effect of the oscilloscope on the device under test.

To set the external trigger input options:

1 Access the External Trigger menu:

• On 4-channel oscilloscopes:

i Press the [Trigger] key in the Trigger section of the front panel.

ii In the Trigger menu, press the External softkey.

• On 2-channel oscilloscopes, press the [External] key in the Vertical section of 
the front panel.

CAUTION Maximum voltage at oscilloscope external trigger input

30 Vrms, 40 Vpk
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The [External] key also displays the Ext Trig signal's digital waveform. If the 
External Trigger menu is already open, pressing [External] turns the Ext Trig 
waveform display off or on.

The Ext Trig signal's digital waveform is based on its threshold voltage level 
setting.

The external trigger digital waveform view is not available when the XY time 
mode is selected or when the Averaging or High Resolution acquisition 
modes are selected. On EDUX1000-Series oscilloscopes, additionally, the 
external waveform view is not available when the trigger source is not "Ext", 
when the Roll time mode is selected, or when serial bus decode is enabled.

2 In the External Trigger menu, press the Units softkey to select 
between:

• Volts — for a voltage probe.

• Amps — for a current probe.

Measurement results, channel sensitivity, and the trigger 
level will reflect the measurement units you have selected.

3 Press the Probe softkey; then, turn the entry knob to specify 
the probe attenuation.

The attenuation factor can be set from 0.1:1 to 1000:1 in a 
1-2-5 sequence.

The probe attenuation factor must be set properly for 
measurements to be made correctly.

4 Press the Threshold softkey; then, turn the Entry knob to set 
the threshold voltage for the External Trigger input signal.

5 On DSOX1200-Series oscilloscopes, press the Range softkey; then, turn the 
Entry knob to set the External Trigger input signal range. When using a 1:1 
probe, the Ext Trig input signal range is either 1.6 V or 8 V.

On EDUX1000-Series oscilloscopes, when using a 1:1 probe, the Ext Trig input 
signal range is fixed at 8 V (and there is no Range softkey).

The range is automatically recalculated when a different External Trigger probe 
attenuation factor is chosen.

6 On 2-channel oscilloscopes, press the Position softkey; then, turn the Entry 
knob to adjust the vertical position of the Ext Trig signal's digital waveform.
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13 Acquisition Control
Running, Stopping, and Making Single Acquisitions (Run Control) / 129
Overview of Sampling / 130
Selecting the Acquisition Mode / 135
Acquiring to Segmented Memory / 141

This chapter shows how to use the oscilloscope's acquisition and run controls.

Running, Stopping, and Making Single Acquisitions (Run Control)

There are two front panel keys for starting and stopping the oscilloscope's 
acquisition system: [Run/Stop] and [Single].

• When the [Run/Stop] key is green, the oscilloscope is running, that is, acquiring 
data when trigger conditions are met.

To stop acquiring data, press [Run/Stop]. When stopped, the last acquired 
waveform is displayed.

• When the [Run/Stop] key is red, data acquisition is stopped.

"Stop" is displayed next to the trigger type in the status line at the top of the 
display.

To start acquiring data, press [Run/Stop].

• To capture and display a single acquisition (whether the oscilloscope is running 
or stopped), press [Single].

The [Single] run control lets you view single-shot events without subsequent 
waveform data overwriting the display. Use [Single] when you want maximum 
memory depth for pan and zoom.
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When you press [Single], the display is cleared, the trigger mode is temporarily 
set to Normal (to keep the oscilloscope from auto-triggering immediately), the 
trigger circuitry is armed, the [Single] key is illuminated, and the oscilloscope 
waits until a trigger condition occurs before it displays a waveform.

When the oscilloscope triggers, the single acquisition is displayed and the 
oscilloscope is stopped (the [Run/Stop] key is illuminated in red). Press [Single] 
again to acquire another waveform.

If the oscilloscope doesn't trigger, you can press the [Force] key to trigger on 
anything and make a single acquisition.

To display the results of multiple acquisitions, use persistence. See "To set or 
clear persistence" on page 85.

Single vs. Running
and Record Length

The maximum data record length is greater for a single acquisition than when the 
oscilloscope is running (or when the oscilloscope is stopped after running):

• Single — Single acquisitions always use the maximum memory available — at 
least twice as much memory as acquisitions captured when running — and the 
oscilloscope stores at least twice as many samples. At slower time/div settings, 
because there is more memory available for a single acquisition, the acquisition 
has a higher effective sample rate.

• Running — When running (versus taking a single acquisition), the memory is 
divided in half. This lets the acquisition system acquire one record while 
processing the previous acquisition, dramatically improving the number of 
waveforms per second processed by the oscilloscope. When running, a high 
waveform update rate provides the best representation of your input signal.

To acquire data with the longest possible record length, press the [Single] key.

For more information on settings that affect record length, see "Length 
Control" on page 221.

Overview of Sampling

To understand the oscilloscope's sampling and acquisition modes, it is helpful to 
understand sampling theory, aliasing, oscilloscope bandwidth and sample rate, 
oscilloscope rise time, oscilloscope bandwidth required, and how memory depth 
affects sample rate.
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Sampling Theory

The Nyquist sampling theorem states that for a limited bandwidth (band-limited) 
signal with maximum frequency fMAX, the equally spaced sampling frequency fS 
must be greater than twice the maximum frequency fMAX, in order to have the 
signal be uniquely reconstructed without aliasing.

fMAX = fS/2 = Nyquist frequency (fN) = folding frequency

Aliasing

Aliasing occurs when signals are under-sampled (fS < 2fMAX). Aliasing is the signal 
distortion caused by low frequencies falsely reconstructed from an insufficient 
number of sample points.

Oscilloscope Bandwidth and Sample Rate

An oscilloscope's bandwidth is typically described as the lowest frequency at 
which input signal sine waves are attenuated by 3 dB (-30% amplitude error).

Figure 21 Aliasing
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At the oscilloscope bandwidth, sampling theory says the required sample rate is 
fS = 2fBW. However, the theory assumes there are no frequency components above 
fMAX (fBW in this case) and it requires a system with an ideal brick-wall frequency 
response.

However, digital signals have frequency components above the fundamental 
frequency (square waves are made up of sine waves at the fundamental frequency 
and an infinite number of odd harmonics), and typically, for 500 MHz bandwidths 
and below, oscilloscopes have a Gaussian frequency response.

Figure 22 Theoretical Brick-Wall Frequency Response

fSfN

-3dB

At
te

nu
at

io
n

Frequency

0dB



Acquisition Control 13

Keysight InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes User's Guide 133

 So, in practice, an oscilloscope's sample rate should be four or more times its 
bandwidth: fS = 4fBW. This way, there is less aliasing, and aliased frequency 
components have a greater amount of attenuation.

See Also Evaluating Oscilloscope Sample Rates vs. Sampling Fidelity: How to Make the 
Most Accurate Digital Measurements, Keysight Application Note 1587 
(http://literature.cdn.keysight.com/litweb/pdf/5989-5732EN.pdf)

Oscilloscope Rise Time

Closely related to an oscilloscope's bandwidth specification is its rise time 
specification. Oscilloscopes with a Gaussian-type frequency response have an 
approximate rise time of 0.35/fBW based on a 10% to 90% criterion.

An oscilloscope's rise time is not the fastest edge speed that the oscilloscope can 
accurately measure. It is the fastest edge speed the oscilloscope can possibly 
produce.

Figure 23 Sample Rate and Oscilloscope Bandwidth
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Oscilloscope Bandwidth Required

The oscilloscope bandwidth required to accurately measure a signal is primarily 
determined by the signal's rise time, not the signal's frequency. You can use these 
steps to calculate the oscilloscope bandwidth required:

1 Determine the fastest edge speeds.

You can usually obtain rise time information from published specifications for 
devices used in your designs.

2 Compute the maximum "practical" frequency component.

From Dr. Howard W. Johnson's book, High-Speed Digital Design – A 
Handbook of Black Magic, all fast edges have an infinite spectrum of frequency 
components. However, there is an inflection (or "knee") in the frequency 
spectrum of fast edges where frequency components higher than fknee are 
insignificant in determining the shape of the signal.

fknee = 0.5 / signal rise time (based on 10% - 90% thresholds)

fknee = 0.4 / signal rise time (based on 20% - 80% thresholds)

3 Use a multiplication factor for the required accuracy to determine the 
oscilloscope bandwidth required.

See Also Choosing an Oscilloscope with the Right Bandwidth for your Application, Keysight 
Application Note 1588 
(http://literature.cdn.keysight.com/litweb/pdf/5989-5733EN.pdf)

Memory Depth and Sample Rate

The number of points of oscilloscope memory is fixed, and there is a maximum 
sample rate associated with oscilloscope's analog-to-digital converter; however, 
the actual sample rate is determined by the time of the acquisition (which is set 
according to the oscilloscope's horizontal time/div scale).

Required accuracy Oscilloscope bandwidth required

20% fBW = 1.0 x fknee

10% fBW = 1.3 x fknee

3% fBW = 1.9 x fknee

http://literature.cdn.keysight.com/litweb/pdf/5989-5733EN.pdf
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sample rate = number of samples / time of acquisition

For example, when storing 50 µs of data in 50,000 points of memory, the actual 
sample rate is 1 GSa/s.

Likewise, when storing 50 ms of data in 50,000 points of memory, the actual 
sample rate is 1 MSa/s.

The actual sample rate is displayed in the right-side information area when softkey 
menus are off.

The oscilloscope achieves the actual sample rate by throwing away (decimating) 
unneeded samples.

Selecting the Acquisition Mode

When selecting the oscilloscope acquisition mode, keep in mind that samples are 
normally decimated at slower time/div settings.

At slower time/div settings, the effective sample rate drops (and the effective 
sample period increases) because the acquisition time increases and the 
oscilloscope's digitizer is sampling faster than is required to fill memory.

For example, suppose an oscilloscope's digitizer has a sample period of 1 ns 
(maximum sample rate of 1 GSa/s) and a 1 M memory depth. At that rate, memory 
is filled in 1 ms. If the acquisition time is 100 ms (10 ms/div), only 1 of every 100 
samples is needed to fill memory.

To select the acquisition mode:

1 Press the [Acquire] key on the front panel.

2 In the Acquire menu, press the Acq Mode softkey; then, turn the Entry knob to 
select the acquisition mode.

The InfiniiVision oscilloscopes have the following acquisition modes:

• Normal — at slower time/div settings, normal decimation occurs, and there is 
no averaging. Use this mode for most waveforms. See "Normal Acquisition 
Mode" on page 136.

• Peak Detect — at slower time/div settings, the maximum and minimum 
samples in the effective sample period are stored. Use this mode for 
displaying narrow pulses that occur infrequently. See "Peak Detect 
Acquisition Mode" on page 136.
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• Averaging — at all time/div settings, the specified number of triggers are 
averaged together. Use this mode for reducing noise and increasing 
resolution of periodic signals without bandwidth or rise time degradation. 
See "Averaging Acquisition Mode" on page 138.

• High Resolution — at slower time/div settings, all samples in the effective 
sample period are averaged and the average value is stored. Use this mode 
for reducing random noise. See "High Resolution Acquisition Mode" on 
page 140.

Normal Acquisition Mode

In Normal mode at slower time/div settings, extra samples are decimated (in other 
words, some are thrown away). This mode yields the best display for most 
waveforms.

Peak Detect Acquisition Mode

In Peak Detect mode, at slower time/div settings when decimation would normally 
occur, minimum and maximum value samples are kept in order to capture 
infrequent and narrow events (at the expense of exaggerating any noise). This 
mode displays all pulses that are at least as wide as the sample period.

For InfiniiVision 1200 X-Series oscilloscopes, which have a maximum sample rate 
of 2 GSa/s, a sample is taken every 500 ps (sample period).

See Also • "Glitch or Narrow Pulse Capture" on page 136

• "Using Peak Detect Mode to Find a Glitch" on page 138

Glitch or Narrow Pulse Capture

A glitch is a rapid change in the waveform that is usually narrow as compared to 
the waveform. Peak detect mode can be used to more easily view glitches or 
narrow pulses. In peak detect mode, narrow glitches and sharp edges are 
displayed more brightly than when in Normal acquire mode, making them easier 
to see.

To characterize the glitch, use the cursors or the automatic measurement 
capabilities of the oscilloscope.
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Figure 24 Sine With Glitch, Normal Mode

Figure 25 Sine With Glitch, Peak Detect Mode
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Using Peak Detect Mode to Find a Glitch

1 Connect a signal to the oscilloscope and obtain a stable display.

2 To find the glitch, press the [Acquire] key; then, press the Acq Mode softkey until 
Peak Detect is selected.

3 Press the [Display] key then press the ∞ Persistence (infinite persistence) softkey.

Infinite persistence updates the display with new acquisitions but does not 
erase previous acquisitions. New sample points are shown at normal intensity 
while previous acquisitions are displayed at reduced intensity. Waveform 
persistence is not kept beyond the display area boundary.

Press the Clear Display softkey to erase previously acquired points. The display 
will accumulate points until ∞ Persistence is turned off.

4 Characterize the glitch with Zoom mode:

a Press the  zoom key (or press the [Acquire] key and then the Zoom 
softkey).

b To obtain a better resolution of the glitch, expand the time base.

Use the horizontal position knob ( ) to pan through the waveform to set the 
expanded portion of the normal window around the glitch.

Averaging Acquisition Mode

The Averaging mode lets you average multiple acquisitions together to reduce 
noise and increase vertical resolution (at all time/div settings). Averaging requires 
a stable trigger.

The number of averages can be set from 2 to 65536 in power-of-2 increments.

A higher number of averages reduces noise more and increases vertical resolution.

# Avgs Bits of resolution

2 8

4 9

16 10

64 11

≥ 256 12
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The higher the number of averages, the slower the displayed waveform responds 
to waveform changes. You must compromise between how quickly the waveform 
responds to changes and how much you want to reduce the displayed noise on 
the signal.

To use the Averaging mode:

1 Press the [Acquire] key, then press the Acq Mode softkey until the Averaging 
mode is selected.

2 Press the #Avgs softkey and turn the Entry knob to set the number of averages 
that best eliminates the noise from the displayed waveform. The number of 
acquisitions being averaged is displayed in the # Avgs softkey.

Figure 26 Random noise on the displayed waveform
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High Resolution Acquisition Mode

In High Resolution mode, at slower time/div settings extra samples are averaged 
in order to reduce random noise, produce a smoother trace on the screen, and 
effectively increase vertical resolution.

High Resolution mode averages sequential sample points within the same 
acquisition. An extra bit of vertical resolution is produced for every factor of 2 
averages. Random noise is reduced by ½ for every factor of 4 averages. The 
number of extra bits of vertical resolution is dependent on the time per division 
setting (sweep speed) of the oscilloscope.

The slower the time/div setting, the greater the number of samples that are 
averaged together for each display point.

High Resolution mode can be used on both single-shot and repetitive signals and 
it does not slow waveform update because the computation is done in the 
MegaZoom custom ASIC. High Resolution mode limits the oscilloscope's real-time 
bandwidth because it effectively acts like a low-pass filter.

Figure 27 128 Averages used to reduce random noise
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Acquiring to Segmented Memory

Segmented memory is available on DSOX1200-Series models.

When capturing multiple infrequent trigger events it is advantageous to divide the 
oscilloscope's memory into segments. This lets you capture signal activity without 
capturing long periods of signal inactivity.

Each segment is complete with all analog channel and serial decode data.

When using segmented memory, use the Analyze Segments feature (see "Infinite 
Persistence with Segmented Memory" on page 142) to show infinite persistence 
across all acquired segments. See also "To set or clear persistence" on page 85 
for details.

To acquire to
segmented

memory

1 Set up a trigger condition. (See Chapter 11, “Triggers,” starting on page 97 for 
details.)

2 Press the [Acquire] key in the Waveform section of the front panel.

3 Press the Segmented softkey.

4 In the Segmented Mem menu, press the Segmented softkey to enable 
segmented memory acquisitions.

5 Press the # of Segs softkey and turn the Entry knob to select the number of 
segments into which you would like to divide the oscilloscope's memory.

Memory can be divided into as few as two segments and as many as 500 
segments.

6 Press the [Run] or [Single] key.

Sweep speed Bits of resolution

≤ 1 µs/div 8

2 µs/div 9

5 µs/div 10

10 µs/div 11

≥ 20 µs/div 12
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The oscilloscope runs and fills a memory segment for each trigger event. When 
the oscilloscope is busy acquiring multiple segments, the progress is displayed in 
the upper right area of the display. The oscilloscope continues to trigger until 
memory is filled, then the oscilloscope stops.

If the signal you are measuring has more than about 1 s of inactivity, consider 
selecting the Normal trigger mode to prevent auto-triggering. See "To select the 
Auto or Normal trigger mode" on page 122.

See Also • "Navigating Segments" on page 142

• "Infinite Persistence with Segmented Memory" on page 142

• "Segmented Memory Re-Arm Time" on page 142

• "Saving Data from Segmented Memory" on page 143

Navigating Segments

1 Press the Current Seg softkey and turn the Entry knob to display the desired 
segment along with a time tag indicating the time from the first trigger event.

Infinite Persistence with Segmented Memory

When data has been acquired to segmented memory, you can also turn on infinite 
persistence (in the Display menu) and press the Analyze Segments softkey to create 
an infinite persistence display. The Analyze Segments softkey appears when the 
acquisition is stopped and the segmented memory feature is on.

Segmented Memory Re-Arm Time

After each segment fills, the oscilloscope re-arms and is ready to trigger in about 
1 µs.

Remember though, for example: if the horizontal time per division control is set to 
5 µs/div, and the Time Reference is set to Center, it will take at least 50 µs to fill all 
ten divisions and re-arm. (That is 25 µs to capture pre-trigger data and 25 µs to 
capture post-trigger data.)
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Saving Data from Segmented Memory

You can save either the currently displayed segment (Save Segment - Current), or all 
segments (Save Segment - All) in the following data formats: CSV, ASCII XY, and 
BIN.

Be sure to set the Length control to capture enough points to accurately represent 
the captured data. When the oscilloscope is busy saving multiple segments, 
progress is displayed in the upper right area of the display.

For more information, see "To save CSV, ASCII XY, or BIN data files" on page 220.
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14 Cursors
To make cursor measurements / 146
Cursor Examples / 150

Cursors are horizontal and vertical markers that indicate X-axis values and Y-axis 
values on a selected waveform source. You can use cursors to make custom 
voltage, time, phase, or ratio measurements on oscilloscope signals.

Cursor information is displayed in the information area on the bottom of the 
display.

Cursors are not always limited to the visible display. If you set a cursor, then pan 
and zoom the waveform until the cursor is off screen, its value will not be changed. 
It will still be there when you return to its original location.

X Cursors X cursors are vertical dashed lines that adjust horizontally and can be used to 
measure time (s), frequency (1/s), phase (°), and ratio (%).

The X1 cursor is the short-dashed vertical line, and the X2 cursor is the 
long-dashed vertical line.

When used with the FFT math function as a source, the X cursors indicate 
frequency.

In XY horizontal mode, the X cursors display channel 1 values (Volts or Amps).

The X1 and X2 cursor values for the selected waveform source are displayed in the 
softkey menu area.

The difference between X1 and X2 (ΔX) and 1/ΔX are displayed in the Cursors box 
in the bottom information area.
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Y Cursors Y cursors are horizontal dashed lines that adjust vertically and can be used to 
measure Volts or Amps, dependent on the channel Probe Units setting, or they can 
measure ratios (%). When math functions are used as a source, the measurement 
units correspond to that math function.

The Y1 cursor is the short-dashed horizontal line and the Y2 cursor is the 
long-dashed horizontal line.

The Y cursors adjust vertically and typically indicate values relative to the 
waveform's ground point, except math FFT where the values are relative to 0 dB.

In XY horizontal mode, the Y cursors display channel 2 values (Volts or Amps).

When active, the Y1 and Y2 cursor values for the selected waveform source are 
displayed in the softkey menu area.

The difference between Y1 and Y2 (ΔY) is displayed in the Cursors box in the 
bottom information area.

To make cursor measurements

1 Connect a signal to the oscilloscope and obtain a stable display.

2 Press the [Cursors] key.

The Cursors box in the bottom information area appears, indicating that cursors 
are "on". (Press the [Cursors] key again when you want to turn cursors off.)

3 In the Cursors menu, press Mode; then, select the desired mode:
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• Manual — ΔX, 1/ΔX, and ΔY values are displayed. ΔX is the difference 
between the X1 and X2 cursors and ΔY is the difference between the Y1 and 
Y2 cursors.

• Track Waveform — As you move a marker horizontally, 
the vertical amplitude of the waveform is tracked and 
measured. The time and voltage positions are shown 
for the markers. The vertical (Y) and horizontal (X) 
differences between the markers are shown as ΔX and 
ΔY values.

• Binary — Logic levels of displayed waveforms at the 
current X1 and X2 cursor positions are displayed in 
binary. The display is color coded to match the color of 
the related channel's waveform.



148 Keysight InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes User's Guide

14 Cursors
 

• Hex — Logic levels of displayed waveforms at the current X1 and X2 cursor 
positions are displayed in hexadecimal.

Manual and Track Waveform modes can be used on 
waveforms that are displayed on the analog input 
channels (including math functions).

In Hex and Binary modes, a level can be displayed as 1 
(higher than trigger level), 0 (lower than trigger level), 

indeterminate state ( ), or X (don't care).

In Binary mode, X is displayed if the channel is turned off.

In Hex mode, the channel is interpreted as 0 if turned off.

4 Press Source (or X1 Source, X2 Source in the Track Waveform 
mode); then, select the input source for cursor values.

5 Select the cursor(s) to be adjusted:

• Push the Cursors knob; then, turn the Cursors knob. To 
finalize your selection, either push the Cursors knob 
again or wait about five seconds for the popup menu to 
disappear.

Or:

• Press the Cursors softkey; then, turn the Entry knob.

The X1 X2 linked and Y1 Y2 linked selections let you adjust both cursors at the 
same time, while the delta value remains the same. This can be useful, for 
example, for checking pulse width variations in a pulse train.

The currently selected cursor(s) display brighter than the other cursors.

6 To change the cursor units, press the Units softkey.
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In the Cursor Units menu:

You can press the X Units softkey to select:

• Seconds (s).

• Hz (1/s).

• Phase (°) — when selected, use the Use X Cursors softkey to 
set the current X1 location as 0 degrees and the current 
X2 location as 360 degrees.

• Ratio (%) — when selected, use the Use X Cursors softkey to 
set the current X1 location as 0% and the current X2 
location as 100%.

You can press the Y Units softkey to select:

• Base — the same units used for the source waveform.

• Ratio (%) — when selected, use the Use Y Cursors softkey to 
set the current Y1 location as 0% and the current Y2 
location as 100%.

For phase or ratio units, once the 0 and 360 degree or 0 and 100% locations are 
set, adjusting cursors will display measurements relative to the set locations.

7 Adjust the selected cursor(s) by turning the Cursors knob.
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Cursor Examples

Figure 28 Cursors used to measure pulse widths other than middle threshold points
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Expand the display with Zoom mode, then characterize the event of interest with 
the cursors.

Figure 29 Cursors measure frequency of pulse ringing
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Put the X1 cursor on one side of a pulse and the X2 cursor on the other side of the 
pulse.

Figure 30 Cursors track Zoom window
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Press the X1 X2 linked softkey and move the cursors together to check for pulse 
width variations in a pulse train.

Figure 31 Measuring pulse width with cursors
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Figure 32 Moving the cursors together to check pulse width variations
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15 Measurements
To make automatic measurements / 156
Measurements Summary / 157
Voltage Measurements / 160
Time Measurements / 167
Count Measurements / 174
Measurement Thresholds / 175
Measurement Window with Zoom Display / 177
Measurement Statistics / 178

The [Meas] key lets you make automatic measurements on waveforms. Some 
measurements can only be made on analog input channels.

The results of the last four selected measurements are displayed in the 
Measurements information area at the bottom of the screen.

Cursors are turned on to show the portion of the waveform being measured for the 
most recently added measurement.

NOTE Post Acquisition Processing

In addition to changing display parameters after the acquisition, you can perform all of the 
measurements and math functions after the acquisition. Measurements and math functions 
will be recalculated as you pan and zoom and turn channels on and off. As you zoom in and out 
on a signal using the horizontal scale knob and vertical volts/division knob, you affect the 
resolution of the display. Because measurements and math functions are performed on 
displayed data, you affect the resolution of functions and measurements.
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To make automatic measurements

1 Press the [Meas] key to display the Measurement menu.

2 Press the Source softkey to select the channel, running math 
function, or reference waveform to be measured.

Only channels, math functions, or reference waveforms that 
are displayed are available for measurements.

If a portion of the waveform required for a measurement is 
not displayed or does not display enough resolution to make 
the measurement, the result will display "No Edges", 
"Clipped", "Low Signal", "< value", or "> value", or a similar 
message to indicate that the measurement may not be 
reliable.

3 Press the Type softkey then rotate the Entry knob to select a 
measurement to be made.

For more information on the types of measurements, see "Measurements 
Summary" on page 157.
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4 The Settings softkey will be available to make additional measurement settings 
on some measurements.

5 Press the Add Measurement softkey or push the Entry knob to display the 
measurement.

6 To turn off measurements, press the [Meas] key again.

Measurements are erased from the display.

7 To stop making one or more measurements, press the Clear Meas softkey and 
choose the measurement to clear, or press Clear All.

After all measurements have been cleared, when [Meas] is 
pressed again, the default measurements will be Frequency 
and Peak-Peak.

Measurements Summary

The automatic measurements provided by the oscilloscope are listed in the 
following table. All measurements are available for analog channel waveforms. All 
measurements except Counter are available for math waveforms other than FFT. A 
limited set of measurements is available for math FFT waveforms (as described in 
the following table).
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Measurement Valid for Math FFT* Notes

"Snapshot All" on page 159

"Amplitude" on page 161

"Average" on page 164 Yes, Full Screen

"Base" on page 162

"Bit Rate" on page 169

"Counter" on page 169 Not valid for math waveforms.

"Delay" on page 170 Measures between two sources. Press 
Settings to specify the second source.

"Duty Cycle" on page 170

"Fall Time" on page 170

"Frequency" on page 168

"Maximum" on page 160 Yes

"Minimum" on page 161 Yes

"Rising Edge Count" on 
page 175

"Falling Edges Count" on 
page 175

"Positive Pulse Count" on 
page 174

"Negative Pulse Count" on 
page 174

"Overshoot" on page 162

"Peak-Peak" on page 160 Yes

"Period" on page 167

"Phase" on page 171 Measures between two sources. Press 
Settings to specify the second source.

"Preshoot" on page 163

"Rise Time" on page 170
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Snapshot All

The Snapshot All measurement type displays a popup containing a snapshot of all 
the single waveform measurements.

You can also configure the [Quick Action] key to display the Snapshot All popup. 
See "Configuring the [Quick Action] Key" on page 248.

"DC RMS" on page 164

"AC RMS" on page 165

"Top" on page 161

"+ Width" on page 169

"– Width" on page 169

"X at Max Y" on page 173 Yes The resultant units are in Hertz.

"X at Min Y" on page 173 Yes The resultant units are in Hertz.

* Use the cursors to make other measurements on FFT.

Measurement Valid for Math FFT* Notes
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Voltage Measurements

The following figure shows the voltage measurement points.

Measurement units for each input channel can be set to Volts or Amps using the 
channel Probe Units softkey. See "To specify the channel units" on page 52.

The units of math waveforms are described in "Units for Math Waveforms" on 
page 67.

• "Peak-Peak" on page 160

• "Maximum" on page 160

• "Minimum" on page 161

• "Amplitude" on page 161

• "Top" on page 161

• "Base" on page 162

• "Overshoot" on page 162

• "Preshoot" on page 163

• "Average" on page 164

• "DC RMS" on page 164

• "AC RMS" on page 165

Peak-Peak

The peak-to-peak value is the difference between Maximum and Minimum values. 
The Y cursors show the values being measured.

Maximum

Maximum is the highest value in the waveform display. The Y cursor shows the 
value being measured.

Amplitude

Maximum

Minimum
Base

Top

Peak-Peak
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Minimum

Minimum is the lowest value in the waveform display. The Y cursor shows the 
value being measured.

Amplitude

The Amplitude of a waveform is the difference between its Top and Base values. 
The Y cursors show the values being measured.

Top

The Top of a waveform is the mode (most common value) of the upper part of the 
waveform, or if the mode is not well defined, the top is the same as Maximum. The 
Y cursor shows the value being measured.

See Also • "To isolate a pulse for Top measurement" on page 161

To isolate a pulse for Top measurement

The following figure shows how to use Zoom mode to isolate a pulse for a Top 
measurement.

You may need to change the measurement window setting so that the 
measurement is made in the lower, Zoom window. See "Measurement Window 
with Zoom Display" on page 177.
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The Base of a waveform is the mode (most common value) of the lower part of the 
waveform, or if the mode is not well defined, the base is the same as Minimum. 
The Y cursor shows the value being measured.

Overshoot

Overshoot is distortion that follows a major edge transition expressed as a 
percentage of Amplitude. The X cursors show which edge is being measured (edge 
closest to the trigger reference point).

Figure 33 Isolating area for Top measurement

Rising edge overshοot =
local Maximum − D Top

Amplitude
× 100

Falling edge overshοot = Base − D local Minimum
Amplitude

× 100
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Preshoot

Preshoot is distortion that precedes a major edge transition expressed as a 
percentage of Amplitude. The X cursors show which edge is being measured (edge 
closest to the trigger reference point).

Figure 34 Automatic Overshoot measurement

Overshoot
local Maximum

local Minimum

Base

Top

Overshoot

Rising edge preshοot =
local Maximum − D Top

Amplitude
× 100
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Average

Average is the sum of the levels of the waveform samples divided by the number 
of samples.

Where xi = value at ith point being measured, n = number of points in 
measurement interval.

The Full Screen measurement interval variation measures the value on all 
displayed data points.

The N Cycles measurement interval variation measures the value on an integral 
number of periods of the displayed signal. If less than three edges are present, the 
measurement shows "No edges".

The X cursors show what interval of the waveform is being measured.

DC RMS

DC RMS is the root-mean-square value of the waveform over one or more full 
periods.

Falling edge preshοot = Base − D local Minimum
Amplitude

× 100

Preshootlocal Maximum

local Minimum

Base

Top

Preshoot

Average =
∑ xi
n

RMS (dc) =
∑i=1

n
xi

2

n
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Where xi = value at ith point being measured, n = number of points in 
measurement interval.

The Full Screen measurement interval variation measures the value on all 
displayed data points.

The N Cycles measurement interval variation measures the value on an integral 
number of periods of the displayed signal. If less than three edges are present, the 
measurement shows "No edges".

The X cursors show the interval of the waveform being measured.

AC RMS

AC RMS is the root-mean-square value of the waveform, with the DC component 
removed. It is useful, for example, for measuring power supply noise.

The N Cycles measurement interval measures the value on an integral number of 
periods of the displayed signal. If less than three edges are present, the 
measurement shows "No edges".

The X cursors show the interval of the waveform being measured.

The Full Screen (Std Deviation) measurement interval variation is an RMS 
measurement across the full screen with the DC component removed. It shows the 
standard deviation of the displayed voltage values.

The standard deviation of a measurement is the amount that a measurement 
varies from the mean value. The Mean value of a measurement is the statistical 
average of the measurement.

The following figure graphically shows the mean and standard deviation. Standard 
deviation is represented by the Greek letter sigma: σ. For a Gaussian distribution, 
two sigma (± 1σ) from the mean, is where 68.3 percent of the measurement results 
reside. Six sigma (± 3σ) from is where 99.7 percent of the measurement results 
reside.
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The mean is calculated as follows:

where:

• x = the mean.

• N = the number of measurements taken.

• xi = the ith measurement result.

The standard deviation is calculated as follows:

where:

• σ = the standard deviation.

• N = the number of measurements taken.

• xi = the ith measurement result.

• x = the mean.

-2σ

mean

-1σ 1σ 2σ
68.3%

-3σ

95.4%
99.7%

0 3σ

x̄ =
∑i=1

N xi
N

σ =
∑i=1

N
(xi − x̄)

2

N
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Time Measurements

The following figure shows time measurement points.

The default lower, middle, and upper measurement thresholds are 10%, 50%, and 
90% between Top and Base values. See "Measurement Thresholds" on page 175 
for other percentage threshold and absolute value threshold settings.

• "Period" on page 167

• "Frequency" on page 168

• "Counter" on page 169

• "+ Width" on page 169

• "– Width" on page 169

• "Bit Rate" on page 169

• "Duty Cycle" on page 170

• "Rise Time" on page 170

• "Fall Time" on page 170

• "Delay" on page 170

• "Phase" on page 171

• "X at Min Y" on page 173

• "X at Max Y" on page 173

Period

Period is the time period of the complete waveform cycle. The time is measured 
between the middle threshold points of two consecutive, like-polarity edges. A 
middle threshold crossing must also travel through the lower and upper threshold 
levels which eliminates runt pulses. The X cursors show what portion of the 
waveform is being measured. The Y cursor shows the middle threshold point.

Rise Time

+ Width

Fall Time

- Width
Period

Middle
Upper

Thresholds

Lower
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Frequency

Frequency is defined as 1/Period. Period is defined as the time between the 
middle threshold crossings of two consecutive, like-polarity edges. A middle 
threshold crossing must also travel through the lower and upper threshold levels 
which eliminates runt pulses. The X cursors show what portion of the waveform is 
being measured. The Y cursor shows the middle threshold point.

See Also • "To isolate an event for frequency measurement" on page 168

To isolate an event for frequency measurement

The following figure shows how to use Zoom mode to isolate an event for a 
frequency measurement.

You may need to change the measurement window setting so that the 
measurement is made in the lower, Zoom window. See "Measurement Window 
with Zoom Display" on page 177.

If the waveform is clipped, it may not be possible to make the measurement.

Figure 35 Isolating an event for Frequency measurement
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Counter

The InfiniiVision 1200 X-Series oscilloscopes have an integrated hardware 
frequency counter which counts the number of cycles that occur within a period of 
time (known as the gate time) to measure the frequency of a signal.

The gate time for the Counter measurement is automatically adjusted to be 
100 ms or twice the current time window, whichever is longer, up to 1 second.

The Counter can measure frequencies up to the bandwidth of the oscilloscope. 
The minimum frequency supported is 1/(2 X gate time).

The hardware counter uses the trigger comparator output. Therefore, the counted 
channel's trigger level (or threshold for digital channels) must be set correctly. The 
Y cursor shows the threshold level used in the measurement.

Analog and Ext Trig channels can be selected as the source. On 4-channel 
oscilloscope models, you must set up an edge trigger on the EXT TRIG input 
before it can be selected as the counter source.

Only one Counter measurement can be displayed at a time.

+ Width

+ Width is the time from the middle threshold of the rising edge to the middle 
threshold of the next falling edge. The X cursors show the pulse being measured. 
The Y cursor shows the middle threshold point.

– Width

– Width is the time from the middle threshold of the falling edge to the middle 
threshold of the next rising edge. The X cursors show the pulse being measured. 
The Y cursor shows the middle threshold point.

Bit Rate

The bit rate measurement measures all positive and negative pulse widths on the 
waveform, takes the minimum value found of either width type and inverts that 
minimum width to give a value in Hertz.
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Duty Cycle

The duty cycle of a repetitive pulse train is the ratio of the positive pulse width to 
the period, expressed as a percentage. The X cursors show the time period being 
measured. The Y cursor shows the middle threshold point.

Rise Time

The rise time of a signal is the time difference between the crossing of the lower 
threshold and the crossing of the upper threshold for a positive-going edge. The X 
cursor shows the edge being measured. For maximum measurement accuracy, set 
the horizontal time/div as fast as possible while leaving the complete rising edge 
of the waveform on the display. The Y cursors show the lower and upper threshold 
points.

Fall Time

The fall time of a signal is the time difference between the crossing of the upper 
threshold and the crossing of the lower threshold for a negative-going edge. The X 
cursor shows the edge being measured. For maximum measurement accuracy, set 
the horizontal time/div as fast as possible while leaving the complete falling edge 
of the waveform on the display. The Y cursors show the lower and upper threshold 
points.

Delay

Delay measures the time difference from the selected edge on source 1 and the 
selected edge on source 2 closest to the timebase reference point at the middle 
threshold points on the waveforms. Negative delay values indicate that the 
selected edge of source 1 occurred after the selected edge of source 2.

1 Press the [Meas] key to display the Measurement menu.

+ Duty cycle = + Width
Period

× 100 − Duty cycle = − Width
Period

× 100

Source 2

Source 1

Delay
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2 Press the Source softkey; then turn the Entry knob to select the first analog 
channel source.

3 Press the Type: softkey; then, turn the Entry knob to select Delay.

4 Press the Settings softkey to select the second analog channel source and slope 
for the delay measurement.

The default Delay settings measure from the rising edge of channel 1 to the 
rising edge of channel 2.

5 Press the Back key to return to the Measurement menu.

6 Press the Add Measurement softkey to make the measurement.

The example below shows a delay measurement between the rising edge of 
channel 1 and the rising edge of channel 2.

Phase

Phase is the calculated phase shift from source 1 to source 2, expressed in 
degrees. Negative phase shift values indicate that the rising edge of source 1 
occurred after the rising edge of source 2.

Back
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1 Press the [Meas] key to display the Measurement menu.

2 Press the Source softkey; then turn the Entry knob to select the first analog 
channel source.

3 Press the Type: softkey; then, turn the Entry knob to select Delay.

4 Press the Settings softkey to select the second analog channel source for the 
phase measurement.

The default Phase settings measure from channel 1 to channel 2.

5 Press the Back key to return to the Measurement menu.

6 Press the Add Measurement softkey to make the measurement.

The example below shows a phase measurement between the channel 1 and the 
math d/dt function on channel 1.

Phase =
Delay

Source 1 Period
× 360

Source 2

Source 1
Delay

Period

Back
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X at Min Y

X at Min Y is the X axis value (usually time) at the first displayed occurrence of the 
waveform Minimum, starting from the left-side of the display. For periodic signals, 
the position of the minimum may vary throughout the waveform. The X cursor 
shows where the current X at Min Y value is being measured.

X at Max Y

X at Max Y is the X axis value (usually time) at the first displayed occurrence of the 
waveform Maximum, starting from the left-side of the display. For periodic signals, 
the position of the maximum may vary throughout the waveform. The X cursor 
shows where the current X at Max Y value is being measured.

See Also • "To measure the peak of an FFT" on page 173

To measure the peak of an FFT

1 Select FFT as the Operator in the Waveform Math Menu.

2 Choose Math: f(t) as the source in the Measurement Menu.

3 Choose Maximum and X at Max Y measurements.
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Maximum units are in dB and X at Max Y units are in Hertz for FFT.

Count Measurements

• "Positive Pulse Count" on page 174

• "Negative Pulse Count" on page 174

• "Rising Edge Count" on page 175

• "Falling Edges Count" on page 175

Positive Pulse Count

The Positive Pulse Count measurement is a pulse count for the selected waveform 
source.

This measurement is available for analog channels.

Negative Pulse Count

The Negative Pulse Count measurement is a pulse count for the selected waveform 
source.

Positive pulse count
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This measurement is available for analog channels.

Rising Edge Count

The Rising Edge Count measurement is an edge count for the selected waveform 
source.

This measurement is available for analog channels.

Falling Edges Count

The Falling Edges Count measurement is an edge count for the selected waveform 
source.

This measurement is available for analog channels.

Measurement Thresholds

Setting measurement thresholds defines the vertical levels where measurements 
will be taken on an analog channel or math waveform.

Negative pulse count

NOTE Changing default thresholds may change measurement results

The default lower, middle, and upper threshold values are 10%, 50%, and 90% of the value 
between Top and Base. Changing these threshold definitions from the default values may 
change the returned measurement results for Average, Delay, Duty Cycle, Fall Time, 
Frequency, Overshoot, Period, Phase, Preshoot, Rise Time, +Width, and -Width.
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1 From the Measurement menu, press the Settings softkey; then, press the 
Thresholds softkey to set analog channel measurement thresholds.

You can also open the Meas Threshold menu by pressing 
[Analyze] > Features and then selecting Measurement Thresholds.

2 Press the Source softkey to select the analog channel or math 
waveform source for which you want to change measurement 
thresholds.

Each analog channel and the math waveform can be 
assigned unique threshold values.

3 Press the Type softkey to set the measurement threshold to % 
(percentage of Top and Base value) or to Absolute (absolute 
value).

• Percentage thresholds can be set from 5% to 95%.

• The units for absolute threshold for each channel is set in 
the channel probe menu.

• When the Source is set to Math: f(t), the threshold Type can 
only be set to Percent.

4 Press the Lower softkey; then, turn the Entry knob to set the lower measurement 
threshold value.

Increasing the lower value beyond the set middle value will automatically 
increase the middle value to be more than the lower value. The default lower 
threshold is 10% (or 800 mV when absolute thresholds are selected).

If threshold Type is set to %, the lower threshold value can be set from 5% to 
93%.

TIP Absolute threshold hints

• Absolute thresholds are dependent on channel scaling, probe attenuation, and probe units. Always 
set these values first before setting absolute thresholds.

• The minimum and maximum threshold values are limited to on-screen values.

• If any of the absolute threshold values are above or below the minimum or maximum waveform 
values, the measurement may not be valid.
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5 Press the Middle softkey; then, turn the Entry knob to set the middle 
measurement threshold value.

The middle value is bounded by the values set for lower and upper thresholds. 
The default middle threshold is 50% (or 1.20 V when absolute thresholds are 
selected).

• If threshold Type is set to %, the middle threshold value can be set from 6% to 
94%.

6 Press the Upper softkey; then, turn the Entry knob to set the upper 
measurement threshold value.

Decreasing the upper value below the set middle value will automatically 
decrease the middle value to be less than the upper value. The default upper 
threshold is 90% (or 1.50 V when absolute thresholds are selected).

• If threshold Type is set to %, the upper threshold value can be set from 7% to 
95%.

Measurement Window with Zoom Display

When the zoomed time base is displayed, you can choose whether measurements 
are made in the Main window portion of the display or the Zoom window portion of 
the display.

1 Press the [Meas] key.

2 In the Measurement menu, press the Settings softkey.

3 In the Meas Settings menu, press the Meas Window softkey; then, turn the Entry 
knob to select from:

• Auto Select — The measurement is attempted in the lower, Zoom window; if it 
cannot be made there, the upper, Main window is used.

• Main — The measurement window is the upper, Main window.

• Zoom — The measurement window is the lower, Zoom window.
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Measurement Statistics

Press the [Meas] key to enter the Measurement Menu. By default, 
statistics are displayed, and frequency and voltage are measured 
on channel 1.

Select the measurements you desire for the channels you are using 
(see "Measurements Summary" on page 157).

From the Measurement Menu, press the Statistics softkey to enter 
the Statistics Menu.

The following statistics are shown: Name of the measurement, 
current measured value, mean, minimum measured value, 
maximum measured value, standard deviation, and the number of 
times the measurement has been made (count). Statistics are 
based on the total number of captured waveforms (count).

The standard deviation shown in Statistics is calculated using the 
same formula used for calculating the standard deviation 
measurement. The formula is shown in the section titled "AC 
RMS" on page 165.

The source channel of the measurement is shown in parenthesis after the 
measurement name. For example: "Freq(1)" indicates a frequency measurement on 
channel 1.
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You can switch the statistics Display On or Display Off. Statistics continue to 
accumulate even when the statistics display is off.

To reset the statistics measurements, press the Reset Statistics softkey. This resets 
all statistics and begins recording statistical data again.

Each time a new measurement (for example: frequency, period, or amplitude) is 
added the statistics are reset and accumulation of statistical data begins again.

When the [Single] key is pressed, statistics are reset and a single measurement is 
done (count = 1). Successive [Single] acquisitions accumulate statistical data (and 
the count is incremented).

Press the Transparent softkey to disable the Transparent mode. This shows 
statistics with a gray background. Press the Transparent softkey again to enable 
Transparent mode. This writes measurement values, statistics, and cursor values 
on the screen without a background. The Transparent setting affects measurement 
statistics, reference waveform information, and the optional Mask test feature's 
statistics display.

Relative σ — When enabled, the standard deviation shown in measurement 
statistics becomes a relative standard deviation, that is, standard deviation/mean.

Max Count — This softkey specifies the number of values used when calculating 
measurement statistics.
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The Increment Statistics softkey only appears when the acquisition is stopped and 
the optional segmented memory feature is off. Press the [Single] or [Run/Stop] key 
to stop the acquisition. You can use the horizontal position control (in the 
Horizontal control section of the front panel) to pan through the waveform. Active 
measurements will stay on screen, allowing you to measure various aspects of the 
captured waveforms. Press Increment Statistics to add the currently measured 
waveform to the collected statistical data.

The Analyze Segments softkey only appears when the acquisition is stopped and the 
optional segmented memory feature is on. After an acquisition has completed 
(and the oscilloscope is stopped), you can press the Analyze Segments softkey to 
accumulate measurement statistics for the acquired segments.

You can also turn on infinite persistence (in the Display Menu) and press the 
Analyze Segments softkey to create an infinite persistence display.
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16 Mask Testing
To create a mask from a "golden" waveform (Automask) / 181
Mask Test Setup Options / 184
Mask Statistics / 186
To manually modify a mask file / 187
Building a Mask File / 190

On DSOX1200-Series oscilloscopes, one way to verify a waveform's compliance to 
a particular set of parameters is to use mask testing. A mask defines a region of 
the oscilloscope's display in which the waveform must remain in order to comply 
with chosen parameters. Compliance to the mask is verified point-by-point across 
the display. Mask test operates on displayed analog channels; it does not operate 
on channels that are not displayed.

To create a mask from a "golden" waveform (Automask)

A golden waveform meets all chosen parameters, and it is the waveform to which 
all others will be compared.

1 Configure the oscilloscope to display the golden waveform.

2 Press the [Analyze] key.

3 Press Features; then, select Mask Test.

4 Press Features again to enable mask testing.
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5 Press Automask.

6 In the Automask menu, press the Source softkey and ensure 
the desired analog channel is selected.

7 Adjust the mask's horizontal tolerance (± Y) and vertical 
tolerance (± X). These are adjustable in graticule divisions or 
in absolute units (volts or seconds), selectable using the Units 
softkey.

8 Press the Create Mask softkey.

The mask is created and testing begins.

Whenever the Create Mask softkey is pressed the old mask is 
erased and a new mask is created.
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9 To clear the mask and switch off mask testing, press the Back key to return 
to the Analyze menu, then press the Clear Mask softkey.

If infinite persistence display mode (see "To set or clear persistence" on page 85) 
is "on" when mask test is enabled, it stays on. If infinite persistence is "off" when 
mask test is enabled, it is switched on when mask test is switched on, then infinite 
persistence is switched off when mask test is switched off.

Troubleshooting
Mask Setup

If you press Create Mask and the mask appears to cover the entire screen, check the 
± Y and ± X settings in the Automask menu. If these are set to zero the resulting 
mask will be extremely tight around the waveform.

If you press Create Mask and it appears that no mask was created, check the ± Y 
and ± X settings. They may be set so large that the mask is not visible.

Back
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Mask Test Setup Options

From the Mask Test menu, press the Setup softkey to enter the Mask Setup menu.

• Run Until — Lets you specify a condition on which to terminate 
testing.

• Forever — The oscilloscope runs continuously. However, if an 
error occurs the action specified using the On Error softkey 
will occur.

• Minimum # of Tests — Choose this option and then use the 
# of Tests softkey to select the number of times the 
oscilloscope will trigger, display the waveform(s), and 
compare them to the mask. The oscilloscope will stop after 
the specified number of tests have been completed. The 
specified minimum number of tests may be exceeded. If an 
error occurs the action specified using the On Error softkey 
will occur. The actual number of tests completed is 
displayed.

• Minimum Time — Choose this option and then use the Test Time 
softkey to select how long the oscilloscope will run. When 
the selected time has passed the oscilloscope will stop. The specified time 
may be exceeded. If an error occurs the action specified using the On Error 
softkey will occur. The actual test time is displayed.

• Minimum Sigma — Choose this option and then use the Sigma softkey to 
select a minimum sigma. The mask test runs until enough waveforms are 
tested to achieve a minimum test sigma. (If an error occurs the oscilloscope 
will perform the action specified by the On Error softkey.) Note that this is a 
test sigma (the max achievable process sigma, assuming no defects, for a 
certain number of tested waveforms) as opposed to a process sigma (which 
is tied to the amount of failures per test). The sigma value may exceed the 
selected value when a small sigma value is chosen. The actual sigma is 
displayed.

• On Error — Specifies the action(s) to take when the input waveform does not 
conform to the mask. This setting supersedes the Run Until setting.

• Stop — The oscilloscope will stop when the first error is detected (on the first 
waveform that does not conform to the mask). This setting supersedes the 
Minimum # of Tests and Minimum Time settings.
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• Save — The oscilloscope saves the screen image when an error is detected. In 
the Save menu (press [Save/Recall] > Save), select an image format (*.bmp or 
*.png), destination (on a USB storage device), and file name (which can be 
auto-incrementing). If errors occur too frequently and the oscilloscope 
spends all its time saving images, press the [Stop] key to stop acquisitions.

• Print — The oscilloscope prints the screen image when an error is detected. 
This option is only available when a printer is connected as described in "To 
print the oscilloscope's display" on page 229.

• Measure — Measurements (and measurement statistics if your oscilloscope 
supports them) run only on waveforms that contain a mask violation. 
Measurements are not affected by passing waveforms. This mode is not 
available when the acquisition mode is set to Averaging.

Note that you can choose to Print or Save, but you cannot select both at the 
same time. All other actions may be selected at the same time. For example, 
you can select both Stop and Measure to cause the oscilloscope to measure and 
stop on the first error..

On G-suffix oscilloscope models (that have a built-in waveform generator), you 
can output a signal on the front panel Gen Out connector when there is a mask 
test failure. See "Setting the Gen Out Source" on page 242.

• Source Lock — When you turn on Source Lock using the Source Lock softkey, the 
mask is redrawn to match the source whenever you move the waveform. For 
example, if you change the horizontal timebase or the vertical gain the mask is 
redrawn with the new settings.

When you turn off Source Lock, the mask is not redrawn when horizontal or 
vertical settings are changed.

• Source — If you change the Source channel, the mask is not erased. It is 
re-scaled to the vertical gain and offset settings of the channel to which it is 
assigned. To create a new mask for the selected source channel, go back up in 
the menu hierarchy; then, press Automask, and press Create Mask.

The Source softkey in the Mask Setup menu is the same as the Source softkey 
in the Automask menu.

• Test All — When enabled, all displayed analog channels are included in the 
mask test. When disabled, just the selected source channel is included in the 
test.
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Mask Statistics

From the Mask Test menu, press the Statistics softkey to enter the Mask Statistics 
menu.

• Show Stats — When you enable Show Statistics the following information is 
displayed:

• Current mask, name of mask, Channel number, date and time.

• # of Tests (total number of mask tests executed).

• Status (Passing, Failing, or Untested).

• Accumulated test time (in hours, minutes, seconds, and tenths of seconds).

And for each analog channel:

• Number of failures (acquisitions in which the signal excursion went beyond 
the mask).

• Failure rate (percentage of failures).

• Sigma (the ratio of process sigma to maximum achievable sigma, based on 
number of waveforms tested).

• Reset Statistics — Note that statistics are also reset when:
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• Mask Test is switched on after being switched off.

• Clear Mask softkey is pressed.

• An Automask is created.

Additionally, the accumulated time counter is reset whenever the oscilloscope 
is run after the acquisition was stopped.

• Transparent — Enable Transparent mode to write measurement values and 
statistics on the screen without a background. Disable the Transparent mode to 
show them with a gray background. The Transparent setting affects mask test 
statistics, measurement statistics, and reference waveform information display.

• Clear Display — Clears acquisition data from the oscilloscope display.

To manually modify a mask file

You can manually modify a mask file that you created using the Automask 
function.

1 Follow the steps 1-7 in "To create a mask from a "golden" waveform 
(Automask)" on page 181. Do not clear the mask after creating it.

2 Attach a USB mass storage device to the oscilloscope.

3 Press the [Save/Recall] key.

4 Press the Save softkey.

5 Press the Format softkey and select Mask.

6 Press the second softkey and select a destination folder on your USB mass 
storage device.

7 Press the Press to Save softkey. This creates an ASCII text file that describes the 
mask.

8 Remove the USB mass storage device and connect it to a PC.

9 Open the .msk file your created using a text editor (such as Wordpad).

10 Edit, save, and close the file.

The mask file contains the following sections:

• Mask File Identifier.

• Mask Title.

• Mask Violation Regions.
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• Oscilloscope Setup Information.

Mask File Identifier The Mask File Identifier is MASK_FILE_548XX.

Mask Title The Mask Title is a string of ASCII characters. Example: autoMask CH1 OCT 03 
09:40:26 2008

When a mask file contains the keyword "autoMask" in the title, the edge of the 
mask is passing by definition. Otherwise, the edge of the mask is defined as a 
failure.

Mask Violation
Regions

Up to 8 regions can be defined for a mask. They can be numbered 1-8. They can 
appear in any order in the .msk file. The numbering of the regions must go from 
top to bottom, left to right.

An Automask file contains two special regions: the region "glued" to the top of the 
display, and the region that is "glued" to the bottom. The top region is indicated by 
y-values of "MAX" for the first and last points. The bottom region is indicated by 
y-values of "MIN" for the first and last points.

The top region must be the lowest numbered region in the file. The bottom region 
must be the highest numbered region in the file.

Region number 1 is the top mask region. The vertices in Region 1 describe points 
along a line; that line is the bottom edge of the top portion of the mask.

Region 1

Region 2
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Similarly, the vertices in Region 2 describe the line that forms the top of the 
bottom part of the mask.

The vertices in a mask file are normalized. There are four parameters that define 
how values are normalized:

• X1

• ΔX

• Y1

• Y2

These four parameters are defined in the Oscilloscope Setup portion of the mask 
file.

The Y-values (normally voltage) are normalized in the file using the following 
equation:

Ynorm = (Y - Y1)/ΔY

where ΔY = Y2 - Y1

To convert the normalized Y-values in the mask file to voltage:

Y = (Ynorm * ΔY) + Y1

where ΔY = Y2 - Y1

The X-values (normally time) are normalized in the file using the following 
equation:

Xnorm = (X - X1)/ΔX

To convert the normalized X-values to time:

X = (Xnorm * ΔX) + X1

Oscilloscope
Setup Information

The keywords "setup" and "end_setup" (appearing alone on a line) define the 
beginning and end of the oscilloscope setup region of the mask file. The 
oscilloscope setup information contains remote programming language 
commands that the oscilloscope executes when the mask file is loaded.

Any legal remote programming command can be entered in this section.

The mask scaling controls how the normalized vectors are interpreted. This in turn 
controls how the mask is drawn on the display. The remote programming 
commands that control mask scaling are:
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:MTES:SCAL:BIND 0
:MTES:SCAL:X1 -400.000E-06
:MTES:SCAL:XDEL +800.000E-06
:MTES:SCAL:Y1 +359.000E-03
:MTES:SCAL:Y2 +2.35900E+00

Building a Mask File

The following mask uses all eight mask regions. The most difficult part of creating 
a mask file is normalizing the X and Y values from the time and voltage values. 
This example shows an easy way to convert voltage and time to normalized X and 
Y values in the mask file.

The following mask file produced the mask shown above:
MASK_FILE_548XX

"All Regions"

/* Region Number */ 1
/* Number of vertices */ 4

-12.50, MAX
-10.00, 1.750
10.00, 1.750
12.50, MAX

/* Region Number */ 2

1

8

2 3 4

5 6 7
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/* Number of vertices */ 5
-10.00, 1.000
-12.50, 0.500
-15.00, 0.500
-15.00, 1.500
-12.50, 1.500

/* Region Number */ 3
/* Number of vertices */ 6

-05.00, 1.000
-02.50, 0.500
02.50, 0.500
05.00, 1.000
02.50, 1.500

-02.50, 1.500

/* Region Number */ 4
/* Number of vertices */ 5

10.00, 1.000
12.50, 0.500
15.00, 0.500
15.00, 1.500
12.50, 1.500

/* Region Number */ 5
/* Number of vertices */ 5

-10.00, -1.000
-12.50, -0.500
-15.00, -0.500
-15.00, -1.500
-12.50, -1.500

/* Region Number */ 6
/* Number of vertices */ 6

-05.00, -1.000
-02.50, -0.500
02.50, -0.500
05.00, -1.000
02.50, -1.500

-02.50, -1.500

/* Region Number */ 7
/* Number of vertices */ 5

10.00, -1.000
12.50, -0.500
15.00, -0.500
15.00, -1.500
12.50, -1.500

/* Region Number */ 8
/* Number of vertices */ 4

-12.50, MIN
-10.00, -1.750
10.00, -1.750
12.50, MIN

setup
:MTES:ENAB 1
:CHAN1:RANG +4.00E+00;OFFS +0.0E+00;COUP DC;IMP ONEM;DISP 1;BWL 0;INV 0
:CHAN1:LAB "1";UNIT VOLT;PROB +1.0E+00;PROB:SKEW +0.0E+00;STYP SING
:CHAN2:RANG +16.0E+00;OFFS +1.62400E+00;COUP DC;IMP FIFT;DISP 0;BWL 0;INV
0
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:CHAN2:LAB "2";UNIT VOLT;PROB +1.0E+00;PROB:SKEW +0.0E+00;STYP SING
:CHAN3:RANG +40.0E+00;OFFS +0.0E+00;COUP DC;IMP ONEM;DISP 0;BWL 0;INV 0
:CHAN3:LAB "3";UNIT VOLT;PROB +1.0E+00;PROB:SKEW +0.0E+00;STYP SING
:CHAN4:RANG +40.0E+00;OFFS +0.0E+00;COUP DC;IMP ONEM;DISP 0;BWL 0;INV 0
:CHAN4:LAB "4";UNIT VOLT;PROB +1.0E+00;PROB:SKEW +0.0E+00;STYP SING
:EXT:BWL 0;IMP ONEM;RANG +5E+00;UNIT VOLT;PROB +1.0E+00;PROB:STYP SING
:TIM:MODE MAIN;REF CENT;MAIN:RANG +50.00E-09;POS +0.0E+00
:TRIG:MODE EDGE;SWE AUTO;NREJ 0;HFR 0;HOLD +60E-09
:TRIG:EDGE:SOUR CHAN1;LEV -75.00E-03;SLOP POS;REJ OFF;COUP DC
:ACQ:MODE RTIM;TYPE NORM;COMP 100;COUNT 8;SEGM:COUN 2
:DISP:LAB 0;CONN 1;PERS MIN;SOUR PMEM1
:HARD:APR "";AREA SCR;FACT 0;FFE 0;INKS 1;PAL NONE;LAY PORT
:SAVE:FIL "mask_0"
:SAVE:IMAG:AREA GRAT;FACT 0;FORM NONE;INKS 0;PAL COL
:SAVE:WAV:FORM NONE
:MTES:SOUR CHAN1;ENAB 1;LOCK 1
:MTES:AMAS:SOUR CHAN1;UNIT DIV;XDEL +3.00000000E-001;YDEL +2.00000000E-00
1
:MTES:SCAL:BIND 0;X1 +0.0E+00;XDEL +1.0000E-09;Y1 +0.0E+00;Y2 +1.00000E+0
0
:MTES:RMOD FOR;RMOD:TIME +1E+00;WAV 1000;SIGM +6.0E+00
:MTES:RMOD:FACT:STOP 0;PRIN 0;SAVE 0
end_setup

In a mask file, all region definitions need to be separated by a blank line.

Mask regions are defined by a number of (x,y) coordinate vertices (as on an 
ordinary x,y graph). A "y" value of "MAX" specifies the top of the graticule, and a 
"y" value of "MIN" specifies the bottom of the graticule.

The mask x,y graph is related to the oscilloscope graticule using the 
:MTESt:SCALe setup commands.

The oscilloscope's graticule has a time reference location (at the left, center, or 
right of the screen) and a trigger (t=0) position/delay value relative to the 
reference. The graticule also has a vertical ground 0 V reference (offset relative to 
the center of the screen) location.

The X1 and Y1 setup commands relate the mask region's x,y graph origin to the 
oscilloscope graticule's t=0 and V=0 reference locations, and the XDELta and Y2 
setup commands specify the size of the graph's x and y units.

• The X1 setup command specifies the time location of the x,y graph's x origin.

• The Y1 setup command specifies the vertical location of the x,y graph's y origin.

NOTE If there are more than 1000 vertices in a mask region, only the first 1000 vertices will be 
processed.
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• The XDELta setup command specifies the amount of time associated with each 
x unit.

• The Y2 setup command is the vertical location of the x,y graph's y=1 value (so 
in effect, Y2 – Y1 is the YDELta value).

For example:

• With a graticule whose trigger position is 10 ns (before a center screen 
reference) and whose ground reference (offset) is 2 V below the center of the 
screen, to place the mask region's x,y graph's origin at center screen, you would 
set X1 = 10 ns and Y1 = 2 V.

• If the XDELta parameter is set to 5 ns and Y2 is set to 4 V, a mask region whose 
vertices are (-1, 1), (1, 1), (1, -1), and (-1, -1) goes from 5 ns to 15 ns and from 
0 V to 4 V.

• If you move the mask region's x,y graph origin to the t=0 and V=0 location by 
setting X1 = 0 and Y1 = 0, the same vertices define a region that goes from 
-5 ns to 5 ns and from -2 V to 2 V.

How is mask testing done?

InfiniiVision oscilloscopes start mask testing by creating a database that is 200 x 
640 for the waveform viewing area. Each location in the array is designated as 
either a violation or a pass area. Each time a data point from a waveform occurs in 
a violation area a failure is logged. If Test All was selected, every active analog 
channel is tested against the mask database for each acquisition. Over 2 billion 
failures can be logged per-channel. The number of acquisitions tested is also 
logged and displayed as "# of Tests".

The mask file allows greater resolution than the 200 X 640 database. Some 
quantization of data occurs to reduce the mask file data for display on-screen.

NOTE Although a mask can have up to 8 regions, in any given vertical column, it is only possible to 
define 4 regions. When there are 4 regions in a vertical column, one region must be tied to the 
top (using the MAX y value) and one must be tied to the bottom (using the MIN y value).
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17 Digital Voltmeter

The Digital Voltmeter (DVM) analysis feature provides 3-digit voltage and 5-digit 
frequency measurements using any analog channel. DVM measurements are 
asynchronous from the oscilloscope's acquisition system and are always 
acquiring.

The DVM display is a seven-segment readout like you would see on a digital 
voltmeter. It shows the selected mode as well as the units. Units are selected 
using the Units softkey in the Channel Probe menu.

After pressing the [Analyze] key, the DVM display also appears in the graticule 
along with a scale and the frequency counter value. The DVM scale is determined 
by the channel's vertical scale and reference level. The scale's blue triangle pointer 
shows the most recent measurement. The white bar above that shows the 
measurement extrema over the last 3 seconds.
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The DVM makes accurate RMS measurements when the signal frequency is 
between 20 Hz and 100 kHz. When the signal frequency is outside this range, 
"<BW Limit?" or ">BW Limit?" appears in the DVM display to caution you about 
inaccurate RMS measurement results.

To use the digital voltmeter:

1 Press the [Analyze] key.

2 Press Features; then, select Digital Voltmeter.

3 Press Features again to enable the DVM measurements.

4 Press the Source softkey and turn the Entry knob to select the analog channel 
on which digital voltmeter (DVM) measurements are made.

The selected channel does not have to be on (displaying a waveform) in order 
for DVM measurements to be made.

5 Press the Mode softkey and turn the Entry knob to select the digital voltmeter 
(DVM) mode:

• DC — displays the DC value of the acquired data.

• DC RMS — displays the root-mean-square value of the acquired data.

• AC RMS — displays the root-mean-square value of the acquired data, with 
the DC component removed.
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• Frequency — displays the frequency counter measurement.

6 Press Transparent to toggle between a transparent and shaded background for 
the DVM display.

7 If the selected source channel is not used in oscilloscope triggering, press Auto 
Range to disable or enable automatic adjustment of the DVM channel's vertical 
scale, vertical (ground level) position, and trigger (threshold voltage) level (used 
for the counter frequency measurement).

When enabled, Auto Range overrides attempted adjustments of the channel's 
vertical scale and position knobs.

When disabled, you can use the channel's vertical scale and position knobs 
normally.
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18 Frequency Response 
Analysis
To make connections / 199
To set up and run the analysis / 200
To view and save the analysis results / 202

On G-suffix oscilloscope models (that have a built-in waveform generator), the 
Frequency Response Analysis (FRA) feature controls the built-in waveform 
generator to sweep a sine wave across a range of frequencies while measuring the 
input to and output from a device under test (DUT). At each frequency, gain (A) 
and phase are measured and plotted on a frequency response Bode chart.

When the frequency response analysis completes, you can move a marker across 
the chart to see the measured gain and phase values at each frequency point. You 
can also adjust the chart's scale and offset settings for the gain and phase plots.

To make connections

The waveform generator output is connected to a device under test (DUT). The 
input to the device and the output from the device are probed by the 
oscilloscope's input channels.
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 To set up and run the analysis

1 Press the [Analyze] key.

2 Press Features; then, select Frequency Response Analysis.

3 Press Features again to enable the feature.

DUT
(Transfer Function)

Input Output

Wave
Gen

1 2 3 4

Oscilloscope
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4 Press the Setup softkey.

In the FRA Setup menu, these softkeys are present for setting up the frequency 
response analysis:
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• Sources — opens a menu for specifying the oscilloscope channels probing the 
DUT's input and output.

• Start Freq, Stop Freq — specifies the start frequency and the stop frequency in 
the sweep.

To toggle between coarse, fine, and log scale decade adjustment, press this 
softkey again or push the Entry knob. The "~" character appears in the 

softkey label when fine adjustment is enabled, and the "10X" characters 
appear when decade adjustment is enabled.

Because the stop frequency value must be greater than the start value, 
increasing the start value can also cause the stop value to be increased. 
Likewise, decreasing the stop value can also cause the start value to be 
decreased.

• Amplitude — specifies the waveform generator amplitude.

• Output Load — specifies the waveform generator expected output load 
impedance.

The output impedance of the Gen Out signal is fixed at 50 ohms. However, 
the output load selection lets the waveform generator display the correct 
amplitude and offset levels for the expected output load. If the actual load 
impedance is different than the selected value, the displayed amplitude and 
offset levels will be incorrect.

• Points — sets the total number of points to use for the sweep.

The number of points may be limited depending on the specified frequency 
range.

5 Press the Back key to return the the Analyze menu.

6 Press the Run Analysis softkey.

To view and save the analysis results

After the frequency response analysis completes, the results are displayed in a 
Bode plot chart. You can press the Move Marker softkey and turn the Entry knob to 
move a marker across the chart to see the measured gain and phase values at 
each frequency point.

Back
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To adjust the chart's scale, offset, and frequency range for the gain and phase 
plots, press the Chart softkey. In the FRA Chart menu, these softkeys let you make 
adjustments:

• Select: — Press this softkey or turn the Entry knob to select the chart parameters 
to adjust:

• Gain — use the Gain Scale and Gain Offset softkeys to adjust the gain plot's 
vertical scale and offset.

• Phase — use the Phase Scale and Phase Offset softkeys to adjust the phase 
plot's vertical scale and offset.

• Frequency — use the Start Freq and Stop Freq softkeys to adjust the chart's 
starting and ending frequency values.

To toggle between coarse, fine, and log scale decade adjustment, press this 
softkey again or push the Entry knob. The "~" character appears in the 
softkey label when fine adjustment is enabled, and the "10X" characters 
appear when decade adjustment is enabled.

Because the chart's ending frequency value must be greater than the 
starting frequency value, increasing the starting value can also cause the 
ending value to be increased. Likewise, decreasing the ending value can also 
cause the starting value to be decreased.
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• Move Marker — lets you turn the Entry knob to move a marker across the chart to 
see the measured gain and phase values at each frequency point.

• Trace — lets you choose the plot(s) that are included in the chart. Press this 
softkey, then turn the Entry knob to select either gain or phase, then push the 
knob or press the softkey again to enable or disable the plot.

• Autoscale — automatically sets the scale and offset of the gain and phase plots 
based on the measured values.

You can save the analysis results by choosing [Save/Recall] > Save > Format and 
selecting the Frequency Response Analysis data (*.csv) option.
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19 Waveform Generator
To select generated waveform types and settings / 205
To specify the expected output load / 208
To use waveform generator logic presets / 209
To add noise to the waveform generator output / 209
To add modulation to the waveform generator output / 210
To restore waveform generator defaults / 215

On G-suffix oscilloscope models, a waveform generator is built into the 
oscilloscope. The waveform generator gives you an easy way to provide input 
signals when testing circuitry with the oscilloscope.

Waveform generator settings can be saved and recalled with oscilloscope setups. 
See Chapter 20, “Save/Recall (Setups, Screens, Data),” starting on page 217.

To select generated waveform types and settings

1 To access the Wave Gen menu and enable or disable the waveform generator 
output on the front panel Gen Out BNC, press the [Wave Gen] key.

When waveform generator output is enabled, the [Wave Gen] key is illuminated. 
When waveform generator output is disabled, the [Wave Gen] key is off.

The waveform generator output is always disabled when the instrument is first 
turned on.

The waveform generator output is automatically disabled if excessive voltage is 
applied to the Gen Out BNC.

2 In the Wave Gen menu, press the Waveform softkey and turn the Entry knob to 
select the waveform type.
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3 Depending on the selected waveform type, use the remaining softkeys and the 
Entry knob to set the waveform's characteristics.



Waveform Generator 19

Keysight InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes User's Guide 207

 
For all waveform types, the output amplitude, into 50 Ω, can be adjusted from 
10 mVpp to 2.5 Vpp (or from 20 mVpp to 5 Vpp into an open-circuit load).

Waveform 
Type

Characteristics

Sine Use the Frequency/Frequency Fine/Period/Period Fine, Amplitude/High-Level, and 
Offset/Low-Level softkeys to set the sine signal parameters.

The frequency can be adjusted from 100 mHz to 20 MHz.

Square Use the Frequency/Frequency Fine/Period/Period Fine, Amplitude/High-Level, 
Offset/Low-Level, and Duty Cycle softkeys to set the square wave signal 
parameters.

The frequency can be adjusted from 100 mHz to 10 MHz.

The duty cycle can be adjusted from 1% to 99% up to 500 kHz. At higher 
frequencies, the adjustment range narrows to not allow pulse widths less than 
20 ns. For example:

• At 1 MHz, the duty cycle can be adjusted from 2% to 98%.

• At 5 MHz, the duty cycle can be adjusted from 10% to 90%.

• At 10 MHz, the duty cycle can be adjusted from 20% to 80%.

Ramp Use the Frequency/Frequency Fine/Period/Period Fine, Amplitude/High-Level, 
Offset/Low-Level, and Symmetry softkeys to set the ramp signal parameters.

The frequency can be adjusted from 100 mHz to 100 kHz.

Symmetry represents the amount of time per cycle that the ramp waveform is rising 
and can be adjusted from 0% to 100%.

Pulse Use the Frequency/Frequency Fine/Period/Period Fine, Amplitude/High-Level, 
Offset/Low-Level, and Width/Width Fine softkeys to set the pulse signal 
parameters.

The frequency can be adjusted from 100 mHz to 10 MHz.

The pulse width can be adjusted from 20 ns to the period minus 20 ns.

DC Use the Offset softkey to set the DC level.

Noise Use the Amplitude/High-Level and Offset/Low-Level to set the noise signal 
parameters.
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Pressing a signal parameter softkey can open a menu for selecting the type of 
adjustment. For example, you can choose to enter amplitude and offset values, 
or you can choose to enter high-level and low-level values. Or, you can choose 
to enter frequency values or period values. Keep pressing the softkey to select 
the type of adjustment. Turn the Entry knob to adjust the value.

Notice that you can select between coarse and fine adjustments for frequency, 
period, and width. Also, pushing the Entry knob is a quick way to toggle 
between coarse and fine adjustments.

The Settings softkey opens the Wave Gen Settings menu which lets you make 
other settings related to the waveform generator.

See:

• "To specify the expected output load" on page 208

• "To use waveform generator logic presets" on page 209

• "To restore waveform generator defaults" on page 215

To specify the expected output load

1 If the Wave Gen menu is not currently displayed on the oscilloscope's softkeys, 
press the [Wave Gen] key.

2 In the Wave Gen menu, press the Settings softkey.

3 In the Wave Gen Settings menu, press the Out Load softkey and turn the Entry 
knob to select:

• 50 Ω
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• High-Z

The output impedance of the Gen Out BNC is fixed at 50 ohms. However, the 
output load selection lets the waveform generator display the correct amplitude 
and offset levels for the expected output load.

If the actual load impedance is different than the selected value, the displayed 
amplitude and offset levels will be incorrect.

To use waveform generator logic presets

With logic level presets, you can easily set the output voltage to TTL, CMOS 
(5.0V), CMOS (3.3V), CMOS (2.5V), or ECL compatible Low and High levels.

1 If the Wave Gen menu is not currently displayed on the oscilloscope's softkeys, 
press the [Wave Gen] key.

2 In the Wave Gen menu, press the Settings softkey.

3 In the Wave Gen Settings menu, press the Logic Presets softkey.

4 In the Wave Gen Presets menu, press one of the softkeys to set the generated 
signal's Low and High voltages to logic compatible levels:

To add noise to the waveform generator output

1 If the Wave Gen menu is not currently displayed on the oscilloscope's softkeys, 
press the [Wave Gen] key.

Softkey (logic levels) Low level High level, 50 ohm 
expected output load

High level, high-Z 
expected output load

TTL 0 V +2.5 V (TTL compatible) +5 V

CMOS (5.0V) 0 V Not Available +5 V

CMOS (3.3V) 0 V +2.5 V (CMOS 
compatible)

+3.3 V

CMOS (2.5V) 0 V +2.5 V +2.5 V

ECL -1.7 V -0.8 V (ECL compatible) -0.9 V
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2 In the Wave Gen menu, press the Settings softkey.

3 In the Wave Gen Settings menu, press the Add Noise softkey and turn the Entry 
knob to select the amount of white noise to add to the waveform generator 
output.

Note that adding noise affects edge triggering on the waveform generator source 
(see "Edge Trigger" on page 99). This is because the trigger comparator is located 
after the noise source.

To add modulation to the waveform generator output

Modulation is where an original carrier signal is modified according to the 
amplitude of a second modulating signal. The modulation type (AM, FM, or FSK) 
specifies how the carrier signal is modified.

To enable and set up modulation for the waveform generator output:

1 If the Wave Gen menu is not currently displayed on the oscilloscope's softkeys, 
press the [Wave Gen] key.

2 In the Wave Gen menu, press the Settings softkey.

3 In the Wave Gen Settings menu, press the Modulation softkey.
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4 In the Wave Gen Mod menu:

• Press the Modulation softkey to enable or disable 
modulated waveform generator output.

You can enable modulation for all waveform generator 
function types except pulse, DC, and noise.

• Press the Type softkey and turn the Entry knob to select 
the modulation type:

• Amplitude Modulation (AM) — the amplitude of the 
original carrier signal is modified according to the 
amplitude of the modulating signal. See "To set up 
Amplitude Modulation (AM)" on page 211.

• Frequency Modulation (FM) — the frequency of the original 
carrier signal is modified according to the amplitude of 
the modulating signal. See "To set up Frequency 
Modulation (FM)" on page 212.

• Frequency-Shift Keying Modulation (FSK) — the output 
frequency "shifts" between the original carrier frequency and a "hop 
frequency" at the specified FSK rate. The FSK rate specifies a digital 
square wave modulating signal. See "To set up Frequency-Shift Keying 
Modulation (FSK)" on page 214.

To set up Amplitude Modulation (AM)

In the Wave Gen Mod menu (under [Wave Gen] > Settings > Modulation):

1 Press the Type softkey and turn the Entry knob to select Amplitude Modulation 
(AM).

2 Press the Waveform softkey and turn the Entry knob to select the shape of the 
modulating signal:

• Sine

• Square

• Ramp

When the Ramp shape is selected, a Symmetry softkey appears so that you can 
specify the amount of time per cycle that the ramp waveform is rising.

3 Press the AM Freq softkey and turn the Entry knob to specify the frequency of 
the modulating signal.
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4 Press the AM Depth softkey and turn the Entry knob to specify the amount of 
amplitude modulation.

AM Depth refers to the portion of the amplitude range that will be used by the 
modulation. For example, a depth setting of 80% causes the output amplitude 
to vary from 10% to 90% (90% – 10% = 80%) of the original amplitude as the 
modulating signal goes from its minimum to maximum amplitude.

The following screen shows an AM modulation of a 100 kHz sine wave carrier 
signal.

To set up Frequency Modulation (FM)

In the Wave Gen Mod menu (under [Wave Gen] > Settings > Modulation):

1 Press the Type softkey and turn the Entry knob to select Frequency Modulation 
(FM).

2 Press the Waveform softkey and turn the Entry knob to select the shape of the 
modulating signal:

• Sine

• Square

• Ramp
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When the Ramp shape is selected, a Symmetry softkey appears so that you can 
specify the amount of time per cycle that the ramp waveform is rising.

3 Press the FM Freq softkey and turn the Entry knob to specify the frequency of the 
modulating signal.

4 Press the FM Dev softkey and turn the Entry knob to specify the frequency 
deviation from the original carrier signal frequency.

When the modulating signal is at its maximum amplitude, the output frequency 
is the carrier signal frequency plus the deviation amount, and when the 
modulating signal is at its minimum amplitude, the output frequency is the 
carrier signal frequency minus the deviation amount.

The frequency deviation cannot be greater than the original carrier signal 
frequency.

Also, the sum of the original carrier signal frequency and the frequency 
deviation must be less than or equal to the maximum frequency for the selected 
waveform generator function plus 100 kHz.

The following screen shows an FM modulation of a 100 kHz sine wave carrier 
signal.
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To set up Frequency-Shift Keying Modulation (FSK)

In the Wave Gen Mod menu (under [Wave Gen] > Settings > Modulation):

1 Press the Type softkey and turn the Entry knob to select Frequency-Shift Keying 
Modulation (FSK).

2 Press the Hop Freq softkey and turn the Entry knob to specify the "hop 
frequency".

The output frequency "shifts" between the original carrier frequency and this 
"hop frequency".

3 Press the FSK Rate softkey and turn the Entry knob to specify the rate at which 
the output frequency "shifts".

The FSK rate specifies a digital square wave modulating signal.

The following screen shows an FSK modulation of a 100 kHz sine wave carrier 
signal.
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To restore waveform generator defaults

1 If the Wave Gen menu is not currently displayed on the oscilloscope's softkeys, 
press the [Wave Gen] key.

2 In the Wave Gen menu, press the Settings softkey.

3 In the Wave Gen Settings menu, press the Default Wave Gen softkey.

The waveform generator factory default settings (1 kHz sine wave, 500 mVpp, 
0 V offset, High-Z output load) are restored.
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20 Save/Recall (Setups, 
Screens, Data)
Saving Setups, Screen Images, or Data / 217
Recalling Setups, Masks, or Reference Waveforms / 224
Recalling Default Setups / 226
Performing a Secure Erase / 226

Oscilloscope setups, reference waveforms, and mask files can be saved to internal 
oscilloscope memory or to a USB storage device and recalled later. You can also 
recall default or factory default setups.

Oscilloscope screen images can be saved to a USB storage device in BMP or PNG 
formats.

Acquired waveform data can be saved to a USB storage device in 
comma-separated value (CSV), ASCII XY, and binary (BIN) formats.

There is also a command to securely erase all the oscilloscope's non-volatile 
internal memory.

Saving Setups, Screen Images, or Data

1 Press the [Save/Recall] key.

2 In the Save/Recall menu, press Save.

3 In the Save menu, press Format, then, turn the Entry knob to select the type of 
file you want to save:
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• Setup (*.scp) — The oscilloscope's horizontal timebase, vertical sensitivity, 
trigger mode, trigger level, measurements, cursors, and math function 
settings that tell the oscilloscope how to make a particular measurement. 
See "To save setup files" on page 219.

• 8-bit Bitmap image (*.bmp) — The complete screen image in a reduced color 
(8-bit) bitmap format. See "To save BMP or PNG image files" on page 219.

• 24-bit Bitmap image (*.bmp) — The complete screen image in a 24-bit color 
bitmap format. See "To save BMP or PNG image files" on page 219.

• PNG 24-bit image (*.png) — The complete screen image in a 24-bit color PNG 
format that uses lossless compression. Files are much smaller than the BMP 
format. See "To save BMP or PNG image files" on page 219.

• CSV data (*.csv) — This creates a file of comma-separated values of all 
displayed channels and math waveforms. This format is suitable for 
spreadsheet analysis. See "To save CSV, ASCII XY, or BIN data files" on 
page 220.

• ASCII XY data (*.csv) — This creates separate files of comma-separated values 
for each displayed channel. This format is also suitable for spreadsheets. See 
"To save CSV, ASCII XY, or BIN data files" on page 220.

• Reference Waveform data (*.h5) — Saves waveform data in a format that can be 
recalled to one of the oscilloscope's reference waveform locations. See "To 
save reference waveform files to a USB storage device" on page 222.

• Multi Channel Waveform data (*.h5) — Saves multiple channels of waveform 
data in a format that can be opened by the N8900A Infiniium Offline 
oscilloscope analysis software. You can recall the first Analog or Math 
channel from a multi channel waveform data file.

• Binary data (*.bin) — This creates a binary file, with a header, and data in the 
form of time and voltage pairs. This file is much smaller than the ASCII XY 
data file. See "To save CSV, ASCII XY, or BIN data files" on page 220.

• Lister data (*.csv) — This is a CSV format file containing serial decode row 
information with commas separating the columns. See "To save Lister data 
files" on page 222.

• Mask (*.msk) — This creates a mask file in a Keysight proprietary format that 
can be read by Keysight InfiniiVision oscilloscopes. A mask data file includes 
some oscilloscope setup information, but not all setup information. To save 
all setup information including the mask data file, choose "Setup (*.scp)" 
format instead. See "To save masks" on page 223.
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• Frequency Response Analysis data (*.csv) — This creates a file of 
comma-separated values for the Frequency Response Analysis results table 
values. In the saved file, there are three data columns: frequency (Hz), gain 
(dB), and phase (degrees). See "To view and save the analysis results" on 
page 202.

You can also configure the [Quick Action] key to save setups, screen images, or 
data. See "Configuring the [Quick Action] Key" on page 248.

To save setup files

Setup files can be saved to one of 10 internal (/User Files) locations or to an 
external USB storage device.

1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select Setup 
(*.scp).

2 Press the softkey in the second position and use the Entry knob to navigate to 
the save location. See "To navigate storage locations" on page 223.

3 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

Setup files have the extension SCP. These extensions appear when using the File 
Explorer (see "File Explorer" on page 236), but they do not appear when using the 
Recall menu.

To save BMP or PNG image files

Image files can be saved to an external USB storage device.

1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select 8-bit 
Bitmap image (*.bmp), 24-bit Bitmap image (*.bmp), or PNG 24-bit image (*.png).

2 Press the softkey in the second position and use the Entry knob to navigate to 
the save location. See "To navigate storage locations" on page 223.

3 Press the Settings softkey.

In the File Settings menu, you have these softkeys and options:

• Setup Info — setup information (vertical, horizontal, trigger, acquisition, math, 
and display settings) is also saved in a separate file with a TXT extension.

• Invert Grat — the graticule in the image file has a white background instead of 
the black backgound that appears on-screen.

• Palette — lets you choose between Color or Grayscale images.
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4 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

See Also • "To add an annotation" on page 87

To save CSV, ASCII XY, or BIN data files

Data files can be saved to an external USB storage device.

1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select CSV data 
(*.csv), ASCII XY data (*.csv), or  Binary data (*.bin).

2 Press the softkey in the second position and use the Entry knob to navigate to 
the save location. See "To navigate storage locations" on page 223.

3 Press the Settings softkey.

In the File Settings menu, you have these softkeys and options:

• Setup Info — when enabled, setup information (vertical, horizontal, trigger, 
acquisition, math, and display settings) is also saved in a separate file with a 
TXT extension.

• Length — sets the number of data points that will be output to the file. For 
more information, see "Length Control" on page 221.

• Save Seg — when data is acquired to segmented memory, you can specify 
whether the currently displayed segment is saved or all acquired segments 
are saved. (See also "Saving Data from Segmented Memory" on page 143.)

4 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

NOTE When saving screen images, the oscilloscope uses the last menu visited before pressing the 
[Save/Recall] key. This lets you save any relevant information within the softkey menu area.

To save a screen image showing the Save/Recall menu at the bottom, press the [Save/Recall] 
key twice before saving the image.

NOTE You can also save the oscilloscope's display image using a web browser. See "Get 
Image" on page 256 for details.
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See Also • "Binary Data (.bin) Format" on page 266

• "CSV and ASCII XY files" on page 273

• "Minimum and Maximum Values in CSV Files" on page 274

Length Control

The Length control is available when saving data to CSV, ASCII XY, or BIN format 
files. It sets the number of data points that will be output to the file. Only displayed 
data points are saved.

The maximum number of data points depends on these things:

• Whether acquisitions are running. When stopped, data comes from the raw 
acquisition record. When running, data comes from the smaller measurement 
record.

• Whether the oscilloscope was stopped using [Stop] or [Single]. Running 
acquisitions split memory to provide fast waveform update rates. Single 
acquisitions use full memory.

• Whether only one channel of a pair is turned on. (Channels 1 and 2 are one pair, 
channels 3 and 4 are the other.) Acquisition memory is divided among the 
channels in a pair.

• On 2-channel oscilloscope models, whether the external trigger input channel 
is on. The displayed external channel consumes acquisition memory.

• Whether reference waveforms are on. Displayed reference waveforms consume 
acquisition memory.

• Whether segmented memory (available on DSOX1200-Series models) is on. 
Acquisition memory is divided by the number of segments.

• The horizontal time/div (sweep speed) setting. At faster settings, fewer data 
points appear on the display.

• When saving to a CSV format file, the maximum number of data points is 
50,000.

When necessary, the Length control performs a "1 of n" decimation of the data . 
For example: if the Length is set to 1000, and you are displaying a record that is 
5000 data points in length, four of each five data points will be decimated, 
creating an output file 1000 data points in length.

When saving waveform data, the save times depend on the chosen format:
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See Also • "Binary Data (.bin) Format" on page 266

• "CSV and ASCII XY files" on page 273

• "Minimum and Maximum Values in CSV Files" on page 274

To save Lister data files

Lister data files can be saved to an external USB storage device.

1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select Lister data 
(*.csv).

2 Press the softkey in the second position and use the Entry knob to navigate to 
the save location. See "To navigate storage locations" on page 223.

3 Press the Settings softkey.

In the File Settings Menu, you have these softkeys and options:

• Setup Info — when enabled, setup information (vertical, horizontal, trigger, 
acquisition, math, and display settings) is also saved in a separate file with a 
TXT extension.

4 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

To save reference waveform files to a USB storage device

1 Press the [Save/Recall] key.

2 In the Save/Recall menu, press the Save softkey.

3 In the Save menu, press the Format softkey and turn the Entry knob to select 
Reference Waveform data (*.h5) .

4 Press the Source softkey and turn the Entry knob to select the source waveform.

5 Press the softkey in the second position and use the Entry knob to navigate to 
the save location. See "To navigate storage locations" on page 223.

Data File Format Save Times

BIN fastest

ASCII XY medium

CSV slowest
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6 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

To save masks

Mask files can be saved to one of four internal (/User Files) locations or to an 
external USB storage device.

1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select Mask 
(*.msk).

2 Press the softkey in the second position and use the Entry knob to navigate to 
the save location. See "To navigate storage locations" on page 223.

3 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

Mask files have the extension MSK.

See Also • Chapter 16, “Mask Testing,” starting on page 181

To navigate storage locations

When saving or recalling files, the softkey in the second position of the Save menu 
or Recall menu, along with the Entry knob, are used to navigate to storage 
locations. The storage locations can be internal oscilloscope storage locations (for 
setup files or mask files) or they can be external storage locations on a connected 
USB storage device.

The softkey in the second position can have these labels:

• Press to go — when you can push the Entry knob to navigate to a new folder or 
storage location.

• Location — when you have navigated to the current folder location (and are not 
saving files).

• Save to — when you can save to the selected location.

• Load from — when you can recall from the selected file.

NOTE Masks are also saved as part of setup files. See "To save setup files" on page 219.
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When saving files:

• The proposed file name is shown in the Save to file = line.

• To overwrite an existing file, browse to that file and select it. To create a new file 
name, see "To enter file names" on page 224.

To enter file names

To create new file names when saving files to a USB storage device:

1 In the Save menu, press the File Name softkey.

You must have a USB storage device connected to the oscilloscope for this 
softkey to be active.

2 In the File Name menu, use the Spell, Enter, and Delete Character softkeys to 
enter the file name:

• Spell — press this softkey and turn the Entry knob to select the character at 
the current position.

• Enter — press this softkey to enter characters and move the cursor to the next 
character position. Pushing the Entry knob is the same as pressing the Enter 
softkey.

• Delete Character — press this softkey to delete the character at the current 
position.

When available, the Increment softkey can be used to enable or disable 
automatically incremented file names. Auto increment adds a numeric suffix to 
your file name and increments the number with each successive save. It will 
truncate characters as necessary when the file name length is at maximum and 
more digits are required for the numeric portion of the file name.

Recalling Setups, Masks, or Reference Waveforms

1 Press the [Save/Recall] key.

2 In the Save/Recall menu, press Recall.

NOTE You can use a connected USB keyboard instead of using the Spell (and other) character 
editing softkeys.
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3 In the Recall menu, press Recall:, then, turn the Entry knob to select the type of 
file you want to recall:

• Setup (*.scp) — See "To recall setup files" on page 225.

• Mask (*.msk) — See "To recall mask files" on page 225.

• Reference Waveform data (*.h5) — See "To recall reference waveform files from 
a USB storage device" on page 226.

You can also recall setups and mask files by loading them using the File Explorer. 
See "File Explorer" on page 236.

You can also configure the [Quick Action] key to recall setups, masks, or reference 
waveforms. See "Configuring the [Quick Action] Key" on page 248.

To recall setup files

Setup files can be recalled from one of 10 internal (/User Files) locations or from 
an external USB storage device.

1 Press [Save/Recall] > Recall > Recall:; then, turn the Entry knob to select Setup 
(*.scp).

2 Press the softkey in the second position and use the Entry knob to navigate to 
the file to recall. See "To navigate storage locations" on page 223.

3 Press the Press to Recall softkey.

A message indicating whether the recall was successful is displayed.

4 If you would like to clear the display, press Clear Display.

To recall mask files

Mask files can be recalled from one of four internal (/User Files) locations or from 
an external USB storage device.

1 Press [Save/Recall] > Recall > Recall:; then, turn the Entry knob to select Mask 
(*.msk).

2 Press the softkey in the second position and use the Entry knob to navigate to 
the file to recall. See "To navigate storage locations" on page 223.

3 Press the Press to Recall softkey.

A message indicating whether the recall was successful is displayed.

4 If you would like to clear the display or clear the recalled mask, press Clear 
Display or Clear Mask.
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To recall reference waveform files from a USB storage device

1 Press the [Save/Recall] key.

2 In the Save/Recall menu, press the Recall softkey.

3 In the Recall menu, press the Recall softkey and turn the Entry knob to select 
Reference Waveform data (*.h5) .

4 Press the To Ref: softkey and turn the Entry knob to select the desired reference 
waveform location.

5 Press the softkey in the second position and use the Entry knob to navigate to 
the file to recall. See "To navigate storage locations" on page 223.

6 Press the Press to Recall softkey.

A message indicating whether the recall was successful is displayed.

7 If you would like to clear the display of everything except the reference 
waveform, press Clear Display.

Recalling Default Setups

1 Press the [Save/Recall] key.

2 In the Save/Recall menu, press Default/Erase.

3 In the Default menu, press one of these softkeys:

• Default Setup— recalls the oscilloscope's default setup. This is the same as 
pressing the front panel [Default Setup] key. See "Recall the Default 
Oscilloscope Setup" on page 24.

Some user settings are not changed when recalling the default setup.

• Factory Default— recalls the oscilloscope's factory default settings.

You must confirm the recall because there are no user settings that are left 
unchanged.

Performing a Secure Erase

1 Press the [Save/Recall] key.

2 In the Save/Recall menu, press Default/Erase.
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3 In the Default menu, press Secure Erase.

This performs a secure erase of all non-volatile memory in compliance with 
National Industrial Security Program Operation Manual (NISPOM) Chapter 8 
requirements.

You must confirm the secure erase, and the oscilloscope will reboot when 
finished.
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21 Print (Screens)
To print the oscilloscope's display / 229
To set up network printer connections / 231
To specify the print options / 232
To specify the palette option / 232

You can print the complete display, including the status line and softkeys, to a 
USB printer or a network printer when the oscilloscope is set up on a network.

To print the oscilloscope's display

1 Connect a printer. You can:

• Connect a USB printer to the rectangular USB host port on the front panel.

For the most up-to-date information on printers that are compatible with the 
InfiniiVision oscilloscopes, please visit 
www.keysight.com/find/InfiniiVision-printers.

• Set up a network printer connection. See "To set up network printer 
connections" on page 231.

2 To open the Print Config menu:

• Press [Save/Recall] > Print.

• Select the Quick Print quick action ([Utility] > Quick Action > Action, Quick Print); 
then, press Settings.

Some softkeys in the Print Config menu are ghosted (not available) until a 
printer is connected.

3 In the Print Config menu, press the Print to softkey; then, turn the Entry knob to 
select the desired printer.

http://www.keysight.com/find/InfiniiVision-printers
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4 Press the Options softkey to select the print options.

See "To specify the print options" on page 232.

5 Press the Palette softkey to select the print palette. See "To specify the palette 
option" on page 232.

6 Press the Press to Print softkey.

You can stop printing by pressing the Cancel Print softkey.

You can also configure the [Quick Action] key to print the display. See "Configuring 
the [Quick Action] Key" on page 248.

See Also • "To add an annotation" on page 87

NOTE The oscilloscope will print the last menu visited before you opened the Print Config menu. 
Therefore, if you have measurements (Amplitude, Frequency, etc.) showing on the display 
before you open the Print Config menu, the measurements will be shown on the printout.

To print the display showing the Print Config menu at the bottom, open the Print Config menu 
twice; then, press the Press to Print softkey.
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To set up network printer connections

You can set up network printer connections. A network printer is a printer 
attached to the network or a print server on the network.

1 Press [Save/Recall] > Print.

2 In the Print Config menu, press the Print to softkey; then, turn the Entry knob to 
select the network printer you want to configure (either #0 or #1).

3 Press the Network Setup softkey.

4 In the Network Printer Setup menu, press the Modify softkey; then, turn the 
Entry knob to select the network parameter you want to enter.

The setting that must be entered is:

• Printer Address — this is the printer or print server's address in one of the 
following formats:

• IP address of a network-enabled printer (for example: 192.168.1.100 or 
192.168.1.100:650). Optionally, a non-standard port number can be 
specified following a colon.

• IP address of a print server followed by the path to the printer (for 
example: 192.168.1.100/printers/printer-name or 
192.168.1.100:650/printers/printer-name).

5 Use the Spell, Enter, and Delete Character softkeys to enter the network printer 
settings:

• Spell — press this softkey and turn the entry knob to select the character at 
the current position.

• Enter — press this softkey to enter characters and move the cursor to the next 
character position.

• Delete Character — press the Enter softkey until the desired character is 
highlighted; then, press this softkey to delete the character.

6 Press the Apply softkey to make the printer connection.

A message appears to tell you whether the connection was successful.

NOTE You can use a connected USB keyboard instead of using the Spell (and other) character 
editing softkeys.
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To specify the print options

In the Print Config menu, press the Options softkey to change the following 
options:

• Setup Information — Select this to print oscilloscope setup information on your 
printout, including vertical, horizontal, trigger, acquisition, math, and display 
settings.

• Invert Graticule Colors — Select this to reduce the amount of black ink it takes to 
print oscilloscope images by changing the black background to white. Invert 
Graticule Colors is the default mode.

• Form Feed — Select this to send a form feed command to the printer after the 
waveform is printed and before the setup information is printed. Switch Form 
Feed off if you want setup information printed on the same sheet of paper with 
the waveform. This option only has an effect when the Setup Information option is 
selected. Also, if the amount of setup information will not fit on the same page 
with the waveform, it will be printed on a new page regardless of the Form Feed 
setting.

• Landscape — Select this to print horizontally on the page instead of vertically 
(portrait mode).

To specify the palette option

In the Print Config menu, press the Palette softkey to change the following options.

• Color — Select this to print the screen in color.

The oscilloscope's print driver cannot print color images to color laser printers, 
so the Color option is not available when connected to laser printers.

• Grayscale — Select this to print the screen in shades of gray rather than in color.
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22 Utility Settings
I/O Interface Settings / 233
Setting up the Oscilloscope's LAN Connection / 234
File Explorer / 236
Setting Oscilloscope Preferences / 238
Setting the Oscilloscope's Clock / 242
Setting the Gen Out Source / 242
Enabling Remote Command Logging / 243
Performing Service Tasks / 245
Configuring the [Quick Action] Key / 248

This chapter explains oscilloscope utility functions.

I/O Interface Settings

The oscilloscope can be accessed and/or controlled remotely via these I/O 
interfaces:

• USB device port on the rear panel (square shaped USB port).

Connect the USB device port to a computer only when the oscilloscope is 
turned off or when the oscilloscope is fully booted up and running. If you make 
this connection while the oscilloscope is booting up, you will likely get a "USB 
device not recognized" error.

• LAN interface on the rear panel.

To configure the I/O interfaces:

1 On the oscilloscope's front panel, press [Utility].
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2 In the Utility menu, press I/O.

3 In the I/O menu, press Configure.

• LAN — When connected to a LAN, you can use the LAN Settings and LAN Reset 
softkeys to configure the LAN interface. See "Setting up the Oscilloscope's 
LAN Connection" on page 234.

• USB — You can enable Compatibility Mode if you are experiencing connectivity 
issues when using the oscilloscope as a USB device. This mode provides 
maximum compatibility with USB host controllers at the cost of I/O 
performance.

When an I/O interface is present, remote control over that interface is always 
enabled. Also, the oscilloscope can be controlled via multiple I/O interfaces (for 
example, USB and LAN) at the same time.

See Also • Chapter 23, “Web Interface,” starting on page 251 (when the oscilloscope is 
connected to a LAN).

• The oscilloscope's Programmer's Guide.

Setting up the Oscilloscope's LAN Connection

You can place the oscilloscope on the network and set up its LAN connection. 
Once that is done, you can use the oscilloscope's web interface or remotely 
control the oscilloscope via the LAN interface.

The oscilloscope supports methods for automated LAN configuration or manual 
LAN configuration (see "To establish a LAN connection" on page 235). It is also 
possible to set up a point-to-point LAN connection between a PC and the 
oscilloscope (see "Stand-alone (Point-to-Point) Connection to a PC" on 
page 236).

Once the oscilloscope is set up on the network, you can use the oscilloscope's 
web page to view or change its network configuration and access additional 
settings (like the network password). See Chapter 23, “Web Interface,” starting on 
page 251.

NOTE Any time you modify the oscilloscope's hostname, it breaks the connection between the 
oscilloscope and the LAN. You need to re-establish communication to the oscilloscope using 
the new hostname.
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To establish a LAN connection

Automatic
Configuration

1 Press [Utility] > I/O.

2 Press the LAN Settings softkey.

3 Press the Config softkey; then, turn the Entry knob to select Automatic, and press 
the softkey again to enable it.

If your network supports DHCP or AutoIP, enabling Automatic lets the 
oscilloscope use those services to get its LAN configuration settings

4 You can enable the Multicast DNS option to let the oscilloscope use Multicast 
DNS for name resolution on small networks without a conventional DNS server.

5 Connect the oscilloscope to the local area network (LAN) by inserting the LAN 
cable into the "LAN" port on the rear panel of the oscilloscope.

In a few moments the oscilloscope will connect to the network automatically.

If the oscilloscope does not automatically connect to the network, press [Utility] 
> I/O > LAN Reset. In a few moments the oscilloscope will connect to the 
network.

Manual
Configuration

1 Get the oscilloscope's network parameters (host name, IP address, subnet 
mask, gateway IP, DNS IP, etc.) from your network administrator.

2 Press [Utility] > I/O.

3 Press the LAN Settings softkey.

4 Press the Config softkey; then, turn the Entry knob to select Automatic, and press 
the softkey again to disable it.

If Automatic is not enabled, the oscilloscope's LAN configuration must be set 
up manually using the Addresses and Host name softkeys

5 Configure the oscilloscope's LAN interface:

a Press the Addresses softkey.

b Use the Modify softkey (and the other softkeys and the Entry knob) to enter 
the IP Address, Subnet Mask, Gateway IP, and DNS IP values. When you are 
done, go back up in the menu hierarchy.

c Press the Host name softkey. Use the softkeys and the Entry knob to enter the 
Host name. When you are done, go back up in the menu hierarchy.

d Press the Apply softkey.

6 Connect the oscilloscope to the local area network (LAN) by inserting the LAN 
cable into the "LAN" port on the rear panel of the oscilloscope.
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Stand-alone (Point-to-Point) Connection to a PC

The following procedure describes how to establish a point-to-point (stand alone) 
connection to the oscilloscope. This is useful if you want to control the 
oscilloscope using a laptop computer or a stand-alone computer.

1 Press [Utility] > I/O.

2 Press the LAN Settings softkey.

3 Press the Config softkey; then, turn the Entry knob to select Automatic, and press 
the softkey again to enable it.

If your network supports DHCP or AutoIP, enabling Automatic lets the 
oscilloscope use those services to get its LAN configuration settings

4 Connect your PC to the oscilloscope using a cross-over LAN cable such as 
Keysight part number 5061-0701, available on the web at 
www.keysight.com/find/parts.

5 Cycle power on the oscilloscope. Wait until the LAN connection is configured:

• Press [Utility] > I/O and wait until the LAN status shows "configured".

This may take a few minutes.

Now, the instrument is connected, and the instrument's web interface or remote 
control via LAN may be used.

File Explorer

The File Explorer lets you navigate the oscilloscope's internal file system and the 
file systems of connected USB storage devices.

From the internal file system, you can load oscilloscope setup files or mask files.

From a connected USB storage device, you can load setup files, mask files, license 
files, firmware update (*.cab) files, label files, etc. Also, you can delete files on a 
connected USB storage device.

NOTE The rectangular USB port on the front panel is a USB Series A receptacle to which you can 
connect USB mass storage devices and printers.

The square receptacle on the rear panel labeled "DEVICE" is provided for controlling the 
oscilloscope over USB. See the Programmer's Guide for more information.

http://www.keysight.com/find/parts
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The oscilloscope's internal file system, under "/User Files", consists of 10 locations 
for oscilloscope setup files, and four locations for mask files.

To use the File Explorer:

1 Press [Utility] > File Explorer.

2 In the File Explorer menu, press the softkey in the first position and use the 
Entry knob to navigate.

The softkey in the first position can have these labels:

• Press to go — when you can push the Entry knob to navigate to a new folder 
or storage location.

• Location — when pointing to a directory that is currently selected.

• Selected — when pointing to a file that can be loaded or deleted.

When this label appears, you can press the Load File or Delete File softkeys to 
take the action.

Pushing the Entry knob is the same as pressing the Load File softkey.

A file that has been deleted from a USB storage device cannot be recovered 
by the oscilloscope.
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• Eject — press this softkey to properly unmount a USB storage device before 
removal.

If you remove the device without pressing the Eject softkey first, the device 
will be marked as needing repair when connecting to a computer with the 
Windows operating system (even though there are no harmful effects to the 
device).

USB Storage
Devices

Use your PC to create directories on a USB storage device.

Most USB mass storage devices are compatible with the oscilloscope. However, 
certain devices may be incompatible, and may not be able to be read or written to. 
USB storage devices must be formatted with the FAT/FAT16, FAT32, NTFS, EXT2, 
EXT3, or EXT4 file system format. The exFAT format is not supported. Any given 
storage device may not support all of these formats.

When the USB mass storage device is connected to the oscilloscope's USB host 
port, a small four-color circle icon may be displayed briefly as the USB storage 
device is read.

You must "eject" a USB mass storage device before unplugging it; otherwise, the 
device will be marked as needing repair when connecting to a computer with the 
Windows operating system (even though there are no harmful effects to the 
device).

Do not connect USB storage devices that identify themselves as hardware type 
"CD" because these devices are not compatible with the InfiniiVision X-Series 
oscilloscopes.

See Also • Chapter 20, “Save/Recall (Setups, Screens, Data),” starting on page 217

Setting Oscilloscope Preferences

The User Preferences menu (under [Utility] > Options > Preferences) lets you specify 
oscilloscope preferences.

• "To choose "expand about" center or ground" on page 239

• "To disable/enable transparent backgrounds" on page 239

• "To load the default label library" on page 239

• "To set up the screen saver" on page 239

• "To set Autoscale preferences" on page 241
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To choose "expand about" center or ground

When you change a channel's volts/division setting, the waveform display can be 
set to expand (or compress) about the signal ground level or the center of the 
display.

To set the waveform expansion reference point:

1 Press [Utility] > Options > Preferences > Expand and select:

• Ground— The displayed waveform will expand about the position of the 
channel's ground. This is the default setting.

The ground level of the signal is identified by the position of the ground level 

( ) icon at the far-left side of the display.

The ground level will not move when you adjust the vertical sensitivity 
(volts/division) control.

If the ground level is off screen, the waveform will expand about the top or 
bottom edge of the screen based on where the ground is off screen.

• Center— The displayed waveform will expand about the center of the display.

To disable/enable transparent backgrounds

There is a preference setting for whether measurements, statistics, reference 
waveform information, and other text displays have transparent or solid 
backgrounds.

1 Press [Utility] > Options > Preferences.

2 Press Transparent to toggle between transparent and solid text display 
backgrounds.

To load the default label library

See "To reset the label library to the factory default" on page 95.

To set up the screen saver

The oscilloscope can be configured to turn on a display screen saver when the 
oscilloscope has been idle for a specified length of time.
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1 Press [Utility] > Options > Preferences > Screen Saver to display the Screen Saver 
menu.

2 Press the Saver softkey to select the screen saver type.

The screen saver can be set to Off, to display any of the 
images shown in the list, or can display a user-defined text 
string.

If User is selected, press the Spell softkey to select the first 
character of the text string. Use the Entry knob to choose a 
character. Then press the Enter softkey to advance to the next 
character and repeat the process.

NOTE You can use a connected USB keyboard instead of using the Spell (and other) character 
editing softkeys.
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The resultant string is displayed in the "Text =" line.

3 Press the Wait softkey; then, turn the Entry knob to select the 
number of minutes to wait before the selected screen saver 
activates.

When you turn the Entry knob, the number of minutes is 
displayed on the Wait softkey. The default time is 180 
minutes (3 hours).

4 Press the Preview softkey to preview the screen saver you 
have selected with the Saver softkey.

5 To view the normal display after the screen saver has started, 
press any key or turn any knob.

To set Autoscale preferences

1 Press [Utility] > Options > Preferences > Autoscale.

2 In the Autoscale Pref menu, you can:

• Press the Fast Debug softkey enable/disable this type of autoscale.

When fast debug is enabled, autoscale lets you make quick visual 
comparisons to determine whether the signal being probed is a DC voltage, 
ground, or an active AC signal.

Channel coupling is maintained to allow easy viewing of oscillating signals.

• Press the Channels softkey and turn the Entry knob to specify the channels to 
be autoscaled:

• All Channels — The next time you press [Auto Scale], all channels that meet 
the requirements of Autoscale will be displayed.

• Only Displayed Channels — The next time you press [Auto Scale], only the 
channels that are turned on will be examined for signal activity. This is 
useful if you only want to view specific active channels after pressing 
[Auto Scale].

• Press the Acq Mode softkey and turn the Entry knob to select whether the 
acquisition mode should be preserved during autoscale:
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• Normal — to make the oscilloscope switch to Normal acquisition mode 
whenever the [Auto Scale] key is pressed. This is the default mode.

• Preserve — to make the oscilloscope remain in the acquisition mode you 
have chosen when the [Auto Scale] key is pressed.

Setting the Oscilloscope's Clock

The Clock menu lets you set the current date and time of day (24-hour format). 
This time/date stamp will appear on hardcopy prints and directory information on 
the USB mass storage device.

To set the date and time, or to view the current date and time:

1 Press [Utility] > Options > Clock.

2 Press the Year, Month, Day, Hour or Minute softkey; then, rotate 
the Entry knob to set to the appropriate number.

3 Press the Time Zone softkey; then, rotate the Entry knob to 
select your time zone.

Because licenses are based on Coordinated Universal Time 
(UTC), the proper time zone setting allows licenses to work 
immediately after they are generated.

The hours are shown in the 24-hour format. So 1:00 PM is hour 
13.

The real-time clock allows selection of valid dates only. If a day 
is selected and the month or year is changed so the day is 
invalid, the day is automatically adjusted.

Setting the Gen Out Source

On G-suffix oscilloscope models (that have a built-in waveform generator), you 
can choose the source of the Gen Out connector on the front panel of the 
oscilloscope:
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1 Press [Utility] > Options > Auxiliary.

2 In the Auxiliary menu, press Gen Out; then, turn the Entry knob to select from:

• WaveGen— The waveform generator output. See Chapter 19, “Waveform 
Generator,” starting on page 205.

• Triggers— The trigger output. Each time the oscilloscope triggers, a rising 
edge occurs. The signal is is 0-5 V. See Chapter 11, “Triggers,” starting on 
page 97.

• Mask— The mask test failure output. A 5 volt pulse occurs when the mask 
test fails. When the mask test passes, no pulse occurs, and the signal 
remains at 0 volts. See Chapter 16, “Mask Testing,” starting on page 181.

The output impedance of the Gen Out connector is 50 ohms.

Enabling Remote Command Logging

When remote command logging is enabled, remote commands sent to the 
instrument (and results returned by the instrument) can be logged to the screen, 
to a text file on a USB storage device, or to both the screen and a text file.

To enable remote command logging:
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1 Press [Utility] > Options > Remote Log to open the Remote Log menu:

2 Press Enable to enable or disable the remote command 
logging feature.

When remote logging is enabled, additional debug 
information can be included in the returned error string. If the 
error is detected by the SCPI command parser, such as a 
header error or other syntax error, the extra debug 
information is generated and included. But if the error is 
detected by the oscilloscope system, such as when an 
out-of-range value is sent, then no extra debug information 
is included.

3 Press Destination to select whether remote commands are 
logged to a text file (on a connected USB storage device), 
logged to the screen, or both.

4 Press Write Mode to specify whether logged commands will 
be created in a new list or appended to existing logged 
commands.

Your selection takes effect when remote command logging is enabled.

This option applies to both screen and file logging.

5 Press File Name to open the Log Filename menu where you can specify the name 
of the file (on the USB storage device) to which remote commands are logged.

6 Press Display On to enable or disable the screen display of logged remote 
commands and their return values (if applicable).

7 Press Transparent to disable or enable a transparent background for the remote 
command logging screen display.

Enable to make the background transparent. This lets you view underlying 
waveforms.

Disable for a solid background which makes the logged remote commands 
easier to read.
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Performing Service Tasks

The Service menu (under [Utility] > Service) lets you perform service-related tasks:

• "To perform user calibration" on page 245

• "To perform hardware self test" on page 246

• "To perform front panel self test" on page 246

• "To export crash log files" on page 246

• "To display oscilloscope information" on page 247

• "To display the user calibration status" on page 247

For other information related to oscilloscope maintenance and 
service, see:

• "To clean the oscilloscope" on page 247

• "To check warranty and extended services status" on page 247

• "To contact Keysight" on page 248

• "To return the instrument" on page 248

To perform user calibration

User Calibration performs an internal self-alignment routine to optimize the signal 
path in the oscilloscope. The routine uses internally generated signals to optimize 
circuits that affect channel sensitivity, offset, and trigger parameters.

User Cal should be performed:

• Every five years or after 10000 hours of operation.

• When the ambient temperature of the oscilloscope is >10 °C different than 
when the last User Cal was performed.

• When you want to maximize the measurement accuracy.

Performing User Cal will invalidate your Certificate of Calibration. If NIST (National 
Institute of Standards and Technology) traceability is required, perform the 
"Performance Verification" procedure in the Keysight InfiniiVision 1200 X-Series 
Oscilloscopes Service Guide using traceable sources.

To perform user calibration:



246 Keysight InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes User's Guide

22 Utility Settings
 

1 Disconnect all inputs and waveform generator output (if available). No cables 
are needed. Allow the oscilloscope to warm up before performing this 
procedure.

2 Disable user calibration protection by pressing [Utility] > Options > Auxiliary > Cal 
Protect.

3 Press [Utility] > Service.

4 In the Service menu, begin the user calibration by pressing the Start User Cal 
softkey.

To perform hardware self test

Pressing [Utility] > Service > Diagnostics > Hardware Self Test performs a series of 
internal procedures to verify that the oscilloscope is operating properly.

It is recommended you run Hardware Self Test:

• After experiencing abnormal operation.

• For additional information to better describe an oscilloscope failure.

• To verify proper operation after the oscilloscope has been repaired.

Successfully passing Hardware Self Test does not guarantee 100% of the 
oscilloscope's functionality. Hardware Self Test is designed to provide an 80% 
confidence level that the oscilloscope is operating properly.

To perform front panel self test

Pressing [Utility] > Service > Diagnostics > Front Panel Self Test lets you test the front 
panel keys and knobs as well as the oscilloscope display.

Follow the on-screen instructions.

To export crash log files

Pressing [Utility] > Service > Diagnostics > Export Logs opens the Log Export menu 
where you can save crash log files to a connected USB storage device.

Crash log files are used by Keysight Technical Support when debugging 
oscilloscope problems.

When there is no crash log data available to export, this softkey is ghosted 
(unavailable).
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A secure erase (see "Performing a Secure Erase" on page 226) will remove crash 
log data along with other non-volatile memory.

To display oscilloscope information

Press [Help] > About Oscilloscope to display information about your oscilloscope:

• Model number.

• Serial number.

• Bandwidth.

• Host ID.

• Software version.

• Installed licenses.

To display the user calibration status

Pressing [Utility] > Service > User Cal Status displays the summary results of the 
previous User Cal, and the status of probe calibrations for probes that can be 
calibrated. Note that passive probes do not need to be calibrated.
Results:
User Cal date:
Change in temperature since last User Cal:
Failure:
Comments:
Probe Cal Status:

To clean the oscilloscope

1 Remove power from the instrument.

2 Clean the external surfaces of the oscilloscope with a soft cloth dampened with 
a mixture of mild detergent and water.

3 Make sure that the instrument is completely dry before reconnecting it to a 
power source.

To check warranty and extended services status

To learn the warranty status of your oscilloscope:

1 Point your web browser to: www.keysight.com/find/warrantystatus

2 Enter your product's model number and serial number. The system will search 
for the warranty status of your product and display the results. If the system 

http://www.keysight.com/find/warrantystatus
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cannot find your product's warranty status, select Contact Us and speak with a 
Keysight Technologies representative.

To contact Keysight

Information on contacting Keysight Technologies can be found at: 
www.keysight.com/find/contactus

To return the instrument

Before shipping the oscilloscope to Keysight Technologies, contact your nearest 
Keysight Technologies sales or service office for additional details. Information on 
contacting Keysight Technologies can be found at: 
www.keysight.com/find/contactus

1 Write the following information on a tag and attach it to the oscilloscope.

• Name and address of owner.

• Model number.

• Serial number.

• Description of service required or failure indication.

2 Remove accessories from the oscilloscope.

Only return accessories to Keysight Technologies if they are associated with the 
failure symptoms.

3 Package the oscilloscope.

You can use the original shipping container, or provide your own materials 
sufficient to protect the instrument during shipping.

4 Seal the shipping container securely, and mark it FRAGILE.

Configuring the [Quick Action] Key

The [Quick Action] key lets you perform common, repetitive actions by pressing a 
single key.

To configure the [Quick Action] key:

1 Press [Utility] > Quick Action > Action; then, select the action that should be 
performed:

http://www.keysight.com/find/contactus
http://www.keysight.com/find/contactus
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• Off — disables the [Quick Action] key.

• Quick Measure All — displays a popup containing a snapshot of all the single 
waveform measurements. The Source softkey lets you select the waveform 
source (which also becomes the source selection in the Measurement 
menu). See Chapter 15, “Measurements,” starting on page 155.

• Quick Mask Statistics Reset — resets mask testing statistics. For more 
information, see "Mask Statistics" on page 186.

• Quick Print — prints the current screen image. Press Settings to set up the 
printing options. See Chapter 21, “Print (Screens),” starting on page 229.

• Quick Save — saves the current image, waveform data, or setup. Press Settings 
to set up the save options. See Chapter 20, “Save/Recall (Setups, Screens, 
Data),” starting on page 217.

• Quick Recall — recalls a setup, mask, or reference waveform. Press Settings to 
set up the recall options. See Chapter 20, “Save/Recall (Setups, Screens, 
Data),” starting on page 217.

• Quick Freeze Display — freezes the display without stopping running 
acquisitions or un-freezes the display if currently frozen. For more 
information, see "To freeze the display" on page 89.

• Quick Trigger Mode — toggles the trigger mode between Auto and Normal, see 
"To select the Auto or Normal trigger mode" on page 122.

• Quick Clear Display — clears the display, see "To clear the display" on 
page 86.

Once the [Quick Action] key is configured, you simply press it to perform the 
selected action.
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When Keysight InfiniiVision 1200 X-Series and EDUX1052A/G oscilloscopes are 
set up on the LAN, you can access the oscilloscope's built-in web server using a 
web browser. The oscilloscope's web interface lets you:

• View information about the oscilloscope like its model number, serial number, 
host name, IP address, and VISA (address) connect string.

• Control the oscilloscope using the Remote Front Panel.

• Send SCPI (Standard Commands for Programmable Instrumentation) remote 
programming commands via the SCPI Commands applet window.

• Get screen images and save or print them from the browser.

• Save setups, screen images, waveform data, and mask files.

• Recall setup files, reference waveform data files, or mask files.

• Activate the Identification function to identify a particular instrument by 
causing a message to be displayed or a front panel light to blink.

• View installed options, firmware versions, and calibration status (via the 
Instrument Utilities page).

• View and modify the oscilloscope's network configuration.
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The web interface for InfiniiVision X-Series oscilloscopes also provides help for 
each of its pages.

Before you can use the web interface, you must place the oscilloscope on the 
network and set up its LAN connection.

Accessing the Web Interface

To access the oscilloscope's web interface:

1 Connect the oscilloscope to your LAN (see "To establish a LAN connection" on 
page 235) or establish a point-to-point connection (see "Stand-alone 
(Point-to-Point) Connection to a PC" on page 236).

It is possible to use a point-to-point connection, but using a normal LAN 
connection is the preferred method.

2 Type the oscilloscope's hostname or IP address in the web browser.

The oscilloscope's web interface Welcome Page is displayed.
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Control Instrument

The web interface's Browser Web Control page gives you access to:

• The Browser-Based Remote Front Panel (see "Remote Front Panel" on 
page 254).

• The SCPI Command window applet for Remote Programming (see "Remote 
Programming via the Web Interface" on page 254).
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Remote Front Panel

To operate the oscilloscope using the web interface's browser-based Remote 
Front Panel:

1 Access the oscilloscope's web interface (see "Accessing the Web Interface" on 
page 252).

2 When the oscilloscope's web interface is displayed, select Control Instrument, 
then select Use Remote Front Panel. After a few seconds the Remote Front Panel 
appears.

3 Click keys or knobs that you would normally press on the oscilloscope's front 
panel. Buttons have been added for turning knobs.

Remote Programming via the Web Interface

NOTE If Java is not installed on your PC, you will be prompted to install the Java Plug-in. This 
plug-in must be installed on the controlling PC for the web interface's Remote Programming 
operations.
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The SCPI Command window is useful for testing commands or entering a few 
commands interactively. When creating automated programs for controlling the 
oscilloscope, you will typically use the Keysight IO Libraries from within a 
programming environment like Microsoft Visual Studio (see "Remote 
Programming with Keysight IO Libraries" on page 256).

To send remote programming commands to the oscilloscope via the SCPI 
Commands applet window:

1 Access the oscilloscope's web interface (see "Accessing the Web Interface" on 
page 252).

2 When the oscilloscope's web interface is displayed, select the Control Instrument 
tab, then select Use Instrument IO.

The SCPI Commands applet appears within the browser web page.
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Remote Programming with Keysight IO Libraries

While the SCPI Commands applet window lets you enter and remote 
programming commands, remote programming for automated test and data 
acquisition is typically done using the Keysight IO Libraries, which are separate 
from the instrument's web interface.

The Keysight IO Libraries let a controller PC communicate with Keysight 
InfiniiVision X-Series oscilloscopes via their USB, LAN, or GPIB interfaces (if 
available).

The Keysight IO Libraries Suite connectivity software to enables communication 
over these interfaces. You can download the Keysight IO Libraries Suite from 
www.keysight.com/find/iolib.

Information about controlling the oscilloscope through remote commands is 
contained in the Programmer's Guide. You can access this document on the 
Keysight web site.

For more information about connecting to the oscilloscope, refer to the Keysight 
Technologies USB/LAN/GPIB Interfaces Connectivity Guide. For a printable 
electronic copy of the Connectivity Guide, direct your Web browser to 
www.keysight.com and search for "Connectivity Guide".

Get Image

To save (or print) the oscilloscope's display from the web interface:

1 Access the oscilloscope's web interface (see "Accessing the Web Interface" on 
page 252).

2 When the oscilloscope's web interface is displayed, select the Get Image tab 
from the left side of the Welcome screen. After a delay of several seconds, the 
oscilloscope's screen image will be displayed.

3 Right-click on the image and select Save Picture As... (or Print Picture...).

4 Select a storage location for the image file and click Save.

http://www.keysight.com/find/iolib
http://www.keysight.com
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Save/Recall

You can save setup files, screen images, waveform data files, or mask files to your 
PC via the oscilloscope's web interface (see "Saving Files via the Web 
Interface" on page 257).

You can recall setup files, reference waveform data files, or mask files from your PC 
via the oscilloscope's web interface (see "Recalling Files via the Web 
Interface" on page 258).

Saving Files via the Web Interface

To save setup files, screen images, waveform data, Lister data, or mask files to 
your PC via the oscilloscope's web interface:

1 Access the oscilloscope's web interface (see "Accessing the Web Interface" on 
page 252).

2 When the oscilloscope's web interface is displayed, select the Save tab.

3 On the Save page:

a Enter the name of the file you are saving to.

b Select the format.
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You can click Preview to view the oscilloscope's current screen image.

With some formats, you can click Save Setup Info to save setup information to 
an ASCII .txt format file.

c Click Save.

The current acquisition is saved.

d In the File Download dialog, click Save.

e In the Save As dialog, navigate to the folder where you want to save the file; 
then, click Save.

Recalling Files via the Web Interface

To recall setup files, reference waveform data files, or mask files from your PC via 
the oscilloscope's web interface:

1 Access the oscilloscope's web interface (see "Accessing the Web Interface" on 
page 252).

2 When the oscilloscope's web interface is displayed, select the Recall tab.
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3 On the Recall page:

a Click Browse....

b In the "Choose file" dialog, select the file you want to recall; then, click Open.

c When recalling reference waveform data files, select the Recall to Reference 
Waveform option.

d Click Recall.

Identification Function

The Identification web interface feature is useful when trying to locate a specific 
instrument in a rack of equipment.

1 Access the oscilloscope's web interface (see "Accessing the Web Interface" on 
page 252).

2 When the oscilloscope's web interface Home tab is displayed, select the Enable 
front panel identification indicator check box.

An "Identify" message is displayed on the oscilloscope.
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You can either clear the Enable front panel identification indicator check box or 
press the OK softkey on the oscilloscope to continue.

Instrument Utilities

The Instrument Utilities page of the web interface lets you:

• View installed options.

• View firmware versions.

• View calibration status.

You can select these cababilities via a drop-down menu.

Identification option
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Setting a Password

Whenever you connect the oscilloscope to a LAN, it is good practice to set a 
password. The password prevents someone from remotely accessing the 
oscilloscope via a Web browser and modifying its settings. Remote users can still 
view the Welcome screen, view network status, etc., but they cannot modify 
instrument settings without the password.

To set a password:

1 Access the oscilloscope's web interface (see "Accessing the Web Interface" on 
page 252).

2 When the oscilloscope's web interface is displayed, select the gear icon in the 
upper-right corner of the web page.

3 Click the Enable password button.

4 Enter your desired password in the New Password field. Enter the password 
again in the Confirm Password field. Click Enable Password.
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When a password is enabled for the web interface, Log out or Log in appears in 
the upper-right corner next to the gear icon.

To change or
disable the

password

Do one of these things:

• Select the gear icon in the upper-right corner of the web page. In the Password 
Options page, click Change Password or Disable Password.

• Another way to disable the password is to reset the oscilloscope's LAN settings. 
To do this, select the Configure LAN tab, select Advanced options, and select 
LAN Reset.

• You can also reset the oscilloscope's LAN settings using the keys on the front 
panel of the oscilloscope: press [Utility] > I/O > LAN Reset.

Enter password
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Specifications and Characteristics

For up-to-date specifications and characteristics on the 1200 X-Series 
oscilloscopes, see the data sheet at: www.keysight.com/find/1200X-Series

Measurement Category

• "Oscilloscope Measurement Category" on page 263

• "Measurement Category Definitions" on page 264

• "Maximum Input Voltages" on page 264

Oscilloscope Measurement Category

The InfiniiVision oscilloscopes are not intended to be used for measurements in 
Measurement Category II, III, or IV.

http://www.keysight.com/find/1200X-Series
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Measurement Category Definitions

The "Not rated for CAT II, III, IV" measurement category is for measurements 
performed on circuits not directly connected to MAINS. Examples are 
measurements on circuits not derived from MAINS, and specially protected 
(internal) MAINS derived circuits. In the latter case, transient stresses are variable; 
for that reason, the transient withstand capability of the equipment is made known 
to the user.

Measurement category II is for measurements performed on circuits directly 
connected to the low voltage installation. Examples are measurements on 
household appliances, portable tools and similar equipment.

Measurement category III is for measurements performed in the building 
installation. Examples are measurements on distribution boards, circuit-breakers, 
wiring, including cables, bus-bars, junction boxes, switches, socket-outlets in the 
fixed installation, and equipment for industrial use and some other equipment, for 
example, stationary motors with permanent connection to the fixed installation.

Measurement category IV is for measurements performed at the source of the 
low-voltage installation. Examples are electricity meters and measurements on 
primary overcurrent protection devices and ripple control units.

Maximum Input Voltages

WARNING Use this instrument only for measurements within its specified measurement category 
(not rated for CAT II, III, IV). No transient overvoltages allowed.

CAUTION  Maximum input voltage at analog inputs

150 Vrms, 200 Vpk
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Environmental Conditions

Declaration of Conformity

For Declarations of Conformity for Keysight products, go to: 
www.keysight.com/go/conformity

Probes and Accessories

For a list of the probes and accessories that are compatible with the 1200 X-Series 
oscilloscopes, see the data sheet at: www.keysight.com/find/1200X-Series

Environment Indoor use only.

Ambient 
temperature

Operating: 0 °C to +50 °C

Non-operating: -10 °C to +70 °C

Humidity Operating: Up to 95% RH, non-condensing to temperatures up to +40 °C 
decreasing linearly to 50% RH at +50 °C

Non-operating: Up to 90% RH up to +65 °C (non condensing)

Altitude Operating: to 3,000 m

Non-operating to 15,300 m

Overvoltage 
Category

This product is intended to be powered by MAINS that comply to Overvoltage 
Category II, which is typical of cord-and-plug connected equipment.

Pollution Degree The InfiniiVision 1200 X-Series and EDUX1052A/G oscilloscopes may be 
operated in environments of Pollution Degree 2 (or Pollution Degree 1).

Pollution Degree 
Definitions

Pollution Degree 1: No pollution or only dry, non-conductive pollution occurs. 
The pollution has no influence. Example: A clean room or climate controlled 
office environment.

Pollution Degree 2. Normally only dry non-conductive pollution occurs. 
Occasionally a temporary conductivity caused by condensation may occur. 
Example: General indoor environment.

Pollution Degree 3: Conductive pollution occurs, or dry, non-conductive 
pollution occurs which becomes conductive due to condensation which is 
expected. Example: Sheltered outdoor environment.

http://www.keysight.com/go/conformity
http://www.keysight.com/find/1200X-Series
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Because the 1200 X-Series oscilloscopes do not have a ring around the BNC 
connector for identifying probes, you must set the probe attenuation factor 
manually. See "Setting Analog Channel Probe Options" on page 51.

See Also For more information on probes and accessories, see www.keysight.com for:

• Probes and Accessories Selection Guide (5989-6162EN)

• InfiniiVision Oscilloscope Probes and Accessories Selection Guide Data Sheet 
(5968-8153EN)

• For compatibility information, manuals, application notes, data sheets, 
selection guides, SPICE models, and more for oscilloscope probes, see the 
Probe Resource Center at: www.keysight.com/find/PRC

Software and Firmware Updates

From time to time Keysight Technologies releases software and firmware updates 
for its products. To search for firmware updates for your oscilloscope, direct your 
web browser to www.keysight.com/find/1200X-Series-sw.

To view the currently installed software and firmware press [Help] > About 
Oscilloscope.

Once you have downloaded a firmware update file, you can place it on a USB 
storage device and load the file using File Explorer (see Chapter 22, “Utility 
Settings,” starting on page 233).

Binary Data (.bin) Format

The binary data format stores waveform data in binary format and provides data 
headers that describe that data.

Because the data is in binary format, the size of the file is approximately 5 times 
smaller than the ASCII XY format.

If more than one source is on, all displayed sources will be saved, except math 
functions.

http://www.keysight.com
http://literature.cdn.keysight.com/litweb/pdf/5989-6162EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5968-8153EN.pdf
http://www.keysight.com/find/PRC
http://www.keysight.com/find/1200X-Series-sw
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When using segmented memory, each segment is treated as a separate 
waveform. All segments for a channel are saved, then all segments of the next 
(higher numbered) channel are saved. This continues until all displayed channels 
are saved.

When the oscilloscope is in the Peak Detect acquisition mode, the minimum and 
maximum value waveform data points are saved to the file in separate waveform 
buffers. The minimum value data points are saved first; then, the maximum value 
data points are saved.

BIN data - using
segmented

memory

When saving all segments, each segment has its own waveform header (see 
"Binary Header Format" on page 267).

In BIN file format, data are presented as follows:

• Channel 1 data (all segments)

• Channel 2 data (all segments)

• Channel 3 data (all segments)

• Channel 4 data (all segments)

• Digital channel data (all segments)

• Math waveform data (all segments)

When not saving all segments, the number of waveforms is equivalent to the 
number of active channels (including math and digital channels, with up to seven 
waveforms for each digital pod). When saving all segments, the number of 
waveforms is equal to the number of active channels multiplied by the number of 
segments acquired.

Binary Data in MATLAB

Binary data from an InfiniiVision oscilloscope can be imported to The MathWorks 
MATLAB. You can download the appropriate MATLAB functions from the Keysight 
Technologies web site at www.keysight.com/find/1200X-Series-examples.

Keysight provides the .m files, which need to be copied into the work directory for 
MATLAB. The default work directory is C:\MATLAB7\work.

Binary Header Format

File Header There is only one file header in a binary file. The file header consists of the 
following information.

http://www.keysight.com/find/1200X-Series-examples
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Waveform Header It is possible to store more than one waveform in the file, and each waveform 
stored will have a waveform header. When using segmented memory, each 
segment is treated as a separate waveform. The waveform header contains 
information about the type of waveform data that is stored following the waveform 
data header.

Cookie Two byte characters, AG, that indicate the file is in the Keysight Binary Data file 
format.

Version Two bytes that represent the file version.

File Size A 32-bit integer that is the number of bytes that are in the file.

Number of 
Waveforms

A 32-bit integer that is the number of waveforms that are stored in the file.

Header Size A 32-bit integer that is the number of bytes in the header.

Waveform Type A 32-bit integer that is the type of waveform stored in the file:

• 0 = Unknown.

• 1 = Normal.

• 2 = Peak Detect.

• 3 = Average.

• 4 = Not used in InfiniiVision oscilloscopes.

• 5 = Not used in InfiniiVision oscilloscopes.

• 6 = Logic.

Number of 
Waveform 
Buffers

A 32-bit integer that is the number of waveform buffers required to read the 
data.

Points A 32-bit integer that is the number of waveform points in the data.

Count A 32-bit integer that is the number of hits at each time bucket in the waveform 
record when the waveform was created using an acquisition mode like 
averaging. For example, when averaging, a count of four would mean every 
waveform data point in the waveform record has been averaged at least four 
times. The default value is 0.

X Display Range A 32-bit float that is the X-axis duration of the waveform that is displayed. For 
time domain waveforms, it is the duration of time across the display. If the value 
is zero then no data has been acquired.
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X Display Origin A 64-bit double that is the X-axis value at the left edge of the display. For time 
domain waveforms, it is the time at the start of the display. This value is treated 
as a double precision 64-bit floating point number. If the value is zero then no 
data has been acquired.

X Increment A 64-bit double that is the duration between data points on the X axis. For time 
domain waveforms, this is the time between points. If the value is zero then no 
data has been acquired.

X Origin A 64-bit double that is the X-axis value of the first data point in the data record. 
For time domain waveforms, it is the time of the first point. This value is treated 
as a double precision 64-bit floating point number. If the value is zero then no 
data has been acquired.

X Units A 32-bit integer that identifies the unit of measure for X values in the acquired 
data:

• 0 = Unknown.

• 1 = Volts.

• 2 = Seconds.

• 3 = Constant.

• 4 = Amps.

• 5 = dB.

• 6 = Hz.

Y Units A 32-bit integer that identifies the unit of measure for Y values in the acquired 
data. The possible values are listed above under X Units.

Date A 16-byte character array, left blank in InfiniiVision oscilloscopes.

Time A 16-byte character array, left blank in the InfiniiVision oscilloscopes.

Frame A 24 byte character array that is the model number and serial number of the 
oscilloscope in the format of: MODEL#:SERIAL#.

Waveform Label A 16 byte character array that contains the label assigned to the waveform.

Time Tags A 64-bit double, only used when saving multiple segments (requires segmented 
memory option). This is the time (in seconds) since the first trigger.

Segment Index A 32-bit unsigned integer. This is the segment number. Only used when saving 
multiple segments.
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Waveform Data
Header

A waveform may have more than one data set. Each waveform data set will have a 
waveform data header. The waveform data header consists of information about 
the waveform data set. This header is stored immediately before the data set.

Example Program for Reading Binary Data

To find an example program for reading binary data, direct your web browser to 
www.keysight.com/find/1200X-Series-examples, and select "Example Program 
for Reading Binary Data".

Examples of Binary Files

Single Acquisition
Multiple Analog

Channels

The following picture shows a binary file of a single acquisition with multiple 
analog channels.

Waveform Data 
Header Size

A 32-bit integer that is the size of the waveform data header.

Buffer Type A 16-bit short that is the type of waveform data stored in the file:

• 0 = Unknown data.

• 1 = Normal 32-bit float data.

• 2 = Maximum float data.

• 3 = Minimum float data.

• 4 = Not used in InfiniiVision oscilloscopes.

• 5 = Not used in InfiniiVision oscilloscopes.

• 6 = Digital unsigned 8-bit char data (for digital channels).

Bytes Per Point A 16-bit short that is the number of bytes per data point.

Buffer Size A 32-bit integer that is the size of the buffer required to hold the data points.

http://www.keysight.com/find/1200X-Series-examples
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Single Acquisition

All Pods Logic
Channels

The following picture shows a binary file of a single acquisition with all pods for the 
logic channels saved.

File Header
12 bytes

Number of Waveforms = N

Number of Waveform Buffers = 1

Buffer Type = 1 (floating point)
Bytes per Point = 4

Waveform Header 1
140 bytes

Waveform Data
Header 1
12 bytes

Voltage Data 1
buffer size

Waveform Header 2
140 bytes

Waveform Data
Header 2
12 bytes

Voltage Data 2
buffer size

Waveform Header N
140 bytes

Waveform Data
Header N
12 bytes

Voltage Data N
buffer size

Number of Waveform Buffers = 1

Buffer Type = 1 (floating point)
Bytes per Point = 4

Number of Waveform Buffers = 1

Buffer Type = 1 (floating point)
Bytes per Point = 4
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Segmented
Memory

Acquisition on One
Analog Channel

The following picture shows a binary file of a segmented memory acquisition on 
one analog channel.

File Header
12 bytes

Waveform Header 2
140 bytes

Waveform Data
Header 1
12 bytes

Pod 1 Timing Data
buffer size

Waveform Data
Header 2
12 bytes

Pod 2 Timing Data
buffer size

Number of Waveforms = 2

Number of Waveform Buffers = 1

Buffer Type = 6 (unsigned char)
Bytes per Point = 1

Buffer Type = 6 (unsigned char)
Bytes per Point = 1

Waveform Header 1
140 bytes

Number of Waveform Buffers = 1



Reference 24

Keysight InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes User's Guide 273

 
CSV and ASCII XY files

• "CSV and ASCII XY file structure" on page 274

• "Minimum and Maximum Values in CSV Files" on page 274

File Header
12 bytes

Waveform Header 1
140 bytes

Waveform Data
Header 1
12 bytes

Voltage Data 1
buffer size

Waveform Header 2
140 bytes

Waveform Data
Header 2
12 bytes

Voltage Data 2
buffer size

Waveform Header N
140 bytes

Waveform Data
Header N
12 bytes

Voltage Data N
buffer size

Number of Waveforms = N = Number of Segments

Number of Waveform Buffers = 1
Index = 1
Time Tag = 0.0

Buffer Type = 1 (floating point)
Bytes per Point = 4

Number of Waveform Buffers = 1
Index = 2
Time Tag = time between segment 1 and 2

Buffer Type = 1 (floating point)
Bytes per Point = 4

Number of Waveform Buffers = 1
Index = N
Time Tag = time between segment 1 and N

Buffer Type = 1 (floating point)
Bytes per Point = 4
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CSV and ASCII XY file structure

In CSV or ASCII XY format the Length control selects the number of points per 
segment. All segments are contained in the CSV file or in each ASCII XY data file.

For example: If the Length control is set to 1000 points, there will be 1000 points 
(rows in the spreadsheet) per segment. When saving all segments there are three 
header rows, so the data for the first segment starts at row 4. The second 
segment's data starts at row 1004. The time column shows the time since the 
trigger on the first segment. The top row shows the selected number of points per 
segment.

BIN files are a more efficient data transfer format than CSV or ASCII XY. Use this 
file format for fastest data transfer.

Minimum and Maximum Values in CSV Files

If you are running a Minimum or Maximum measurement, the minimum and 
maximum values shown in the measurement display may not appear in the CSV 
file.

Explanation: When the oscilloscope's sample rate is 2 GSa/s, a sample will be taken every 
500 ps. If the horizontal scale is set to 10 us/div, there will be 100 us of data 
displayed (because there are ten divisions across the screen). To find the total 
number of samples the oscilloscope will take:

100 us x 2 GSa/s = 200K samples

The oscilloscope is required to display those 200K samples using 640 pixel 
columns. The oscilloscope will decimate the 200K samples to 640 pixel columns, 
and this decimation keeps track of the min and max values of all the points that 
are represented by any given column. Those min and max values will be displayed 
in that screen column.

A similar process is used to reduce the acquired data to produce a record usable 
for various analysis needs such as measurements and CSV data. This analysis 
record (or measurement record) is much larger than 640 and may in fact contain 
up to 65536 points. Still, once the # of acquired points > 65536, some form of 
decimation is required. The decimator used to produce a CSV record is configured 
to provide a best-estimate of all the samples that each point in the record 
represents. Therefore, the min and max values may not appear in the CSV file.
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Acknowledgements

Third party software acknowledgements and licenses for the InfiniiVision 
1200 X-Series and EDUX1052A/G oscilloscopes with the embedded Linux 
operating system are located at 
www.keysight.com/find/1200X-Series-third-party-software.

You can also find a link to this list on the Keysight InfiniiVision oscilloscopes 
manuals website at www.keysight.com/find/1200X-Series-manual.

Product Markings and Regulatory Information

These symbols are used on the 1200 X-Series oscilloscopes.

Symbol Description

Caution, risk of electric shock

Caution, refer to accompanying documentation

This symbol indicates separate collection for electrical and electronic 
equipment mandated under EU law as of August 13, 2005. All electric and 
electronic equipment are required to be separated from normal waste for 
disposal (Reference WEEE Directive 2002/96/EC).

Indicates the time period during which no hazardous or toxic substance 
elements are expected to leak or deteriorate during normal use. Forty 
years is the expected useful life of the product.

The RCM mark is a registered trademark of the Australian 
Communications and Media Authority.

The CE mark is a registered trademark of the European Community.

ICES / NMB-001 Cet appareil ISM est conforme a la norme NMB du 
Canada. This is a marking to indicate product compliance with the 
Industry Canadian Interference-Causing Equipment Standard (ICES-001).

This is also a symbol of an Industrial Scientific and Medical Group 1 Class 
A product (CISPR 11, Clause 4).

ccr.keysight@keysight.com

http://www.keysight.com/find/1200X-Series-third-party-software
http://www.keysight.com/find/1200X-Series-manual
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The CSA mark is a registered trademark of the CSA International.

South Korean Certification (KC) mark; includes the marking's identifier 
code which follows this format:

MSIP-REM-YYY-ZZZZZZZZZZZZZZ.

Symbol Description

267459

MSIP-REM-Kst-
     1A15150
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25 CAN Triggering and Serial 
Decode
Setup for CAN Signals / 277
CAN Triggering / 279
CAN Serial Decode / 281

CAN triggering and serial decode is available on DSOX1200-Series oscilloscopes.

Setup for CAN Signals

Setup consists of connecting the oscilloscope to a CAN signal, using the CAN 
Signals menu to specify the signal source, threshold voltage level, baud rate, and 
sample point.

To set up the oscilloscope to capture CAN signals, use the Signals softkey which 
appears in the Analyze menu:

1 Press [Display] > Labels > Display to turn on labels.

2 Press the [Analyze] key.

3 Press Features; then, select Serial Bus.

4 Press Features again (or push the Entry knob) to enable the serial bus display.

5 Press the Mode softkey; then, select CAN.
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6 Press the Signals softkey to open the CAN Signals menu.

7 Press Source; then, select the channel for the CAN signal.

The label for the CAN source channel is automatically set.

8 Press the Threshold softkey; then, turn the Entry knob to 
select the CAN signal threshold voltage level.

The threshold voltage level is used in decoding, and it will 
become the trigger level when the trigger type is set to the 
selected serial decode slot.

9 Press the Baud softkey; then, turn the Entry knob to select the 
baud rate that matches match your CAN bus signal.

The CAN baud rate can be set to predefined baud rates from 
10 kb/s up to 5 Mb/s or a user-defined baud rate from 
10.0 kb/s to 4 Mb/s in increments of 100 b/s. Fractional 
user-defined baud rates between 4 Mb/s and 5 Mb/s are not 
allowed.

The default baud rate is 125 kb/s

If none of the pre-defined selections match your CAN bus signal, select User 
Defined; then, press the User Baud softkey and turn the Entry knob to enter the 
baud rate.

10 Press the Sample Point softkey; then, turn the Entry knob to select the point 
between phase segments 1 and 2 where the state of the bus is measured. This 
controls the point within the bit's time where the bit value is captured.

11 Press the Signal softkey and select the type and polarity of the CAN signal. This 
also automatically sets the channel label for the source channel.

• CAN_H — The actual CAN_H differential bus.

60%
70%

80%
Sample Point

One Bit
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• Differential (H-L) — The CAN differential bus signals connected to an analog 
source channel using a differential probe. Connect the probe's positive lead 
to the dominant-high CAN signal (CAN_H) and connect the negative lead to 
the dominant-low CAN signal (CAN_L).

Dominant low signals:

• Rx — The Receive signal from the CAN bus transceiver.

• Tx — The Transmit signal from the CAN bus transceiver.

• CAN_L — The actual CAN_L differential bus signal.

• Differential (L-H) — The CAN differential bus signals connected to an analog 
source channel using a differential probe. Connect the probe's positive lead 
to the dominant-low CAN signal (CAN_L) and connect the negative lead to 
the dominant-high CAN signal (CAN_H).

CAN Triggering

To set up the oscilloscope to capture a CAN signal, see "Setup for CAN 
Signals" on page 277.

The Controller Area Network (CAN) trigger allows triggering on CAN version 2.0A 
and 2.0B signals.

A CAN message frame in CAN_L signal type is shown below:

After setting up the oscilloscope to capture a CAN signal:

1 Press [Trigger].

2 In the Trigger menu, press the Trigger Type softkey.

Arbitration
Field

Bus
Idle

Data
Field

SOF edge

Control
Field

ACK
Field

IntermissionCRC
Field

EOF
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3 Press the Trigger Type softkey; then, turn the Entry knob to select the serial slot 
(Serial 1) on which the CAN signal is being decoded.

4 Press the Trigger on: softkey; then, turn the Entry knob to 
select the trigger condition:

• SOF - Start of Frame — The oscilloscope triggers at the start 
of a frame.

• Remote Frame ID (RTR) — The oscilloscope triggers on 
remote frames with the specified ID. Press the Bits softkey 
to select the ID.

• Data Frame ID (~RTR) — The oscilloscope will trigger on data 
frames matching the specified ID. Press the Bits softkey to 
select the ID.

• Remote or Data Frame ID — The oscilloscope will trigger on 
remote or data frames matching the specified ID. Press 
the Bits softkey to select the ID.

• Data Frame ID and Data — The oscilloscope will trigger on 
data frames matching the specified ID and data. Press the 
Bits softkey to select the ID and set up the number of data 
bytes and values.

• Error Frame — The oscilloscope will trigger on CAN active error frames.

• All Errors — The oscilloscope will trigger when any form error or active error is 
encountered.

• Acknowledge Error — The oscilloscope will trigger when the acknowledge bit is 
recessive (high).

• Overload Frame — The oscilloscope will trigger on CAN overload frames.

5 If you select a condition that lets you trigger on ID or data values, use the Bits 
softkey and the CAN Bits menu to specify those values.

For details about using the CAN Bits menu softkeys, press and hold the softkey 
in question to display the built-in help.

You can use the Zoom mode for easier navigation of the decoded data.

NOTE If the setup does not produce a stable trigger, the CAN signal may be slow enough that the 
oscilloscope is auto-triggering. Press the [Trigger] key, then press the Mode softkey to set the 
trigger mode from Auto to Normal.
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To display CAN serial decode, see "CAN Serial Decode" on page 281.

CAN Serial Decode

To set up the oscilloscope to capture CAN signals, see "Setup for CAN Signals" on 
page 277.

For CAN triggering set up see "CAN Triggering" on page 279.

To set up CAN serial decode:

1 Press the [Analyze] key.

2 Press Features; then, select Serial Bus.

3 Press Features again (or push the Entry knob) to enable the serial bus display.

4 Press the Mode softkey; then, select CAN.

5 If the oscilloscope is stopped, press the [Run/Stop] key to 
acquire and decode data.

You can use the horizontal Zoom window for easier navigation of the decoded data.

NOTE If the setup does not produce a stable trigger, the CAN signal may be slow enough that the 
oscilloscope is auto-triggering. Press the [Trigger] key, then press the Mode softkey to set the 
trigger mode from Auto to Normal.
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See Also • "Interpreting CAN Decode" on page 282

• "CAN Totalizer" on page 283

• "Interpreting CAN Lister Data" on page 284

Interpreting CAN Decode

• Frame ID appears in hex digits in yellow. Frames of 11 or 29 bits are 
automatically detected.

• Remote frame (RMT) appears in green.

• Data length code (DLC) appears in blue for data frames and green for remote 
frames.

• Data bytes appear in hex digits in white for data frames.

• Cyclic redundancy check (CRC) appears in hex digits in blue when valid, or in 
red to indicate that the oscilloscope's hardware decode calculated a CRC that 
is different from the incoming CRC data stream.

• Angled waveforms show an active bus (inside a packet/frame).

• Mid-level blue lines show an idle bus.

• Decoded text is truncated at the end of the associated frame when there is 
insufficient space within frame boundaries.
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• Pink vertical bars indicate you need to expand the horizontal scale (and run 
again) to see decode.

• Red dots in the decode line indicate that there is data that is not being 
displayed. Scroll or expand the horizontal scale to view the information.

• Aliased bus values (undersampled or indeterminate) are drawn in pink.

• Unknown bus values (undefined or error conditions) are drawn in red with a "?" 
label.

• Flagged error frames are drawn in red with an "ERR" label.

CAN Totalizer

The CAN totalizer provides a direct measure of bus quality and efficiency. The CAN 
totalizer measures total CAN frames, flagged error frames, overload frames, and 
bus utilization.

The totalizer is always running (counting frames and calculating percentages) and 
is displayed whenever CAN decode is displayed. The totalizer counts even when 
the oscilloscope is stopped (not acquiring data). Pressing the [Run/Stop] key does 
not affect the totalizer. When an overflow condition occurs, the counter displays 
OVERFLOW. The counters can be reset to zero by pressing the Reset CAN Counters 
softkey.
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Types of Frames • Active error frames are CAN frames in which a CAN node recognizes an error 
condition during a data or remote frame and issues an active error flag.

• A partial frame occurs when the oscilloscope detects any error condition during 
a frame that is not followed by an active error flag. Partial frames are not 
counted.

Counters • The FRAMES counter gives the total number of completed remote, data, 
overload, and active error frames.

• The OVLD counter gives the total number of completed overload frames and 
their percentage of the total number of frames.

• The ERR counter gives the total number of completed active error frames and 
their percentage of the total number of frames.

• The LOAD (bus load) indicator measures the percentage of time the bus is 
active. The calculation is done on 330 ms periods, approximately every 400 ms.

Example: If a data frame contains an active error flag, both the FRAMES counter 
and the ERR counter will be incremented. If a data frame contains an error that is 
not an active error it is considered a partial frame and no counters are 
incremented.

Interpreting CAN Lister Data
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In addition to the standard Time column, the CAN Lister contains these columns:

• ID — frame ID.

• Type — frame type (RMT remote frame or Data).

• DLC — data length code.

• Data — data bytes.

• CRC — cyclic redundancy check.

• Errors — highlighted in red. Errors can be Acknowledge (Ack, A), Form (Fo), or 
Frame (Fr). Different kinds of errors can be combined like "Fo,Fr" in the above 
example.

Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.



286 Keysight InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes User's Guide

25 CAN Triggering and Serial Decode
 



287

Keysight InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes 
User's Guide

 

26 I2C Triggering and Serial 
Decode
Setup for I2C Signals / 287
I2C Triggering / 288
I2C Serial Decode / 292

I2C triggering and serial decode is available on DSOX1200-Series and 
EDUX1052A/G oscilloscopes.

Setup for I2C Signals

I2C (Inter-IC bus) signals setup consists of connecting the oscilloscope to the 
serial data (SDA) line and the serial clock (SCL) line and then specifying the input 
signal threshold voltage levels.

To set up the oscilloscope to capture I2C signals, use the Signals softkey which 
appears in the Analyze menu:

1 Press [Display] > Labels > Display to turn on labels.

2 Press the [Analyze] key.

3 Press Features; then, select Serial Bus.

4 Press Features again (or push the Entry knob) to enable the serial bus display.

5 Press the Mode softkey; then, select I2C.
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6 Press the Signals softkey to open the I2C Signals menu.

7 For both the SCL (serial clock) and SDA (serial data) signals:

a Connect an oscilloscope channel to the signal in the 
device under test.

b Press the SCL or SDA softkey; then, turn the Entry knob to 
select the channel for the signal.

c Press the corresponding Threshold softkey; then, turn the 
Entry knob to select the signal threshold voltage level.

The threshold voltage level is used in decoding, and it will 
become the trigger level when the trigger type is set to 
the selected serial decode slot.

Data must be stable during the whole high clock cycle or it 
will be interpreted as a start or stop condition (data 
transitioning while the clock is high).

The SCL and SDA labels for the source channels are 
automatically set.

I2C Triggering

To set up the oscilloscope to capture I2C signals, see "Setup for I2C Signals" on 
page 287.

After the oscilloscope has been set up to capture I2C signals, you can trigger on a 
stop/start condition, a restart, a missing acknowledge, an EEPROM data read, or 
on a read/write frame with a specific device address and data value.

1 Press [Trigger].

2 In the Trigger menu, press the Trigger Type softkey.
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3 Press the Trigger Type softkey; then, turn the Entry knob to select the serial slot 
(Serial 1) on which the I2C signals are being decoded.

4 Press the Trigger: softkey; then, turn the Entry knob to select 
the trigger condition:

• Start Condition— The oscilloscope triggers when SDA data 
transitions from high to low while the SCL clock is high. 
For triggering purposes (including frame triggers), a 
restart is treated as a start condition.

• Stop Condition— The oscilloscope triggers when data (SDA) 
transitions from low to high while the clock (SCL) is high.

• Missing Acknowledge— The oscilloscope triggers when SDA 
data is high during any Ack SCL clock bit.

• Address with no Ack— The oscilloscope triggers when the acknowledge of the 
selected address field is false. The R/W bit is ignored.

• Restart— The oscilloscope triggers when another start condition occurs 
before a stop condition.

• EEPROM Data Read— The trigger looks for EEPROM control byte value 1010xxx 
on the SDA line, followed by a Read bit and an Ack bit. It then looks for the 
data value and qualifier set by the Data softkey and the Data is softkey. When 
this event occurs, the oscilloscope will trigger on the clock edge for the Ack 
bit after the data byte. This data byte does not need to occur directly after 
the control byte.

SDA

SCL

Stop
Condition

R/Start
Condition

AckAck DataAddress

SDA

SCL

Control
byte

Read

R/ Ack Data Ack
Trigger point

Start or
Restart

Condition
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• Frame (Start: Addr7: Read: Ack: Data) or Frame (Start: Addr7: Write: Ack: Data)— The 
oscilloscope triggers on a read or write frame in 7-bit addressing mode on 
the 17th clock edge if all bits in the pattern match. For triggering purposes, 
a restart is treated as a start condition.

• Frame (Start: Addr7: Read: Ack: Data: Ack: Data2) or Frame (Start: Addr7: Write: Ack: 
Data: Ack: Data2)— The oscilloscope triggers on a read or write frame in 7-bit 
addressing mode on the 26th clock edge if all bits in the pattern match. For 
triggering purposes, a restart is treated as a start condition.

• 10-bit Write — The oscilloscope triggers on a 10-bit write frame on the 26th 
clock edge if all bits in the pattern match. The frame is in the format:

Frame (Start: Address byte 1: Write: Address byte 2: Ack: Data)

For triggering purposes, a restart is treated as a start condition.

SDA

SCL

Stop 
Condition

Start or
Restart

Condition
Trigger point

17th clock edge

Address

Read Write

R/ Ack Data Ack

Read Write

Start
Condition

Address R/W Ack Data Ack Data 2

Trigger point
26th clock edge

Ack Stop
Condition

SCL

SDA

Stop
Condition

Start or
Restart

Condition
Trigger point

26th clock edge

Address
1st byte

R/ Ack1 AckAddress
2nd byte

Write

Ack2 Data
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5 If you have set the oscilloscope to trigger on an EEPROM Data Read condition:

Press the Data is softkey to set the oscilloscope to trigger when data is = (equal 
to), ≠ (not equal to), < (less than), or > (greater than) the data value set in the 
Data softkey.

The oscilloscope will trigger on the clock edge for the Ack bit after the trigger 
event is found. This data byte does not need to occur directly after the control 
byte. The oscilloscope will trigger on any data byte that meets the criteria 
defined by the Data is and Data softkeys during a current address read or a 
random read or a sequential read cycle.

6 If you have set the oscilloscope to trigger on a 7-bit address read or write frame 
condition or a 10-bit write frame condition:

a Press the Address softkey and turn the Entry knob to select the 7-bit or 
10-bit device address.

You can select from an address range of 0x00 to 0x7F (7-bit) or 0x3FF 
(10-bit) hexadecimal. When triggering on a read/write frame, the 
oscilloscope will trigger after the start, address, read/write, acknowledge, 
and data events occur.

If don't care is selected (0xXX or 0xXXX) for the address, the address will be 
ignored. The trigger will always occur on the 17th clock for 7-bit addressing 
or 26th clock for 10-bit addressing.

b Press the Data value softkey and turn the Entry knob to select the 8-bit data 
pattern on which to trigger.

You can select a data value in the range of 0x00 to 0xFF (hexadecimal). The 
oscilloscope will trigger after the start, address, read/write, acknowledge, 
and data events occur.

If don't care (0xXX) is selected for data, the data will be ignored. The trigger 
will always occur on the 17th clock for 7-bit addressing or 26th clock for 
10-bit addressing.

c If you have selected a three-byte trigger, press the Data2 value softkey and 
turn the Entry knob to select the 8-bit data pattern on which to trigger.

To display I2C serial decode, see "I2C Serial Decode" on page 292.
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I2C Serial Decode

To set up the oscilloscope to capture I2C signals, see "Setup for I2C Signals" on 
page 287.

For I2C triggering setup see "I2C Triggering" on page 288.

To set up I2C serial decode:

1 Press the [Analyze] key.

2 Press Features; then, select Serial Bus.

3 Press Features again (or push the Entry knob) to enable the serial bus display.

4 Press the Mode softkey; then, select I2C.

5 Choose 7-bit or 8-bit address size. Use 8-bit address size to 
include the R/W bit as part of the address value, or choose 
7-bit address size to exclude the R/W bit from the address 
value.

6 If the oscilloscope is stopped, press the [Run/Stop] key to 
acquire and decode data.

You can use the horizontal Zoom window for easier navigation of the acquired data.

See Also • "Interpreting I2C Decode" on page 293

• "Interpreting I2C Lister Data" on page 294

NOTE If the setup does not produce a stable trigger, the I2C signals may be slow enough that the 
oscilloscope is auto-triggering. Press the [Trigger] key, then press the Mode softkey to set the 
trigger mode from Auto to Normal.
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Interpreting I2C Decode

• Angled waveforms show an active bus (inside a packet/frame).

• Mid-level blue lines show an idle bus.

• In the decoded hexadecimal data:

• Address values appear at the start of a frame.

• Write addresses appear in light-blue along with the "W" character.

• Read addresses appear in yellow along with the "R" character.

• Restart addresses appear in green along with the "S" character.

• Data values appear in white.

• "A" indicates Ack (low), "~A" indicates No Ack (high).

• Decoded text is truncated at the end of the associated frame when there is 
insufficient space within frame boundaries.

• Pink vertical bars indicate you need to expand the horizontal scale (and run 
again) to see decode.

• Red dots in the decode line indicate that more data can be displayed. Scroll or 
expand the horizontal scale to view the data.

• Aliased bus values (undersampled or indeterminate) are drawn in pink.
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• Unknown bus values (undefined or error conditions) are drawn in red.

Interpreting I2C Lister Data

In addition to the standard Time column, the I2C Lister contains these columns:

• Restart — indicated with an "X".

• Address — colored blue for writes, yellow for reads.

• Data — data bytes.

• Missing Ack — indicated by an "X", highlighted in red if an error.

Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.
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27 LIN Triggering and Serial 
Decode
Setup for LIN Signals / 295
LIN Triggering / 297
LIN Serial Decode / 299

LIN triggering and serial decode is available on DSOX1200-Series oscilloscopes.

Setup for LIN Signals

LIN (Local Interconnect Network) signal setup consists of connecting the 
oscilloscope to a serial LIN signal, specifying the signal source, threshold voltage 
level, baud rate, sample point, and other LIN signal parameters.

To set up the oscilloscope to capture LIN signals:

1 Press [Display] > Labels > Display to turn on labels.

2 Press the [Analyze] key.

3 Press Features; then, select Serial Bus.

4 Press Features again (or push the Entry knob) to enable the serial bus display.

5 Press the Mode softkey; then, select LIN.
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6 Press the Signals softkey to open the LIN Signals menu.

7 Press the Source softkey to select the channel connected to 
the LIN signal line.

The label for the LIN source channel is automatically set.

8 Press the Threshold softkey; then, turn the Entry knob to set 
the LIN signal threshold voltage level to the middle of the LIN 
signal.

The threshold voltage level is used in decoding, and it will 
become the trigger level when the trigger type is set to the 
selected serial decode slot.

9 Press the Baud Rate softkey to open the LIN Baud Rate menu.

10 Press the Baud softkey; then, turn the Entry knob to select the 
baud rate that matches match your LIN bus signal.

The default baud rate is 19.2 kb/s.

If none of the pre-defined selections match your LIN bus 
signal, select User Defined; then, press the User Baud softkey and turn the Entry 
knob to enter the baud rate.

You can set the LIN baud rate from 2.4 kb/s to 625 kb/s in increments of 
100 b/s.

11 Press the Back key to return to the LIN Signals menu.

12 Press the Sample Point softkey; then, turn the Entry knob to select the sample 
point at which the oscilloscope will sample the bit value.

13 Press the Standard softkey; then, turn the Entry knob to select the LIN standard 
you are measuring (LIN 1.3 or LIN 2.0).

Back
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For LIN 1.2 signals, use the LIN 1.3 setting. The LIN 1.3 setting assumes the 
signal follows the "Table of Valid ID Values" as shown in section A.2 of the LIN 
Specification dated December 12, 2002. If your signal does not comply with the 
table, use the LIN 2.0 setting.

14 Press the Sync Break softkey and select the minimum number of clocks that 
define a sync break in your LIN signal.

LIN Triggering

To set up the oscilloscope to capture a LIN signal, see "Setup for LIN Signals" on 
page 295.

LIN triggering can trigger on the rising edge at the Sync Break exit of the LIN 
single-wire bus signal (that marks the beginning of the message frame), the 
Frame ID, or the Frame ID and Data.

A LIN signal message frame is shown below:

1 Press [Trigger].

2 In the Trigger menu, press the Trigger Type softkey.

Sync
Break

Identifier
Break

Sync Break Exit

Sync
Field

Checksum
Field

Data
Fields
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3 Press the Trigger Type softkey; then, turn the Entry knob to select the serial slot 
(Serial 1) on which the LIN signal is being decoded.

4 Press the Trigger on: softkey; then, turn the Entry knob to 
select the trigger condition:

• Sync (Sync Break) — The oscilloscope triggers on the rising 
edge at the Sync Break exit of the LIN single-wire bus 
signal that marks the beginning the message frame.

• ID (Frame ID) — The oscilloscope triggers when a frame 
with an ID equal to the selected value is detected. Use the 
Entry knob to select the value for the Frame ID.

• ID & Data (Frame ID and Data) — The oscilloscope triggers 
when a frame with an ID and data equal to the selected 
values is detected. When triggering on a frame ID and 
data:

• To select the frame ID value, press the Frame ID softkey, 
and use the Entry knob.

Note that you can enter a "don't care" value for the 
frame ID and trigger on data values only.

• To set up the number of data bytes and enter their values (in hexadecimal 
or binary), press the Bits softkey to open the LIN Bits menu.
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For LIN decode information see "LIN Serial Decode" on page 299.

LIN Serial Decode

To set up the oscilloscope to capture LIN signals, see "Setup for LIN Signals" on 
page 295.

For LIN triggering setup see "LIN Triggering" on page 297.

To set up LIN serial decode:

1 Press the [Analyze] key.

2 Press Features; then, select Serial Bus.

3 Press Features again (or push the Entry knob) to enable the serial bus display.

NOTE For details about using the LIN Bits menu softkeys, press and hold the softkey in question to 
display the built-in help.
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4 Press the Mode softkey; then, select LIN.

5 Choose whether to include the parity bits in the identifier 
field.

a If you want to mask the upper two parity bits, ensure that 
the box under the Show Parity softkey is not selected.

b If you want to include the parity bits in the identifier field, 
ensure that the box under the Show Parity softkey is 
selected.

6 If the oscilloscope is stopped, press the [Run/Stop] key to 
acquire and decode data.

You can use the horizontal Zoom window for easier navigation of the decoded data.

See Also • "Interpreting LIN Decode" on page 301

• "Interpreting LIN Lister Data" on page 302

NOTE If the setup does not produce a stable trigger, the LIN signal may be slow enough that the 
oscilloscope is auto-triggering. Press the [Trigger] key, then press the Mode softkey to set the 
trigger mode from Auto to Normal.
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Interpreting LIN Decode

• Angled waveforms show an active bus (inside a packet/frame).

• Mid-level blue lines show an idle bus (LIN 1.3 only).

• The hexadecimal ID and parity bits (if enabled) appear in yellow. If a parity error 
is detected the hexadecimal ID and parity bits (if enabled) appear in red.

• Decoded hexadecimal data values appear in white.

• For LIN 1.3, the checksum appears in blue if correct, or red if incorrect. The 
checksum always appears in white for LIN 2.0.

• Decoded text is truncated at the end of the associated frame when there is 
insufficient space within frame boundaries.

• Pink vertical bars indicate you need to expand the horizontal scale (and run 
again) to see decode.

• Red dots in the decode line indicate that there is data that is not being 
displayed. Scroll or expand the horizontal scale to view the information.

• Unknown bus values (undefined or error conditions) are drawn in red.

• If there is an error in the synch field, SYNC will appear in red.

• If the header exceeds the length specified in the standard, THM will appear red.
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• If the total frame count exceeds the length specified in the standard, TFM will 
appear red (LIN 1.3 only).

• For LIN 1.3 a wakeup signal is indicated by WAKE in blue. If the wakeup signal 
is not followed by a valid wakeup delimiter a wakeup error is detected and 
displayed as WUP in red.

Interpreting LIN Lister Data

In addition to the standard Time column, the LIN Lister contains these columns:

• ID — frame ID.

• Data — (LIN 1.3 only) data bytes.

• Checksum — (LIN 1.3 only).

• Data and Checksum — (LIN 2.0 only).

• Errors — highlighted in red.

Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.
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28 SPI Triggering and Serial 
Decode
Setup for SPI Signals / 303
SPI Triggering / 309
SPI Serial Decode / 311

SPI triggering and serial decode is available on DSOX1200-Series oscilloscopes. 
The 2-channel DSOX1200-Series oscilloscopes support 3-wire SPI (Clock, Data, 
and CS). The 4-channel DSOX1200-Series oscilloscopes support 4-wire SPI 
(Clock, MOSI, MISO, and CS).

Setup for SPI Signals

Serial Peripheral Interface (SPI) signals setup consists of connecting the 
oscilloscope to a clock, MOSI data, MISO data, and framing signal, then setting 
the threshold voltage level for each input channel, and finally specifying any other 
signal parameters.

To set up the oscilloscope to capture SPI signals, use the Signals softkey which 
appears in the Analyze menu:

1 Press [Display] > Labels > Display to turn on labels.

2 Press the [Analyze] key.

NOTE Only one SPI serial bus can be decoded at a time.
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3 Press Features; then, select Serial Bus.

4 Press Features again (or push the Entry knob) to enable the serial bus display.

5 Press the Mode softkey; then, select SPI.

6 Press the Signals softkey to open the SPI Signals menu.

On 2-channel DSOX1200-Series oscilloscopes: On 4-channel DSOX1200-Series oscilloscopes:
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7 Press the Clock softkey to open the SPI Clock menu.

In the SPI Clock menu:

a Press the Clock softkey; then, turn the Entry knob to select 
the channel connected to the SPI serial clock line.

The CLK label for the source channel is automatically set.

b Press the Threshold softkey; then, turn the Entry knob to 
select the clock signal threshold voltage level.

The threshold voltage level is used in decoding, and it will 
become the trigger level when the trigger type is set to 
the selected serial decode slot.

c Press the slope softkey ( ) to select rising edge or 
falling edge for the selected Clock source.

This determines which clock edge the oscilloscope will use 
to latch the serial data. When Display Info is enabled, the 
graphic changes to show the current state of the clock 
signal.
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8 On 2-channel DSOX1200-Series oscilloscopes (that support 3-wire SPI), press 
the Data softkey to open the SPI Data menu.

In the SPI Data menu:

a Press the Data softkey; then, turn the Entry knob to select 
the channel that is connected to a SPI serial data line. (If 
the channel you selected is off, switch it on.)

The Data label for the source channel is automatically set.

b Press the Threshold softkey; then, turn the Entry knob to 
select the data signal threshold voltage level.

The threshold voltage level is used in decoding, and it will 
become the trigger level when the trigger type is set to 
the selected serial decode slot.

9 On 4-channel DSOX1200-Series oscilloscopes (that support 
4-wire SPI), press the MOSI softkey to open the SPI MOSI 
menu.

In the SPI MOSI menu:

a Press the MOSI Data softkey; then, turn the Entry knob to 
select the channel that is connected to a SPI serial data 
line. (If the channel you selected is off, switch it on.)

The MOSI label for the source channel is automatically set.

b Press the Threshold softkey; then, turn the Entry knob to 
select the MOSI signal threshold voltage level.

The threshold voltage level is used in decoding, and it will 
become the trigger level when the trigger type is set to 
the selected serial decode slot.
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10 On 4-channel DSOX1200-Series oscilloscopes (that support 4-wire SPI), 
(optional) press the MISO softkey to open the SPI MISO menu.

In the SPI MISO menu:

a Press the MISO Data softkey; then, turn the Entry knob to 
select the channel that is connected to a second SPI serial 
data line. (If the channel you selected is off, switch it on.)

The MISO label for the source channel is automatically set.

b Press the Threshold softkey; then, turn the Entry knob to 
select the MISO signal threshold voltage level.

The threshold voltage level is used in decoding, and it will 
become the trigger level when the trigger type is set to 
the selected serial decode slot.

11 Press the CS softkey to open the SPI Chip Select menu.



308 Keysight InfiniiVision 1200 X-Series and EDUX1052A/G Oscilloscopes User's Guide

28 SPI Triggering and Serial Decode
 

In the SPI Chip Select menu:

a Press the Frame by softkey to select a framing signal that the oscilloscope will 
use for determining which clock edge is the first clock edge in the serial 
stream.

You can set the oscilloscope to trigger during a high chip select (CS), a low 
chip select (~CS), or after a Timeout period during which the clock signal has 
been idle.

• If the framing signal is set to CS (or ~CS), the first clock edge as defined, 
rising or falling, seen after the CS (or ~CS) signal transitions from low to 
high (or high to low) is the first clock in the serial stream.

Chip Select — Press the CS or ~CS softkey; then, turn the Entry knob to 
select the channel that is connected to the SPI frame line. The label (~CS 
or CS) for the source channel is automatically set. The data pattern and 
the clock transition must occur during the time when the framing signal is 
valid. The framing signal must be valid for the entire data pattern.

• If the framing signal is set to Timeout, the oscilloscope generates it's own 
internal framing signal after it sees inactivity on the serial clock line.

Clock Timeout — Select Clock Timeout in the Frame by softkey, then select 
the Timeout softkey and turn the Entry knob to set the minimum time that 
the Clock signal must be idle (not transitioning) before the oscilloscope 
will search for the Data pattern on which to trigger.

The Timeout value can be set anywhere from 100 ns to 10 s.

When you press the Frame by softkey, the Display Info graphic changes to 
show timeout selection or the current state of the chip select signal.

b Press the Threshold softkey; then, turn the Entry knob to select the chip select 
signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become the 
trigger level when the trigger type is set to the selected serial decode slot.

When Display Info is enabled, information about the selected signal sources and 
their threshold voltage levels, as well as a waveform diagram, appears on the 
screen.
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SPI Triggering

To set up the oscilloscope to capture SPI signals, see "Setup for SPI Signals" on 
page 303.

After the oscilloscope has been set up to capture SPI signals, you can then trigger 
on a data pattern that occurs at the start of a frame. The serial data string can be 
specified to be from 4 to 32 bits long.

When you select the SPI trigger type and Display Info is enabled, a graphic is 
displayed showing the current state of the frame signal, clock slope, number of 
data bits, and data bit values.

1 Press [Trigger].

2 In the Trigger menu, press the Trigger Type softkey.

3 Press the Trigger Type softkey; then, turn the Entry knob to select the serial slot 
(Serial 1) on which the SPI signals are being decoded.
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4 Press the Trigger Setup softkey to open the SPI Trigger Setup menu.

5 Press the Trigger Type softkey; then, turn the Entry knob to 
select the trigger condition:

• Master-Out, Slave-In (MOSI) Data — for triggering on the 
MOSI data signal.

• Master-In, Slave-Out (MISO) Data — for triggering on the 
MISO data signal.

6 Press the #Bits softkey, and turn the Entry knob to set the 
number of bits (#Bits) in the serial data string.

The number of bits in the string can be set anywhere from 4 
bits to 64 bits. The data values for the serial string are 
displayed in the MOSI/MISO Data string in the waveform 
area.

7 For each bit in the MOSI/MISO Data string:

a Press the Bit softkey; then, turn the Entry knob to select 
the bit location.

As you rotate the Entry knob, the bit is highlighted in the Data string shown 
in the waveform area.

b Press the 0 1 X softkey to set the bit selected in the Bit softkey to 0 (low), 1 
(high), or X (don't care).
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The Set all Bits softkey will set all bits in the data string to the value of the 0 1 X 
softkey.

For SPI decode information see "SPI Serial Decode" on page 311.

SPI Serial Decode

To set up the oscilloscope to capture SPI signals, see "Setup for SPI Signals" on 
page 303.

For SPI triggering setup see "SPI Triggering" on page 309.

To set up SPI serial decode:

1 Press the [Analyze] key.

2 Press Features; then, select Serial Bus.

3 Press Features again (or push the Entry knob) to enable the serial bus display.
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4 Press the Mode softkey; then, select SPI.

5 Press the Word Size softkey; then, turn the Entry knob to 
select the number of bits in a word.

6 Press the Bit Order softkey; then turn the Entry knob to select 
the bit order, most significant bit first (MSB) or least 
significant bit first (LSB), used when displaying data in the 
serial decode waveform.

7 If the oscilloscope is stopped, press the [Run/Stop] key to 
acquire and decode data.

You can use the horizontal Zoom window for easier navigation of the acquired data.

See Also • "Interpreting SPI Decode" on page 313

• "Interpreting SPI Lister Data" on page 314

NOTE If the setup does not produce a stable trigger, the SPI signal may be slow enough that the 
oscilloscope is auto-triggering. Press the [Trigger] key, then press the Mode softkey to set the 
trigger mode from Auto to Normal.
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Interpreting SPI Decode

• Angled waveforms show an active bus (inside a packet/frame).

• Mid-level blue lines show an idle bus.

• The number of clocks in a frame appears in light-blue above the frame, to the 
right.

• Decoded hexadecimal data values appear in white.

• Decoded text is truncated at the end of the associated frame when there is 
insufficient space within frame boundaries.

• Pink vertical bars indicate you need to expand the horizontal scale (and run 
again) to see decode.

• Red dots in the decode line indicate that there is data that is not being 
displayed. Scroll or expand the horizontal scale to view the information.

• Aliased bus values (undersampled or indeterminate) are drawn in pink.

• Unknown bus values (undefined or error conditions) are drawn in red.
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Interpreting SPI Lister Data

In addition to the standard Time column, the SPI Lister contains these columns:

• Data — data bytes (MOSI and MISO).

Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.
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29 UART/RS232 Triggering 
and Serial Decode
Setup for UART/RS232 Signals / 315
UART/RS232 Triggering / 317
UART/RS232 Serial Decode / 320

UART/RS232 triggering and serial decode is available on DSOX1200-Series and 
EDUX1052A/G oscilloscopes.

Setup for UART/RS232 Signals

To set up the oscilloscope to capture UART/RS232 signals:

1 Press [Display] > Labels > Display to turn on labels.

2 Press the [Analyze] key.

3 Press Features; then, select Serial Bus.

4 Press Features again (or push the Entry knob) to enable the serial bus display.

5 Press the Mode softkey; then, select UART/RS232.
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6 Press the Signals softkey to open the UART Signals menu.

7 For both the Rx and Tx signals:

a Connect an oscilloscope channel to the signal in the 
device under test.

b Press the Rx or Tx softkey; then, turn the Entry knob to 
select the channel for the signal.

c Press the corresponding Threshold softkey; then, turn the 
Entry knob to select the signal threshold voltage level.

The threshold voltage level is used in decoding, and it will 
become the trigger level when the trigger type is set to 
the selected serial decode slot.

The RX and TX labels for the source channels are 
automatically set.

8 Press the Back key to return to the Analyze menu.

9 Press the Bus Config softkey to open the UART Bus Config 
menu.

Set the following parameters.

a #Bits — Set the number of bits in the UART/RS232 words 
to match your device under test (selectable from 5-9 bits).

b Parity — Choose odd, even, or none, based on your device 
under test.

c Baud — Press the Baud Rate softkey, then press the Baud 
softkey and select a baud rate to match the signal in your 
device under test. If the desired baud rate is not listed, 
select User Defined on the Baud softkey; then, select the 
desired baud rate using the User Baud softkey.

Back
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You can set the UART baud rate from 1.2 kb/s to 10.0000 Mb/s in 
increments of 100 b/s.

d Polarity — Select idle low or idle high to match your device under test's state 
when at idle. For RS232 select idle low.

e Bit Order — Select whether the most significant bit (MSB) or the least 
significant bit (LSB) is presented after the start bit in the signal from your 
device under test. For RS232 select LSB.

UART/RS232 Triggering

To set up the oscilloscope to capture UART/RS-232 signals, see "Setup for 
UART/RS232 Signals" on page 315.

To trigger on a UART (Universal Asynchronous Receiver/Transmitter) signal 
connect the oscilloscope to the Rx and Tx lines and set up a trigger condition. 
RS232 (Recommended Standard 232) is one example of a UART protocol.

1 Press [Trigger].

2 In the Trigger menu, press the Trigger Type softkey.

NOTE In the serial decode display, the most significant bit is always displayed on the left regardless 
of how Bit Order is set.
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3 Press the Trigger Type softkey; then, turn the Entry knob to select the serial slot 
(Serial 1) on which the UART/RS232 signals are being decoded.

4 Press the Trigger Setup softkey to open the UART Trigger 
menu.

5 Press the Base softkey to select Hex or ASCII as the base 
displayed on the Data softkey in the UART Trigger menu.

Note that the setting of this softkey does not affect the 
selected base of the decode display.

6 Press the Trigger softkey and set up the desired trigger 
condition:

• Rx Start Bit — The oscilloscope triggers when a start bit 
occurs on Rx.

• Rx Stop Bit — Triggers when a stop bit occurs on Rx. The 
trigger will occur on the first stop bit. This is done 
automatically whether the device under test uses 1, 1.5, or 
2 stop bits. You do not need to specify the number of stop 
bits used by the device Under test.

• Rx Data — Triggers on a data byte that you specify. For use 
when the device under test data words are from 5 to 8 bits 
in length (no 9th (alert) bit).
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• Rx 1:Data — For use when the device under test data words are 9 bits in 
length including the alert bit (the 9th bit). Triggers only when the 9th (alert) 
bit is 1. The specified data byte applies to the least significant 8 bits 
(excludes the 9th (alert) bit).

• Rx 0:Data — For use when the device under test data words are 9 bits in 
length including the alert bit (the 9th bit). Triggers only when the 9th (alert) 
bit is 0. The specified data byte applies to the least significant 8 bits 
(excludes the 9th (alert) bit).

• Rx X:Data — For use when the device under test data words are 9 bits in 
length including the alert bit (the 9th bit). Triggers on a data byte that you 
specify regardless of the value of the 9th (alert) bit. The specified data byte 
applies to the least significant 8 bits (excludes the 9th (alert) bit).

• Similar choices are available for Tx.

• Rx or Tx Parity Error — Triggers on a parity error based on the parity you have 
set in the UART Bus Config menu.

7 If you choose a trigger condition that includes "Data" in its description (for 
example: Rx Data), then press the Data is softkey, and choose an equality 
qualifier. You can choose equal to, not equal to, less than, or greater than a 
specific data value.

8 Use the Data softkey to choose the data value for your trigger comparison. This 
works in conjunction with the Data is softkey.

9 Optional: The Burst softkey lets you trigger on the Nth frame (1-4096) after an 
idle time you select. All trigger conditions must be met for the trigger to occur.

10 If Burst is selected, an idle time (1 µs to 10 s) can be specified so that the 
oscilloscope will look for a trigger condition only after the idle time has past. 
Press the Idle softkey and rotate the Entry knob to set an idle time.

To display UART/RS232 serial decode, see "UART/RS232 Serial Decode" on 
page 320.

NOTE If the setup does not produce a stable trigger, the UART/RS232 signals may be slow enough 
that the oscilloscope is auto-triggering. Press the [Trigger] key, then press the Mode softkey 
to set the trigger mode from Auto to Normal.
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UART/RS232 Serial Decode

To set up the oscilloscope to capture UART/RS232 signals, see "Setup for 
UART/RS232 Signals" on page 315.

For UART/RS232 triggering setup see "UART/RS232 Triggering" on page 317.

To set up UART/RS232 serial decode:

1 Press the [Analyze] key.

2 Press Features; then, select Serial Bus.

3 Press Features again (or push the Entry knob) to enable the serial bus display.

4 Press the Mode softkey; then, select UART/RS232.

5 Press Settings.
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6 In the UART Settings menu, press the Base softkey to select the base (hex, 
binary, or ASCII) in which decoded words are displayed.

• When displaying words in ASCII, the 7-bit ASCII format is 
used. Valid ASCII characters are between 0x00 and 0x7F. 
To display in ASCII you must select at least 7 bits in the 
Bus Configuration. If ASCII is selected and the data 
exceeds 0x7F, the data is displayed in hex.

• When #Bits is set to 9 in the UART Bus Config menu, the 
9th (alert) bit is displayed directly to the left of the ASCII 
value (which is derived from the lower 8 bits).

7 Optional: Press the Framing softkey and select a value. In the 
decode display, the chosen value will be displayed in light 
blue. However, if a parity error occurs the data will be 
displayed in red.

8 If the oscilloscope is stopped, press the [Run/Stop] key to 
acquire and decode data.

You can use the horizontal Zoom window for easier navigation of the acquired data.

See Also • "Interpreting UART/RS232 Decode" on page 322

• "UART/RS232 Totalizer" on page 323

• "Interpreting UART/RS232 Lister Data" on page 324

NOTE If the setup does not produce a stable trigger, the UART/RS232 signals may be slow enough 
that the oscilloscope is auto-triggering. Press the [Trigger] key, then press the Mode softkey 
to set the trigger mode from Auto to Normal.
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Interpreting UART/RS232 Decode

• Angled waveforms show an active bus (inside a packet/frame).

• Mid-level blue lines show an idle bus.

• When using 5-8 bit formats, the decoded data is displayed in white (in binary, 
hex, or ASCII).

• When using the 9 bit format, all data words are displayed in green, including 
the 9th bit. The 9th bit is displayed on the left.

• When a data word value is selected for framing, it is displayed in light blue. 
When using 9-bit data words, the 9th bit will also be displayed in light blue.

• Decoded text is truncated at the end of the associated frame when there is 
insufficient space within frame boundaries.

• Pink vertical bars indicate you need to expand the horizontal scale (and run 
again) to see decode.

• When the horizontal scale setting does not permit the display of all available 
decoded data, red dots will appear in the decoded bus to mark the location of 
hidden data. Expand the horizontal scale to allow the data to display.

• An unknown (undefined) bus is shown in red.
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• A parity error will cause the associated data word to be shown in red, which 
includes the 5-8 data bits and the optional 9th bit.

UART/RS232 Totalizer

The UART/RS232 totalizer consists of counters that provide a direct measure of 
bus quality and efficiency. The totalizer appears on screen whenever UART/RS232 
Decode is ON in the Analyze menu.

The totalizer is running, counting frames and calculating the percentage of error 
frames, even when the oscilloscope is stopped (not acquiring data).

The ERR (error) counter is a count of Rx and Tx frames with parity errors. The TX 
FRAMES and RX FRAMES counts include both normal frames and frames with 
parity errors. When an overflow condition occurs, the counter displays OVERFLOW.

The counters can be reset to zero by pressing the Reset UART Counters softkey in 
the UART Settings menu.
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Interpreting UART/RS232 Lister Data

In addition to the standard Time column, the UART/RS232 Lister contains these 
columns:

• Rx — receive data.

• Tx — transmit data.

• Errors — highlighted in red, Parity Error or Unknown Error.

Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.
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Symbols
(-) Width measurement, 169
(+) Width measurement, 169

A
About Oscilloscope, 247
AC channel coupling, 50
AC RMS - Full Screen 

measurement, 165
AC RMS - N Cycles measurement, 165
accessories, 21, 265, 266
acquire, 129, 139
Acquire key, 29, 37, 42, 44, 138
Acquisition controls, 29
acquisition memory, 98
acquisition memory, saving, 221
acquisition mode, 135
acquisition mode, averaging, 138, 139
acquisition mode, high resolution, 140
acquisition mode, normal, 136
acquisition mode, peak detect, 136
acquisition mode, preserve during 

Autoscale, 241
acquisition modes, 129
active serial bus, 282, 293, 301, 313, 

322
actual sample rate, 134
addition math function, 68
address with no ack condition, I2C 

trigger, 289
Addresses softkey, 235
aliasing, 131
aliasing, FFT, 62
alternating edge trigger, 101
altitude (environmental 

conditions), 265
AM (amplitude modulation), waveform 

generator output, 211
Amplitude measurement, 161

amplitude modulation (AM), waveform 
generator output, 211

analog bus display, 55
analog channel, probe attenuation, 52
analog channel, setup, 47
analog filters, adjusting, 57, 71
Analyze key, 30
Analyze Segments, 141, 142, 180
annotation, adding, 87
ASCII file format, 218
attenuation, probe, 52
attenuation, probe, external 

trigger, 128
Auto Increment, 224
Auto Scale key, 29
Auto Setup, FFT, 58, 71, 73
Auto trigger mode, 122
Auto? trigger indicator, 123
AutoIP, 235, 236
automatic measurements, 155, 157
Autoscale, 24
Autoscale preferences, 241
Autoscale, undo, 25
Average - Full Screen 

measurement, 164
Average - N Cycles measurement, 164
averaging acquire mode, 135, 138, 

139

B
Back key, 28
bandwidth, 247
bandwidth limit, 50
bandwidth required, oscilloscope, 134
bandwidth, oscilloscope, 131
Base measurement, 162
BIN file format, 218
binary data (.bin), 266
binary data file examples, 270
binary data in MATLAB, 267

binary data, example program for 
reading, 270

bit rate measurement, 169
bits, SPI trigger, 310
Blackman Harris FFT window, 58, 72
blanking, 43
BMP file format, 218
Bode plot, frequency response 

analysis, 202
brick-wall frequency response, 132
brightness of waveforms, 28
Browser Web Control, 254, 255
built-in help, 36
burst, capture signal bursts, 141
Bus key, 55
buttons (keys), front panel, 26
BW Limit? in DVM display, 196

C
calibration, 245
calibration protect button, 33
calibration status, 260
CAN decode, source channels, 278
CAN frame counter, 283
CAN serial decode, 281
CAN totalizer, 283
CAN trigger, 279
capture signal bursts, 141
Center, FFT, 57, 72
change network password, 262
channel labels, 91
channel, analog, 47
channel, bandwidth limit, 50
channel, coupling, 50
channel, invert, 51
channel, on/off keys, 31
channel, position, 49
channel, probe units, 52
channel, skew, 53
channel, vernier, 31, 51
channel, vertical sensitivity, 49
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characteristics, 263
choosing values, 28
cleaning, 247
clear display, 138
clear display, Quick Clear Display, 249
clear persistence, 85
clock, 242
compensate passive probes, 25, 32
Config softkey, 235, 236
Conformity, Declaration of, 265
connection, to a PC, 236
connections for frequency response 

analysis (FRA), 199
connectors, rear panel, 33
Control Instrument, 253
control, remote, 233
controls, front panel, 26
copyright, 2
Counter measurement, 169
counter, CAN frame, 283
counter, UART/RS232 frame, 323
coupling, channel, 50
coupling, trigger, 124
crash log files, export, 246
crosstalk between input channels, 

minimizing, 48
crosstalk problems, 57, 71
CSV file format, 218
CSV files, minimum and maximum 

values, 274
cursor measurements, 145
cursor units, 149
Cursors key, 30
Cursors knob, 30
cursors, binary, 147
cursors, hex, 148
cursors, manual, 147
cursors, track waveform, 147

D
damage, shipping, 21
data sheet, 263
DC channel coupling, 50
DC RMS - Full Screen 

measurement, 165
DC RMS - N Cycles measurement, 165
DC signals, checking, 123
DC waveform generator output, 207

dead time (re-arm), 142
decibels, FFT vertical units, 58, 72
decimating samples, 135
decimation, for measurement 

record, 274
decimation, for screen, 274
Declaration of Conformity, 265
default configuration, 24
default label library, 95
default setup, 24, 226
Default Setup key, 29
defaults, waveform generator, 215
delay knob, 39
Delay measurement, 158, 170
delay time indicator, 46
delayed sweep, 44
delete character, 224
delete file, 236
Demo terminal, 32
depth, AM modulation, 212
deviation, FM modulation, 213
DHCP, 235, 236
digital voltmeter (DVM), 195
digital waveform, external trigger 

input, 128
disable network password, 262
Display key, 30
display multiple acquisitions, 130
display, area, 35
display, interpreting, 34
display, persistence, 85
display, signal detail, 83
display, softkey labels, 36
display, status line, 35
displayed channels Autoscale, 241
distortion problems, 57, 71
Divide math function, 69
DNS IP, 235
Duty cycle measurement, 170
DVM (digital voltmeter, 195

E
edge speeds, 134
edge triggering, 99
EEPROM data read, I2C trigger, 289
either edge trigger, 101
eject USB storage device, 238
Entry knob, 28

Entry knob, push to select, 28
environmental conditions, 265
erase, secure, 226
exFAT file system format not 

supported, 238
expand about, 31, 49, 239
expand about center, 239
expand about ground, 239
exporting waveform, 217
EXT TRIG input as Z-axis input, 43
EXT TRIG input connector, 34
Ext Trig input connector, 33
EXT2 file system format, 238
EXT3 file system format, 238
EXT4 file system format, 238
External key, 33
external memory device, 33
external trigger, 127
external trigger, digital waveform, 128
external trigger, input impedance, 127
external trigger, input signal 

range, 128
external trigger, input signal 

threshold, 128
external trigger, probe 

attenuation, 128
external trigger, probe units, 128

F
f(t), 67
factory default settings, 226
Fall time measurement, 170
falling edges count 

measurements, 175
fast debug Autoscale, 241
FAT file system format, 238
FAT16 file system format, 238
FAT32 file system format, 238
FFT aliasing, 62
FFT DC value, 61
FFT key, 31
FFT magnitude math function, 70
FFT math function, 57
FFT measurement hints, 60
FFT phase math function, 70
FFT resolution, 60
FFT spectral leakage, 63
FFT units, 61
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FFT vertical units, 58, 72
FFT window, 58, 72
file explorer, 236
file format, ASCII, 218
file format, BIN, 218
file format, BMP, 218
file format, CSV, 218
file format, PNG, 218
file name, new, 224
file, save, recall, load, 236
filter math function, low pass, 74
filters, math, 74
fine adjustment, horizontal scale, 45
firmware updates, 266
firmware version information, 251
firmware versions, 260
flash drive, 33
Flat top FFT window, 58, 72
FM (frequency modulation), waveform 

generator output, 212
folding frequency, 131
Force key, 31
forcing a trigger, 99
FRA (frequency response analysis), 199
frame trigger, I2C, 290
freeze display, 249
freeze display, Quick Freeze 

Display, 249
frequency deviation, FM 

modulation, 213
Frequency measurement, 168
frequency modulation (FM), waveform 

generator output, 212
frequency requirements, power 

source, 22
frequency response analysis (FRA), 199
frequency response analysis data, 

save, 204
frequency, Nyquist, 131
frequency-shift keying modulation 

(FSK), waveform generator 
output, 214

front panel controls and connectors, 26
front panel self test, 246
front panel, language overlay, 33
front panel, remote, 254
FSK (frequency-shift keying 

modulation), waveform generator 
output, 214

G
g(t), 67
gateway IP, 235
Gaussian frequency response, 132
Gen Out connector, 242
glitch capture, 136
glitch trigger, 102
golden waveform test, 181
graphical user interface language, 36
graticule intensity, 87
graticule type, 86
grid intensity, 87
grid type, 86
ground level, 48
Ground terminal, 32

H
Hanning FFT window, 58, 72
hardware self test, 246
Help key, 32
help, built-in, 36
HF Reject, 125
high-frequency noise rejection, 125
high-resolution mode, 135, 140
holdoff, 126
hop frequency, FSK modulation, 214
Horizontal controls, 29, 37, 40
Horizontal knobs and keys, 37
horizontal position control, 29
horizontal position knob, 39
horizontal scale fine adjustment, 45
horizontal time/div control, 29
horizontal Zoom key, 29
Host ID, 247
host name, 235, 251
Host name softkey, 235
humidity (environmental 

conditions), 265

I
I/O interface settings, 233
I2C serial decode, 292
I2C trigger, 288
identification function, web 

interface, 259

idle serial bus, 282, 293, 301, 313, 
322

increment statistics, 180
indeterminate state, 148
infinite persistence, 85, 130, 136
information area, 36
installed licenses, 247
installed options, 260
Instrument Utilities web page, 260
intensity control, 83
Intensity key, 28
invert graticule colors, 219
invert waveform, 51
IP address, 235, 251

K
keyboard, USB, 88, 94, 224, 231, 240
keys, front panel, 26
Keysight IO Libraries Suite, 256
knobs, front panel, 26

L
label list, 95
label list, loading from text file, 94
labels, 91
labels, auto-increment, 94
labels, default library, 95
LAN connection, 235
LAN interface, remote control, 233
LAN port, 34
LAN Settings softkey, 235, 236
landscape mode, 232
language, user interface and Quick 

Help, 36
length control, 221
length softkey, 220
Level knob, 31
level, trigger, 99
LF Reject, 124
library, labels, 93
LIN serial decode, 299
LIN trigger, 297
line voltage, 22
load file, 236
Load from, 223
localized front panel overlay, 33
Location, 223, 237
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logging remote commands, 243
logic presets, waveform generator, 209
low pass filter math function, 74
low-frequency noise rejection, 124

M
markings, product, 275
mask files, recall, 225
Mask Statistics Reset, 249
mask statistics reset, Quick Mask 

Statistics Reset, 249
mask test, trigger output, 185, 243
mask testing, 181
mask, Gen Out signal, 243
math filters, 74
Math function controls, 32
Math key, 32
math operators, 68
math transforms, 70
math, 1*2, 69
math, 1/2, 69
math, addition, 68
math, divide, 69
math, FFT, 57
math, FFT magnitude/phase, 70
math, functions, 65
math, multiply, 69
math, offset, 67
math, scale, 67
math, subtract, 68
math, transform functions on arithmetic 

operations, 67
math, units, 67
math, using waveform math, 66
MATLAB binary data, 267
maximul input voltages, 264
Maximum measurement, 160
maximum sample rate, 134
Meas key, 30, 155
Measure controls, 30
measure, Quick Measure All, 249
measurement category, 

definitions, 264
measurement definitions, 157
measurement record, 221
measurement statistics, 178
measurement thresholds, 175

measurement window with zoom 
display, 177

measurements, 157
measurements area, 36
measurements, automatic, 155
measurements, delay, 158
measurements, overshoot, 158
measurements, phase, 158
measurements, preshoot, 158
measurements, time, 167
measurements, voltage, 160
memory depth and sample rate, 134
memory, segmented, 141
menu name, 36
menu timeout, softkey, 36
Minimum measurement, 161
missing acknowledge condition, I2C 

trigger, 289
model number, 247, 251
Modify softkey, 235
modulation, waveform generator 

output, 210
Multicast DNS, 235
Multiply math function, 69

N
N8900A Infiniium Offline oscilloscope 

analysis software, 218
navigate files, 236
network configuration parameters, 251
network printer connection, 231
network, connecting to, 235
new label, 93
noise rejection, 125
noise waveform generator output, 207
noise, adding to waveform generator 

output, 209
noise, high-frequency, 125
noise, low-frequency, 124
noisy signals, 122
non-volatile memory, secure 

erase, 226
normal acquire mode, 136
normal mode, 135, 136
Normal trigger mode, 122
notices, 2
NTFS file system format, 238

number of negative pulses 
measurements, 174

number of positive pulses 
measurements, 174

Nyquist frequency, 62
Nyquist sampling theory, 131

O
operators, math, 68
options, print, 232
oscilloscope bandwidth, 131
oscilloscope bandwidth required, 134
oscilloscope rise time, 133
oscilloscope sample rate, 133
output load expected, waveform 

generator, 208
output, trigger, 242
overdrive on input channels, 

avoiding, 48
overlay, localized, 33
Overshoot measurement, 158, 162
overvoltage category, 265

P
palette, 219
pan and zoom, 38
passive probes, compensating, 25
password (network), change or 

disable, 262
password (network), setting, 261
pattern trigger, 104
pattern, SPI trigger, 310
PC connection, 236
peak detect mode, 135, 136
Peak-peak measurement, 160
Period measurement, 167
persistence, 85
persistence, clearing, 85
persistence, infinite, 130
Phase measurement, 158, 171
phase X cursor units, 149
PNG file format, 218
point-to-point connection, 236
pollution degree, 265
pollution degree, definitions, 265
position, analog, 49
post-processing, 155
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post-trigger information, 39
power consumption, 22
power cord connector, 34
power requirements, 22
power supply, 34
power switch, 22, 28
power-on, 22
predefined labels, 92
Preshoot measurement, 158, 163
Press to go, 223, 237
pre-trigger information, 39
print, 249
print options, 232
print screen, 229
print, landscape, 232
print, Quick Print, 249
printer, USB, 33, 229
printing the display, 229
probe attenuation, 52
probe attenuation, external 

trigger, 128
probe check, 52
probe compensation, 32
probe compensation, 10:1 setting 

required, 26
probe units, 52
probes, 265, 266
probes, connecting to oscilloscope, 23
probes, passive, compensating, 25
programmer's guide, 256
pulse polarity, 103
pulse waveform generator output, 207
pulse width trigger, 102

Q
qualifier, pulse width, 103
Quick Action key, 30, 248
Quick Clear Display, 249
Quick Freeze Display, 249
Quick Help, 36
Quick Help language, 36
Quick Measure All, 249
Quick Print, 249
Quick Print quick action, 229
Quick Recall, 249
Quick Save, 249
Quick Trigger Mode, 249

R
ramp waveform generator output, 207
random noise, 122
range, external trigger input, 128
ratio X cursor units, 149
ratio Y cursor units, 149
raw acquisition record, 221
rear panel connectors, 33
re-arm time, 142
recall, 249
recall files via web interface, 258
recall mask files, 225
recall setups, 225
recall, Quick Recall, 249
Rectangular FFT window, 58, 72
reference point, waveform, 239
reference waveforms, 77
regulatory information, 275
remote commands, logging, 243
remote control, 233
Remote Front Panel, 254, 255
remote programming, Keysight IO 

Libraries, 256
remote programming, web 

interface, 254
required oscilloscope bandwidth, 134
restart condition, I2C trigger, 289
results, frequency response analysis 

(FRA), 202
return instrument for service, 248
Rise time measurement, 170
rise time, oscilloscope, 133
rise time, signal, 134
rise/fall time triggering, 106
rising edge count measurements, 175
roll mode, 41
RS232 trigger, 317
Run Control keys, 29
runt pulses, 167

S
safety warning, 23
sample rate, 5
sample rate and memory depth, 134
sample rate, current rate displayed, 38
sample rate, oscilloscope, 132, 133
sampling theory, 131

sampling, overview, 130
save, 249
save file, 236
save files via web interface, 257
save segment, 220
save setup files, 219
save times, data, 221
Save to, 223
Save to USB key, 30
save, Quick Save, 249
save/recall from web interface, 257
Save/Recall key, 30
saver, screen, 239
saving data, 217
SCL, I2C trigger, 288
SCPI Commands window, 255
screen image via web interface, 256
screen saver, 239
SDA, 287
SDA, I2C trigger, 288
secure erase, 226
segmented memory, 141
segmented memory, re-arm time, 142
segmented memory, saving 

segments, 220
Selected, 237
selecting, values, 28
self test, front panel, 246
self test, hardware, 246
serial clock, I2C trigger, 288
serial data, 287
serial data, I2C trigger, 288
serial decode controls, 30
serial number, 247, 251
service functions, 245
setup and hold triggering, 107
setup files, saving, 219
setup, default, 24
setup, frequency response analysis 

(FRA), 200
setups, recall, 225
shipping damage, 21
shipping precautions, 248
Sigma, minimum, 184
sine waveform generator output, 207
single acquisition, 29
Single key, 129
single-shot acquisitions, 123
single-shot events, 129
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skew, analog channel, 53
slope trigger, 99
Snapshot All measurements, 159
snapshot all, quick action, 249
softkey labels, 36
softkeys, 8, 28
software updates, 266
software version, 247
Span, FFT, 57, 72
specifications, 263
spectral leakage, FFT, 63
SPI serial decode, 311
SPI trigger, 309
square waveform generator 

output, 207
square waves, 132
stand-alone connection, 236
start acquisition, 29
start condition, I2C, 289
statistics, increment, 180
statistics, mask test, 186
statistics, measurement, 178
status line, 35
status, User Cal, 247
Std Deviation measurement, 165
stop acquisition, 29
stop condition, I2C, 289
storage locations, navigate, 223
subnet mask, 235
subtract math function, 68
sweep frequencies, frequency response 

analysis, 202

T
temperature (environmental 

conditions), 265
template, front panel, 33
test, mask, 181
theory, sampling, 131
threshold voltage, external trigger 

input, 128
threshold, analog channel 

measurements, 175
thumb drive, 33
time measurements, 167
time reference indicator, 46
time, re-arm, 142
timebase, 40

timeout, softkey menu, 36
times for saving data, 221
Tools keys, 30
Top measurement, 161
totalizer, CAN, 283
totalizer, UART/rs232, 323
tracking cursors, 147
transforms, math, 70
Transparent backgrounds, 239
Trig'd trigger indicator, 123
Trig'd? trigger indicator, 123
Trigger controls, 31
trigger coupling, 124
trigger indicator, Auto?, 123
trigger indicator, Trig'd, 123
trigger indicator, Trig'd?, 123
Trigger key, 31
Trigger key, trigger, 121
trigger level, 99
trigger mode, auto or normal, 122
trigger mode, Quick Trigger Mode, 249
trigger output, 242
trigger output, mask test, 185, 243
trigger type, CAN, 279
trigger type, edge, 99
trigger type, glitch, 102
trigger type, I2C, 288
trigger type, LIN, 297
trigger type, pattern, 104
trigger type, pulse width, 102
trigger type, rise/fall time, 106
trigger type, RS232, 317
trigger type, setup and hold, 107
trigger type, slope, 99
trigger type, SPI, 309
trigger type, UART, 317
trigger type, video, 108
trigger types, 31, 97
trigger, definition, 98
trigger, external, 127
trigger, forcing a, 99
trigger, general information, 98
trigger, holdoff, 126
trigger, mode/coupling, 121
trigger, source, 100
triggers, Gen Out signal, 243
turn channel on, 31

U
UART totalizer, 323
UART trigger, 317
UART/RS232 frame counter, 323
UART/RS232 serial decode, 320
under-sampled signals, 131
units, cursor, 149
units, external trigger probe, 128
units, math, 67
units, probe, 52
updating software and firmware, 266
USB compatibility mode, 234
USB device not recognized, 233
USB device port, remote control, 34, 

233
USB host port, 33, 229
USB printer, 229
USB printers, supported, 229
USB storage device, 33
USB, CD device, 238
USB, eject device, 33
user cal, 245
user calibration, 245
user interface language, 36
utilities, 233
Utility key, 30

V
V RMS, FFT vertical units, 58, 72
values, choosing, 28
variable persistence, 85
ventilation requirements, 22
vernier, channel, 31, 51
Vertical controls, 31
vertical expansion, 31, 49
Vertical knobs and keys, 47
vertical position, 49
vertical position knob, 31, 32
vertical scale knob, 31, 32
vertical sensitivity, 31, 32, 49
Vertical Units, FFT, 58, 72
video trigger, 108
VISA connect string, 251
voltage measurements, 160
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W
warranted specifications, 263
warranty, 2, 247
Wave Gen key, 31, 32
waveform generator, 205
waveform generator amplitude, 

frequency response analysis, 202
waveform generator defaults, 

restoring, 215
waveform generator expected output 

load, 208
waveform generator logic presets, 209
waveform generator output, 243
waveform generator, waveform 

type, 205
waveform type, waveform 

generator, 205
waveform, cursor tracking, 147
waveform, intensity, 83
waveform, printing, 229
waveform, reference point, 239
waveform, saving/exporting, 217
web interface, 251
web interface, accessing, 252
white noise, adding to waveform 

generator output, 209
Width - measurement, 169
Width + measurement, 169
Window, FFT, 58, 72

X
X at Max Y measurement, 173
X at Max Y on FFT, 159
X at Min Y measurement, 173
X at Min Y on FFT, 159
XY mode, 41

Z
Z-axis blanking, 43
zoom and pan, 38
zoom display, measurement window 

with, 177
Zoom key, 29
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